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ご注意書き 

 

１． 本資料に記載されている内容は本資料発行時点のものであり、予告なく変更することがあります。当社製品

のご購入およびご使用にあたりましては、事前に当社営業窓口で最新の情報をご確認いただきますとともに、

当社ホームページなどを通じて公開される情報に常にご注意ください。 
2. 本資料に記載された当社製品および技術情報の使用に関連し発生した第三者の特許権、著作権その他の知的

財産権の侵害等に関し、当社は、一切その責任を負いません。当社は、本資料に基づき当社または第三者の

特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
3. 当社製品を改造、改変、複製等しないでください。 
4. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説

明するものです。お客様の機器の設計において、回路、ソフトウェアおよびこれらに関連する情報を使用す

る場合には、お客様の責任において行ってください。これらの使用に起因しお客様または第三者に生じた損

害に関し、当社は、一切その責任を負いません。 
5. 輸出に際しては、「外国為替及び外国貿易法」その他輸出関連法令を遵守し、かかる法令の定めるところに

より必要な手続を行ってください。本資料に記載されている当社製品および技術を大量破壊兵器の開発等の

目的、軍事利用の目的その他軍事用途の目的で使用しないでください。また、当社製品および技術を国内外

の法令および規則により製造・使用・販売を禁止されている機器に使用することができません。 
6. 本資料に記載されている情報は、正確を期すため慎重に作成したものですが、誤りがないことを保証するも

のではありません。万一、本資料に記載されている情報の誤りに起因する損害がお客様に生じた場合におい

ても、当社は、一切その責任を負いません。 
7. 当社は、当社製品の品質水準を「標準水準」、「高品質水準」および「特定水準」に分類しております。また、

各品質水準は、以下に示す用途に製品が使われることを意図しておりますので、当社製品の品質水準をご確

認ください。お客様は、当社の文書による事前の承諾を得ることなく、「特定水準」に分類された用途に当

社製品を使用することができません。また、お客様は、当社の文書による事前の承諾を得ることなく、意図

されていない用途に当社製品を使用することができません。当社の文書による事前の承諾を得ることなく、

「特定水準」に分類された用途または意図されていない用途に当社製品を使用したことによりお客様または

第三者に生じた損害等に関し、当社は、一切その責任を負いません。なお、当社製品のデータ・シート、デ

ータ・ブック等の資料で特に品質水準の表示がない場合は、標準水準製品であることを表します。 
標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、

産業用ロボット 
高品質水準： 輸送機器（自動車、電車、船舶等）、交通用信号機器、防災・防犯装置、各種安全装置、生命

維持を目的として設計されていない医療機器（厚生労働省定義の管理医療機器に相当） 
特定水準： 航空機器、航空宇宙機器、海底中継機器、原子力制御システム、生命維持のための医療機器（生

命維持装置、人体に埋め込み使用するもの、治療行為（患部切り出し等）を行うもの、その他

直接人命に影響を与えるもの）（厚生労働省定義の高度管理医療機器に相当）またはシステム

等 
8. 本資料に記載された当社製品のご使用につき、特に、最大定格、動作電源電圧範囲、放熱特性、実装条件そ

の他諸条件につきましては、当社保証範囲内でご使用ください。当社保証範囲を超えて当社製品をご使用さ

れた場合の故障および事故につきましては、当社は、一切その責任を負いません。 
9. 当社は、当社製品の品質および信頼性の向上に努めておりますが、半導体製品はある確率で故障が発生した

り、使用条件によっては誤動作したりする場合があります。また、当社製品は耐放射線設計については行っ

ておりません。当社製品の故障または誤動作が生じた場合も、人身事故、火災事故、社会的損害などを生じ

させないようお客様の責任において冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージン

グ処理等、機器またはシステムとしての出荷保証をお願いいたします。特に、マイコンソフトウェアは、単

独での検証は困難なため、お客様が製造された最終の機器・システムとしての安全検証をお願いいたします。 
10. 当社製品の環境適合性等、詳細につきましては製品個別に必ず当社営業窓口までお問合せください。ご使用

に際しては、特定の物質の含有･使用を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、

かかる法令に適合するようご使用ください。お客様がかかる法令を遵守しないことにより生じた損害に関し

て、当社は、一切その責任を負いません。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを固くお

断りいたします。 
12. 本資料に関する詳細についてのお問い合わせその他お気付きの点等がございましたら当社営業窓口までご

照会ください。 
 
注 1. 本資料において使用されている「当社」とは、ルネサスエレクトロニクス株式会社およびルネサスエレク

トロニクス株式会社がその総株主の議決権の過半数を直接または間接に保有する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいい

ます。 



資料中の「日立製作所」、「日立XX」等名称の株式会社ルネサス テクノロジへの変更について

　2003年4月1日を以って三菱電機株式会社及び株式会社日立製作所のマイコン、ロジック、

アナログ、ディスクリート半導体、及びDRAMを除くメモリ（フラッシュメモリ・SRAM等）を含む

半導体事業は株式会社ルネサス テクノロジに承継されました。従いまして、本資料中には 

「日立製作所」、「株式会社日立製作所」、「日立半導体」、「日立XX」といった表記が残っておりま

すが、これらの表記は全て「株式会社ルネサス テクノロジ」に変更されておりますのでご理

解の程お願い致します。尚、会社商標・ロゴ・コーポレートステートメント以外の内容につい

ては一切変更しておりませんので資料としての内容更新ではありません。

ルネサステクノロジ ホームページ （http://www.renesas.com）

2003年4月1日

株式会社ルネサス テクノロジ

カスタマサポート部

お客様各位



ご注意

安全設計に関するお願い

1. 弊社は品質、信頼性の向上に努めておりますが、半導体製品は故障が発生したり、誤

動作する場合があります。弊社の半導体製品の故障又は誤動作によって結果として、

人身事故、火災事故、社会的損害などを生じさせないような安全性を考慮した冗長設

計、延焼対策設計、誤動作防止設計などの安全設計に十分ご留意ください。

本資料ご利用に際しての留意事項

1. 本資料は、お客様が用途に応じた適切なルネサス テクノロジ製品をご購入いただく

ための参考資料であり、本資料中に記載の技術情報についてルネサス テクノロジが

所有する知的財産権その他の権利の実施、使用を許諾するものではありません。

2. 本資料に記載の製品データ、図、表、プログラム、アルゴリズムその他応用回路例の

使用に起因する損害、第三者所有の権利に対する侵害に関し、ルネサス テクノロジ

は責任を負いません。

3. 本資料に記載の製品データ、図、表、プログラム、アルゴリズムその他全ての情報は

本資料発行時点のものであり、ルネサス テクノロジは、予告なしに、本資料に記載

した製品または仕様を変更することがあります。ルネサス テクノロジ半導体製品の

ご購入に当たりましては、事前にルネサス テクノロジ、ルネサス販売または特約店

へ最新の情報をご確認頂きますとともに、ルネサス テクノロジホームページ

(http://www.renesas.com)などを通じて公開される情報に常にご注意ください。

4. 本資料に記載した情報は、正確を期すため、慎重に制作したものですが万一本資料の

記述誤りに起因する損害がお客様に生じた場合には、ルネサス テクノロジはその責

任を負いません。

5. 本資料に記載の製品データ、図、表に示す技術的な内容、プログラム及びアルゴリズ

ムを流用する場合は、技術内容、プログラム、アルゴリズム単位で評価するだけでな

く、システム全体で十分に評価し、お客様の責任において適用可否を判断してくださ

い。ルネサス テクノロジは、適用可否に対する責任は負いません。

6. 本資料に記載された製品は、人命にかかわるような状況の下で使用される機器あるい

はシステムに用いられることを目的として設計、製造されたものではありません。本

資料に記載の製品を運輸、移動体用、医療用、航空宇宙用、原子力制御用、海底中継

用機器あるいはシステムなど、特殊用途へのご利用をご検討の際には、ルネサス テ

クノロジ、ルネサス販売または特約店へご照会ください。

7. 本資料の転載、複製については、文書によるルネサス テクノロジの事前の承諾が必

要です。

8. 本資料に関し詳細についてのお問い合わせ、その他お気付きの点がございましたらル

ネサス テクノロジ、ルネサス販売または特約店までご照会ください。
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ご注意
1 本書に記載の製品及び技術のうち「外国為替及び外国貿易法」に基づき安全保障貿易管理関連貨
物・技術に該当するものを輸出する場合，または国外に持ち出す場合は日本国政府の許可が必要
です。

2 本書に記載された情報の使用に際して，弊社もしくは第三者の特許権，著作権，商標権，その他
の知的所有権等の権利に対する保証または実施権の許諾を行うものではありません。また本書に
記載された情報を使用した事により第三者の知的所有権等の権利に関わる問題が生じた場合，弊
社はその責を負いませんので予めご了承ください。

3 製品及び製品仕様は予告無く変更する場合がありますので，最終的な設計，ご購入，ご使用に際
しましては，事前に最新の製品規格または仕様書をお求めになりご確認ください。

4 弊社は品質・信頼性の向上に努めておりますが，宇宙，航空，原子力，燃焼制御，運輸，交通，
各種安全装置， ライフサポート関連の医療機器等のように，特別な品質・信頼性が要求され，
その故障や誤動作が直接人命を脅かしたり，人体に危害を及ぼす恐れのある用途にご使用をお考
えのお客様は，事前に弊社営業担当迄ご相談をお願い致します。

5 設計に際しては，特に最大定格，動作電源電圧範囲，放熱特性，実装条件及びその他諸条件につ
きましては，弊社保証範囲内でご使用いただきますようお願い致します。
保証値を越えてご使用された場合の故障及び事故につきましては，弊社はその責を負いません。
また保証値内のご使用であっても半導体製品について通常予測される故障発生率，故障モードを
ご考慮の上，弊社製品の動作が原因でご使用機器が人身事故，火災事故，その他の拡大損害を生
じないようにフェールセーフ等のシステム上の対策を講じて頂きますようお願い致します。

6 本製品は耐放射線設計をしておりません。
7 本書の一部または全部を弊社の文書による承認なしに転載または複製することを堅くお断り致し
ます。

8 本書をはじめ弊社半導体についてのお問い合わせ，ご相談は弊社営業担当迄お願い致します。



商標
Microsoft®およびWindows®、 は、米国マイクロソフトコーポレーションの米国およびその他の国

における登録商標です。

IBM PCは、米国 IBM 社により管理されている計算機の名称です。

ELF/DWARFは、the Tool Interface Standards Committee で開発された、オブジェクトフォーマット
の名称です。

本マニュアルで使用されているすべての製品名またはブランド名は、それぞれの会社の商標また
は登録商標です。



まえがき

日立デバッギングインタフェースおよびシミュレータ・デバッガの使用前に本マニュアルを必ず
お読みください。
ユーザーズマニュアルは、なくさないよう保管してください。
本システムの使用方法を十分理解してから、使用してください。

本書について
本書では、日立のマイクロコンピュータの開発ツールに対応した Hitachi Debugging Interface (HDI)

およびシミュレータ・デバッガの使用法について説明します。次章、「はじめに」では、デバッグ
インタフェースおよびシミュレータ・デバッガについて簡単に紹介し、おもな特長を示します。
次の各章、｢システムの概要｣、｢シミュレータ・デバッガの機能｣、｢メニュー｣、｢ウィンドウおよ

びダイアログボックス｣、｢コマンドライン｣および｢メッセージ一覧｣は、それぞれの操作方法や利便
性についてのリファレンスです。
「プログラムの表示」、「メモリの操作」、「プログラムの実行」、「プログラムの停止」、「変

数の表示」、「オーバーレイ機能」、「関数の設定」および「ユーザインタフェースの構成」は、HDI
を使用したデバッグに関する“how to”ガイドです。

本マニュアルは､動作環境を IBM PC上の Microsoft® Windows®95 operating system 英語版として記
述しています。



前提事項
本書では、読者の方々に、C/C++プログラミング言語およびデバッグ対象プロセッサ用のアセン

ブラニーモニックについての十分な知識があること、および Microsoft® Windows®アプリケーション
の使用経験があることを前提としています。

マニュアルの規約
本書には、以下の表記上の規約があります。

表 1　表記上の規約
表　記 意　　　味

[Menu->Menu Option] ’->’の付いた太字の表記は、メニューオプションを指定する場合に使
用します

(例： [File->Save As...])。

FILENAME.C 大文字表記の名前は、ファイル名を指定する場合に使用します。

“enter this string” 入力必須のテキストを指定する場合に使用します(引用符“ ”は除く)。

キー + キー 必要なキーを押すよう指示する場合に使用します。たとえば、CTRL+N
は、CTRLキーを押したまま Nキーを押すことを意味します。

�

(“手順”記号)

この記号は、必ず左端に記載されます。この記号が使われる場合は、
すぐ右に実行手順が記載されていることを意味します。
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1. はじめに

Hitachi Debugging Interface (HDI)は、日立のマイクロコンピュータ用に、C/C++言語およびアセン
ブリ言語で書かれたアプリケーションの開発およびデバッグを簡単に行うためのグラフィカルユー
ザインタフェースです。アプリケーションを実行するデバッグプラットフォームのアクセス、計測、
および変更に関して、HDI は高機能でしかも直観的な手段を提供することを目的としています。

1.1 おもな特長
• Windows®グラフィカルユーザインタフェースを用いたデバッグ
• 直観的なユーザインタフェース
• オンラインヘルプ
• 共通した表示と操作性

【注】 HDIはWindows®3.1では動作しません。

シミュレータ・デバッガは、H8S、H8/300シリーズマイコンの CPUシミュレーション機能およ
びデバッグ機能を持っており、H8/300、H8/300L、H8/300H、H8S/2600、および H8S/2000シリーズ
のシミュレーションをサポートします。シミュレータ・デバッガを利用することによって、C/C++
言語やアセンブリ言語で作成されたプログラムを効率よくデバッグすることができます。

また、当社製の下記ソフトウェアと共に使用することにより、プログラムの開発工数を削減する
ことができます。

• HEW（Hitachi Embedded Workshop）
• H8S、H8/300シリーズC/C++コンパイラ
• H8S、H8/300シリーズクロスアセンブラ
• 最適化リンケージエディタ

1.2 特長
本シミュレータ・デバッガには、次のような特長があります。
（1） ホスト計算機上で動作するので、実機がなくてもプログラムのデバッグを開始することが

でき、システム全体の開発期間を短縮できます。
（2） シミュレーション時にプログラムの命令実行サイクル数を計算します。これにより実機が

なくても性能評価がおこなえます。
（3） 下記のような機能を持ち、プログラムのテスト、およびデバッグを効率よく進めることが

できます。
• H8S、H8/300シリーズの各 CPUに対応
• 全命令またはサブルーチン命令のみのトレース機能
• デバッグ対象プログラムの実行中に異常が発生した場合、異常を無視して続行するか、ま
たは停止するかを制御する機能

• プロファイルデータ取得、および関数単位のパフォーマンス測定
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• 豊富なブレーク機能
• メモリマップの設定・編集
• 関数呼び出し履歴の表示

（4） Windows®上で動作し、ブレークポイント・メモリマップ・パフォーマンス・トレースをダ
イアログボックス上で設定することができます。H8S、H8/300マイコンの各々のメモリマッ
プに対応した環境設定もダイアログボックス上で行うことができます。

1.3 デバッグ対象プログラム
シミュレータ・デバッガでは、ELF/DWARFフォーマット、および S-typeフォーマットのロード

モジュールがデバッグ可能です。これらのロードモジュールをデバッグ対象プログラムと呼びます。
デバッグ対象プログラム作成方法を図 1-1に示します。
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オブジェクト
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H8S,H8/300シリーズ シミュレータ・デバッガ

図1-1　デバッグ対象プログラム作成方法
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1.4 シミュレーション範囲
（1） シミュレータ・デバッガは、H8S、H8/300シリーズマイコンの下記機能をサポートしていま

す。
• 全実行命令
• 例外処理
• レジスタ
• 全アドレス空間

（2） シミュレータ・デバッガは H8S、H8/300シリーズマイコンの下記機能をサポートしていま
せん。下記機能を使用したプログラムは、H8S、H8/300シリーズ用エミュレータを使用し
てデバッグしてください。

• デュアルポート ���

• タイマ
• パルス幅変換器（PWM）
• シリアルコミニュケーションインタフェース（SCI）
• A/D 変換器
• I/Oポート
• 割り込みコントローラ
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2. システムの概要

HDI はモジュール方式のソフトウェアシステムで、それぞれに独立したモジュールを使用します。
これらのモジュールは汎用グラフィカルユーザインタフェースへリンクされており、これにより、
システムを構成するモジュールに関係なく共通した操作性が得られます。

2.1 ユーザインタフェース
HDI グラフィカルユーザインタフェースは、ユーザにデバッグプラットフォームを提供し、シス

テムの設定および変更を可能にするWindows®対応のアプリケーションです。Windows®アプリケーシ
ョンの詳しい操作方法は、Windows®標準のユーザーズマニュアルを参照してください。

2.2 データ入力
ダイアログボックスまたはフィールドに数値を入力する場合には、単純な数値だけでなく式も入

力できます。この式には、符号を含めたり、C/C++言語の演算子を使用することができます。C/C++
言語のデバッグをサポートする ELF/DWARFフォーマットのオブジェクト DLL が使われている場合
に、配列や構造体などの C/C++言語機能を使用できます。

一部のダイアログボックスでは、終了アドレスを入力する際に値の前に+符号を付けることにより
アドレス範囲を入力することが可能です。
この場合、＋符号を付けて入力された値と先頭アドレスの和が、終了アドレスになります。

2.2.1 演算子
以下の C/C++言語演算子を使用できます。

+, -, *, /, &, |, ^, ~, !, >>, <<, %, (, ), <, >, <=, >=, ==, !=, &&, ||

2.2.2 データ形式
接頭コードのないデータ値は、[Setup->Radix]メニューオプションで設定されたデフォルトの基数

を使用していると見なします。ただし、回数を入力するところは例外で 10進数の値をデフォルトに
とります。

名前にはシンボルを使用できます。また、一重引用符で囲めば、ASCII文字列を入力できます
(例：’demo’)。

次の接頭コードを使用して、基数を指定できます。
O’ 8進
B’ 2 進
D’ 10進
H’ 16進
0x 16進
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先頭コードに#文字を使用してレジスタ名を指定すると、そのレジスタの内容を使用できます。次
に例を示します。

#R1, #ER3, #R4L

2.2.3 精度
式の評価では、すべての数理演算は 32ビット(符号付き)を使用して行われます。32ビットを超え

る値はすべて切り捨てられます。

2.2.4 式の例
Buffer_start + 0x1000

#R1 | B’10001101

((pointer + (2 * increment_size)) & H’FFFF0000) >> D’15

!(flag ^ #ER4)

2.2.5 シンボル形式
シンボルには、C/C++ベースの指定ができます。これにより、C/C++言語ソースと同様な記述でシ

ンボルの参照ができます。また、シンボルにはキャスト演算子をつけることができます。これによ
り、型変換後のデータを参照することができます。ただし、以下のような制限事項があります。

• ポインタ指定は 4レベルまで可能です
• 配列指定は 3次元まで可能です
• typedef名は使用できません

2.2.6 シンボル指定の例
Object.value ：メンバの直接参照指定(C/C++)
p_Object->value ：メンバの間接参照指定(C/C++)
Class::value ：クラス指定付きメンバ参照指定(C++)
*value ：ポインタ指定(C/C++)
array[0] ：配列指定(C/C++)
Object.*value ：メンバへのポインタ参照指定(C++)
::g_value ：グローバル変数参照指定(C/C++)
Class::function(short) ：メンバ関数指定(C++)
(struct STR)*value ：キャスト指定(C/C++)

2.3 ヘルプ
HDI には、Windows®標準のコンテキスト依存型ヘルプシステムが備わっています。ヘルプを使用

すると、デバッグシステムの使用法に関するオンライン情報を表示します。

F1キーを押すか、Helpメニューを介して、ヘルプを呼び出すことができます。

さらに、一部のウィンドウおよびダイアログボックスには、専用のヘルプボタンがあります。
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2.3.1 コンテキスト依存型ヘルプ
HDI で、特定の項目に関するヘルプを得るには、ヘルプカーソルを使用します。ヘルプカーソル

を有効状態にするには、SHIFT+F1キーを押すか、または、ツールバー上のボタンをクリックします。
SHIFT+F1キーを押すと、カーソルが変化して、“？”マークが現れます。次に、ヘルプを必要とす

る項目上でクリックすると、適切な内容のヘルプが開きます。
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3. シミュレータ・デバッガの機能

本章では、H8S、H8/300シリーズ シミュレータ・デバッガの機能について説明します。

3.1 シミュレータ・デバッガと CPUの対応
シミュレータ・デバッガのデバッグプラットフォームと CPUの対応を表 3-1に示します。
ご使用になる CPUに合わせてプラットフォームを選択してください。プラットフォームの選択

は、Select Sessionダイアログボックスで行います。

表3-1　プラットフォームと CPUの対応
デバッグ

プラットフォーム名

対応 CPU

H8/300 Simulator H8/300

H8/300L Simulator H8/300L

H8/300HA Simulator H8/300Hアドバンストモード

H8/300HN Simulator H8/300Hノーマルモード

H8S/2600A Simulator H8S/2600アドバンストモード

H8S/2600N Simulator H8S/2600ノーマルモード

H8S/2000A Simulator H8S/2000アドバンストモード

H8S/2000N Simulator H8S/2000ノーマルモード

3.2 シミュレータ・デバッガのメモリ管理
(1) メモリマップの設定

メモリマップの設定は、シミュレーション時のメモリアクセスサイクル数計算に使用します。シ
ミュレータ・デバッガでは、表 3-2に示すメモリ種別をサポートしています。

表3-2　メモリ種別
メモリ種別 デバッグ対象プログラムの実行

内蔵 ROM 可能

内蔵 RAM 可能

外部メモリ 可能

内蔵 I/O 不可能

EEPROM 可能
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メモリマップは、System Configurationダイアログボックス上で設定することができ、シミュレー
ション時のメモリアクセスサイクル数の計算に使用します。設定できる項目は次の通りです。

• メモリ種別
• メモリ領域の先頭位置、終了位置
• メモリアクセスのサイクル数
• メモリのデータバス幅

設定できるメモリ種別は、CPUによって異なります。詳細は、「5.18　System Configurationダ
イアログボックス」を参照してください。なお、デバッグ対象プログラムは、内蔵 I/O空間を除く
すべてのメモリで実行可能です。

(2) メモリリソースの確保

デバッグ対象プログラムをロードして実行させるためにメモリリソースを設定する必要がありま
す。メモリリソースは、System Memory Resource Modifyダイアログボックスで設定できます。設定
できる項目は以下の通りです。

• 開始アドレス
• 終了アドレス
• アクセス種別

アクセス種別は、読み書き可能、読み出しのみ可能、書き込みのみ可能があります。

デバッグ対象プログラムで、読み出しのみ可能メモリへ書き込みを行う等の不正なアクセスを行
ったときはエラーとなるので、誤ったメモリアクセスを検出することができます。

EEPROMについては、他のメモリと異なりアクセス種別が読み出しのみ可能な場合でも、EEPMOV
命令により書き込みできます。反対に書き込み可能でも、EEPMOV命令以外では書き込みできませ
ん。

3.3 命令実行リセット処理
シミュレータ・デバッガでは、以下の場合に命令実行数および命令実行サイクル数をリセットし

ます。
（1） 命令シミュレーション停止後再実行までにPCが変更された
（2） 実行開始アドレスを指定したRunコマンドが実行された
（3） イニシャライズまたはプログラムのロードが行われた

3.4 例外処理
シミュレータ・デバッガでは、TRAPA命令（H8/300H、H8Sシリーズのみ）、トレース例外（H8S

シリーズのみ）の発生を検出し、例外処理をシミュレーションします。これにより、例外発生時の
シミュレーションも行うことができます。
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例外処理のシミュレーションは、次の手順で行います。

(a) 命令の実行中に例外の発生を検出します。
(b) スタック領域に PCと CCRを退避します。EXRの有効ビットが ONのときには EXRも退

避します。退避処理でエラーが発生した場合は、例外処理を中止し、例外処理エラーが
発生したことを表示後、シミュレータ･デバッガのコマンド待ちに戻ります。

(c) CCRの Iビットを１にセットします。
(d) ベクタ番号に対応するベクタアドレスから、スタートアドレスを読み出します。読み出

し処理でエラーが発生した場合は、例外処理を中止し、例外処理エラーが発生したこと
を表示後、シミュレータ･デバッガのコマンド待ちに戻ります。

(e) スタートアドレスから命令実行を行います。スタートアドレスが０の場合は、例外処理
を中止し、例外処理エラーが発生したことを表示後、シミュレータ・デバッガのコマン
ド待ち状態に戻ります。

3.5 H8S/2600CPU特殊機能
(1) MAC命令

H8S/2600CPUでは、積和演算（MAC 命令）が行えます。この命令では飽和演算、非飽和演算が
選択できます。本シミュレータ･デバッガでは内蔵 I/Oの SYSCRレジスタのビット７（以下 MACS
ビットとする）の値により判定します。
MACSビット０：非飽和演算
            １：飽和演算

(2) EXRレジスタ

H8S/2600CPUでは EXRレジスタを使用できます。また、このレジスタの有効/無効を設定するこ
ともできます。本シミュレータ･デバッガでは内蔵 I/Oの SYSCRレジスタのビット５（以下 EXR
ビットとする）の値により判定します。
EXRビット０：EXR無効

        １：EXR有効

SYSCRアドレスは、System Configurationダイアログボックスの [SYSCR Address]で設定します。
【注】 SYSCRアドレスは内蔵 I/Oに設定してください。内蔵 I/O以外に SYSCRアドレスが設定

されている場合は MACSビットを０（非飽和）、EXRビットを０（EXR無効）と判断し
ますのでご注意ください。

詳しくは、「5.18　System Configurationダイアログボックス」、「5.22　Control Registers」、
および「5.23　SYSCRダイアログボックス」を参照してください。

3.6 制御レジスタ
H8S/2600シリーズでは、メモリにマッピングされた制御レジスタとして、SYSCR（システムコン

トロールレジスタ）をサポートしています。これにより、積和演算、EXRアクセスを行っているデ
バッグ対象プログラムのシミュレーション、デバッグを行うことができます。

SYSCRアドレスは、System Configurationダイアログボックスの [SYSCR Address]で設定します。
制御レジスタの変更や表示は Control Registersウィンドウと SYSCRダイアログボックスをご利用く
ださい。
詳しくは、「5.18　System Configurationダイアログボックス」、「5.22　Control Registers」お
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よび「5.23　SYSCRダイアログボックス」を参照してください。

3.7 トレース
シミュレータ・デバッガは、実行結果をトレースバッファに書き込みます。トレースバッファの

大きさは 1024行までです。トレース情報の取得条件は、Trace Acquisitionダイアログボックスで指
定します。Trace Acquisitionダイアログボックスは、Traceウィンドウ上で右クリックしてポップア
ップメニューを表示し、[Acquisition]を選択することによって表示できます。取得したトレース情報
は、Traceウィンドウに表示します。Traceウィンドウに表示する内容は、以下の通りです

• 累計命令実行サイクル数
• 命令アドレス
• CCR
• 乗算器内部フラグ（H8S/2600シリーズでのみ有効）
• 命令ニーモニック
• データアクセス情報（転送先および転送データ）
• C/C++またはアセンブラソース

トレース情報はサーチすることができます。サーチ条件は、Trace Searchダイアログボックスで設
定します。Trace Searchダイアログボックスは、Traceウィンドウ上で右クリックしてポップアップ
メニューを表示し、[Find]を選択することによって表示できます。
詳しくは、「5.14　Trace」から「5.16　Trace Searchダイアログボックス」を参照してくださ

い。
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3.8 標準入出力およびファイル入出力処理
シミュレータ・デバッガでは、デバッグ対象プログラムから標準入出力およびファイル入出力を

行うことができます。入出力機能を利用する場合は、必ず Simulated I/Oウィンドウをオープンして
おいてください。
サポートしている入出力処理は以下の通りです。機能コードには、16ビットアドレス版、24ビッ

トアドレス版、32ビットアドレス版があります。使用する CPUに合わせて選択してください。

表3-3　入出力機能一覧
番号 機能コード 機能名 内　容

1 H'01 (16ビットアドレス)

H'11 (24ビットアドレス)

H'21 (32ビットアドレス)

GETC 標準入力からの１バイト入力

2 H'02 (16ビットアドレス)

H'12 (24ビットアドレス)

H'22 (32ビットアドレス)

PUTC 標準出力への１バイト出力

3 H'03 (16ビットアドレス)

H'13 (24ビットアドレス)

H'23 (32ビットアドレス)

GETS 標準入力からの１行入力

4 H'04 (16ビットアドレス)

H'14 (24ビットアドレス)

H'24 (32ビットアドレス)

PUTS 標準出力への１行出力

5 H'05 (16ビットアドレス)

H'15 (24ビットアドレス)

H'25 (32ビットアドレス)

FOPEN ファイルのオープン

6 H'06 FCLOSE ファイルのクローズ

7 H'017(16ビットアドレス)

H'17 (24ビットアドレス)

H'27 (32ビットアドレス)

FGETC ファイルからの１バイト入力

8 H'08 (16ビットアドレス)

H'18 (24ビットアドレス)

H'28 (32ビットアドレス)

FPUTC ファイルへの１バイト出力

9 H'09 (16ビットアドレス)

H'19 (24ビットアドレス)

H'29 (32ビットアドレス)

FGETS ファイルからの１行入力

10 H'0A (16ビットアドレス)

H'1A (24ビットアドレス)

H'2A (32ビットアドレス)

FPUTS ファイルへの１行出力

11 H'0B FEOF エンドオブファイルのチェック

12 H'0C FSEEK ファイルポインタの移動

13 H'0D FTELL ファイルポインタの現在位置を得る
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この機能を実現するためには、まず入出力用の特定の位置を System Configurationダイアログボッ
クスの [System Call Address]で指定し、[Enable]をチェック後、デバッグ対象プログラムを実行しま
す。シミュレータ・デバッガでは、デバッグ対象プログラムの命令を実行中に、指定された位置へ
のサブルーチン分岐命令（BSR、JSR）すなわちシステムコール命令を検出すると、R0、R1（H8/300、
H8/300Lシリーズ）または ER1（H8/300H、H8Sシリーズ）の内容をパラメータとして入出力処理
を行います。

したがって、システムコールを行う前にデバッグ対象プログラムの中で次の設定をしておきます。

・ R0レジスタ：表 3-3に示す機能コード

MSB 1バイト 1バイト LSB

H'01 機能コード�　― ― ―� ― ― ―�

・ R1レジスタ：パラメータブロックのアドレス
（パラメータブロックの内容は各機能の説明を参照してください。）

MSB LSB

　　　　　パラメータブロックのアドレス��

・パラメータブロックおよび入出力バッファ領域の確保

なお、パラメータブロックの各パラメータにアクセスする場合は、該当するパラメータのサイズ
でアクセスしてください。
入出力処理が終了すると、システムコール命令の次の命令からシミュレーションを再開します。

各入出力機能を図3-1の形式で説明します。

（1） （4）
（2）
（3）

【パラメータブロック】 （5）

【パラメータ】 （6）

図3-1　入出力機能の説明形式

各項目の内容は、以下の通りです。
（1） 表3-3に対応する番号
（2） 機能名
（3） 機能コード
（4） 入出力の機能
（5） 入出力のパラメータブロック
（6） 入出力のパラメータ
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GETC
1

H'01、H'11、H'21
標準入力からの１バイト入力

・機能コード：H'01 (16ビットアドレス)

１バイト １バイト

�� 入力バッファ先頭アドレス

・機能コード：H'11 (24ビットアドレス)、H'21 (32ビットアドレス)

１バイト １バイト

��

��
入力バッファ先頭アドレス

【パラメータブロック】

入力バッファ先頭アドレス（入力）【パラメータ】

入力データを書き込むバッファの先頭アドレス

PUTC
2

H'02、H'12、H'22
標準出力への１バイト出力

・機能コード：H'02 (16ビットアドレス)

１バイト １バイト

�� 出力バッファ先頭アドレス

・機能コード：H'12 (24ビットアドレス)、H'22 (32ビットアドレス)

１バイト １バイト

��

��
出力バッファ先頭アドレス

【パラメータブロック】

出力バッファ先頭アドレス（入力）【パラメータ】

出力データを格納しているバッファの先頭アドレス

GETS
3

H'03、H'13、H'23
標準入力からの１行入力

・機能コード：H'03 (16ビットアドレス)

１バイト １バイト

�� 入力バッファ先頭アドレス

・機能コード：H'13 (24ビットアドレス)、H'23 (32ビットアドレス)

１バイト １バイト

��

��
入力バッファ先頭アドレス

【パラメータブロック】

入力バッファ先頭アドレス（入力）【パラメータ】

入力データを書き込むバッファの先頭アドレス
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PUTS
4

H'04、H'14、H'24
標準出力への１行出力

・機能コード：H'04 (16ビットアドレス)

１バイト １バイト

�� 出力バッファ先頭アドレス

・機能コード：H'14 (24ビットアドレス)、H'24 (32ビットアドレス)

１バイト １バイト

��

��
出力バッファ先頭アドレス

【パラメータブロック】

出力バッファ先頭アドレス（入力）【パラメータ】

出力データを格納しているバッファの先頭アドレス
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FOPEN
5

H'05、H'15、H'25
ファイルのオープン

FOPENによってファイルをオープンすると、ファイル番号が返されます。以後のファイル入出力、
ファイルクローズ等では、このファイル番号を用います。同時にオープンできる最大ファイル数は256
です。

・機能コード：H'05 (16ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� オープンモード 未使用

�� ファイル名先頭アドレス

・機能コード：H'15 (24ビットアドレス)、H'25 (32ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� オープンモード 未使用

��

��
ファイル名先頭アドレス

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ エラー

ファイル番号（出力）

オープン処理以降のファイルアクセスで使用する番号

オープンモード（入力）

H'00 ���

H'01 ���

H'02 �	�

H'03 ����

H'04 ����

H'05 �	��

H'10 ��
�

H'11 ��
�

H'12 �	
�

H'13 ���
�

H'14 ���
�

H'15 �	�
�

各モードの内容は以下の通りです。

��� 読み出し用にオープンする。

��� 空ファイルを書き込み用にオープンする。

�	� ファイルの最後から書き込み用にオープンする。

���� 読み出し，書き込み用にオープンする。

���� 空ファイルを読み出し，書き込み用にオープンする。

�	�� 読み出し追加用にオープンする。

【パラメータ】

�
� バイナリモードでオープンする。
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ファイル名先頭アドレス（入力）

ファイル名を格納している領域の先頭アドレス

FCLOSE
6

H'06
ファイルのクローズ

１バイト １バイト

�� 実行結果 ファイル番号

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ エラー

ファイル番号（入力）

【パラメータ】

ファイルオープン時に返される番号

FGETC
7

H'07、H'17、H'27
ファイルから �バイトのデータ読み出し

・機能コード：H'07 (16ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� 入力バッファ先頭アドレス

・機能コード：H'17 (24ビットアドレス)、H'27 (32ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

��

��
入力バッファ先頭アドレス

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ ��検出

ファイル番号（入力）

ファイルオープン時に返される番号

入力バッファ先頭アドレス（入力）

【パラメータ】

入力データを書き込むバッファの先頭アドレス
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FPUTC
8

H'08、H'18、H'28
ファイルへ �バイトのデータ書き込み

・機能コード：H'08 (16ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� 出力バッファ先頭アドレス

・機能コード：H'18 (24ビットアドレス)、H'28 (32ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

��

��
出力バッファ先頭アドレス

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ エラー

ファイル番号（入力）

ファイルオープン時に返される番号

出力バッファ先頭アドレス（入力）

【パラメータ】

出力データを格納しているバッファの先頭アドレス

FGETS
9

H'09、H'19、H'29
ファイルから文字列データの読み出し

改行コードまたは NULL コードを検出するまで，またはバッファサイズに達するまでファイルか
ら文字列データを読み出します。

・機能コード：H'09 (16ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� バッファサイズ

�� 入力バッファ先頭アドレス

・機能コード：H'19 (24ビットアドレス)、H'29 (32ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� バッファサイズ

��

��
入力バッファ先頭アドレス

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ EOF検出

【パラメータ】

ファイル番号（入力）
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ファイルオープン時に返される番号

バッファサイズ（入力）

データを格納する領域のサイズ

（バイト単位で最大 ���バイトまで）

入力バッファ先頭アドレス（入力）

入力データを書き込むバッファの先頭アドレス

FPUTS
10

H'0A、H'1A、H'2A
ファイルへ文字列データ書き込み

ファイルへ文字列データ書き込みます。文字列終端記号の NULL コードはファイルには書き込ま
れません。

・機能コード：H'0A (16ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

�� 出力バッファ先頭アドレス

・機能コード：H'1A (24ビットアドレス)、H'2A (32ビットアドレス)

１バイト １バイト

�� 実行結果 ファイル番号

��

��
出力バッファ先頭アドレス

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ エラー

ファイル番号（入力）

ファイルオープン時に返される番号

出力バッファ先頭アドレス（入力）

【パラメータ】

出力データを格納しているバッファの先頭アドレス

FEOF
11

H'0B
エンドオブファイルのチェック

１バイト １バイト

�� 実行結果 ファイル番号

【パラメータブロック】

実行結果（出力）

０ EOFでない

–１ EOF検出

ファイル番号（入力）

【パラメータ】

ファイルオープン時に返される番号
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FSEEK
12

H'0C
指定位置にファイルポインタを移動

１バイト １バイト

�� 実行結果 ファイル番号

�� ディレクション 未使用

�� オフセット上位ワード

�� オフセット下位ワード

【パラメータブロック】

実行結果（出力）

０ 正常終了

–１ エラー

ファイル番号（入力）

ファイルオープン時に返される番号

ディレクション（入力）

０ オフセットはファイルの先頭からのバイト数

１ オフセットは現在のファイルポインタからのバイト数

２ オフセットはファイルの最後尾からのバイト数

オフセット（入力）

【パラメータ】

ディレクションで指定した位置からのバイト数

FTELL
13

H'0D
ファイルポインタの現在位置を調査

１バイト １バイト

�� 実行結果 ファイル番号

�� オフセット上位ワード

�� オフセット下位ワード

【パラメータブロック】

実行結果（出力）

0 正常終了

–１ エラー

ファイル番号（入力）

ファイルオープン時に返される番号

オフセット（出力）

【パラメータ】

現在のファイルポインタの位置

（ファイル先頭からのバイト数）



3.　シミュレータ・デバッガの機能

22

以下に標準入力（キーボード）から１文字入力する例を示します。システムコールアドレスとし
てラベル SYS_CALLを指定します。

MOV.W #H'0101, R0
MOV.W #PARM, R1
JSR @SYS_CALL

STOP NOP
SYS_CALL NOP
PARM DATA.W .INBUF
INBUF .RES.B 2

.END

3.9 命令実行サイクル数の計算
シミュレータ･デバッガでの命令実行サイクル数計算は、H8S、H8/300シリーズ プログラミング

マニュアルに記載されている計算式と System Configurationダイアログボックスで設定したメモリの
データバス幅およびアクセスサイクル数を使用して行います。ただし、以下の理由によりシミュレ
ータ･デバッガで計算した命令実行サイクル数と、実機でプログラムを実行した場合の命令実行サイ
クル数が異なることがあります。

(1) MOVFPE、MOVTPE命令

Eクロック同期命令のデータ転送サイクル数は、9～16と幅を持った値となっています。シミュレ
ータ･デバッガでは「11+オペランドアクセスサイクル数」で計算します。オペランドアクセスサイ
クル数は、メモリのデータバス幅およびアクセスサイクル数より求めます。

(2) EEPMOV命令

EEPROM書き込み専用命令のサイクル数は、命令読み出しに要するサイクル数と、データを転送
するのに要するサイクル数の合計となります。

(3) SLEEP命令

シミュレータ･デバッガでは、SLEEP命令がプログラム停止用命令として使用される場合を考慮
して、サイクル数を加算しません。

(4) 標準入出力およびファイル入出力処理

標準入出力およびファイル入出力処理は、シミュレータ･デバッガ固有の機能であるため、サイク
ル数に加算しません。なお、標準入出力およびファイル入出力処理とは、BSR、JSR命令でシステ
ムコールアドレスで指定された位置への分岐が完了してから入出力処理を行いコール元に戻るまで
です。
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3.10 ブレーク条件
デバッグ対象プログラムのシミュレーションを中断する条件として以下のものがあります。

• ブレーク系コマンドの条件成立によるブレーク
• デバッグ対象プログラムの実行時エラー検出によるブレーク
• トレースバッファ満杯によるブレーク
• SLEEP命令実行によるブレーク
• [STOP]ボタンによるブレーク

(1) ブレーク系コマンドの条件成立によるブレーク

ブレーク条件を設定するコマンドには次の 5種類があります。
• BREAKPOINT ：命令実行位置によるブレーク
• BREAK_ACCESS ：メモリ範囲のアクセスによるブレーク
• BREAK_DATA ：メモリ書き込みデータ値によるブレーク
• BREAK_REGISTER ：レジスタ書き込みデータ値によるブレーク
• BREAK_SEQUENCE ：実行順序を指定したブレーク

デバッグ対象プログラム実行中にブレーク条件が成立した場合、ブレークポイントの命令を実行
しないで停止するか、実行してから停止するかを表 3-4に示します。

表3-4　ブレーク条件成立時の処理
ブレーク条件成立命令コマンド名

実行する 実行しない

BREAKPOINT ○

BREAK_ACCESS ○

BREAK_DATA ○

BREAK_REGISTER ○

BREAK_SEQUENCE ○

BREAKPOINT、BREAK_SEQUENCEの場合、実行命令の先頭位置以外にブレークポイントを設
定するとブレークを検出できません。
デバッグ対象プログラム実行中にブレーク条件が成立すると、ブレーク条件成立のメッセージを

ステータスバーに表示して、命令実行を中断します。

(2) デバッグ対象プログラムの実行時エラー検出によるブレーク

シミュレータ・デバッガでは、CPUの例外発生機能では検出できないプログラムの誤りを検出す
るためにシミュレーションエラーを設けています。これらのエラーが発生した場合に、シミュレー
ションを停止するか、続行するかを System Configurationダイアログボックスにより選択できます。
エラーの種類、エラーメッセージ、エラー発生要因、および続行時のシミュレータ・デバッガの動
作を表 3-5に示します。
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表3-5　シミュレーションエラー一覧
エラーの種類/メッセージ エラー発生要因 続行モード時処理

アドレスエラー/Address Error • PC値が奇数

• 内蔵 I/O空間からの命令フェッチ

• 奇数アドレスからのワードアクセス

• 奇数アドレスからのロングワードアク
セス

デバイスと同一動作をする

メモリアクセスエラー/

Memory Access Error

• 確保されていないメモリ領域をアクセ
スしようとした

• 書き込み不可属性を持つメモリへ書き
込みを行おうとした

• 読み出し不可属性を持つメモリから読
み出しを行おうとした

• メモリが存在しない領域をアクセスし
ようとした

• EEPMOV命令以外の命令での
EEPROM書き込み

メモリへの書き込み時、何も
書き込まない

メモリ読み出し時、全ビット
"１"を読み出す

• 命令ではないコードの実行 常に停止する不当命令/

Illegal Instruction • MOV.B Rn,@-SP または MOV.B
@SP+,Rn の実行

そのまま実行するが結果は保
証しない

命令実行不正/

Illegal Operation

• DAA命令、DAS命令で CCRの Cフ
ラグ、Hフラグと補正前の値の関係不
正

• DIVXU命令、DIVXS命令のゼロ除算ま
たはオーバーフロー

そのまま実行するが結果は保
証しない

停止モードの場合、シミュレーションエラーが発生するとシミュレータ・デバッガは、命令実行
を中止してエラーメッセージを表示後、コマンド待ち状態に戻ります。シミュレーションエラー停
止後の PCの状態を表 3-6に示します。なお、シミュレーションエラー停止後 SRの内容は変化しま
せん。

表3-6　シミュレーションエラー停止時のレジスタ
エラーの種類 PCの内容

アドレスエラー、

メモリアクセスエラー

命令読込時：

　エラーが発生した命令の先頭アドレス

命令実行時：

　エラーが発生した命令の次命令のアドレス

不当命令 エラーが発生した命令の先頭アドレス

命令実行不正 エラーが発生した命令の次命令のアドレス

シミュレーションエラーが発生する命令を組み込んだプログラムのデバッグは、次の手順で行っ
てください。

(a) 最初は停止モードで実行させて、意図している箇所以外にエラーがないかどうかを確認し
てください。

(b) 確認が完了したら、続行モードで実行してください。
【注】 停止モードでエラーが発生して停止した状態から、モードを続行モードに変更してシミュ

レーションを再開すると、正しくシミュレーションされない場合があります。シミュレー
ションを再開する場合は、レジスタ内容、メモリの内容をエラー発生前の状態に戻してか
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ら再実行するようにしてください。

(3) トレースバッファ満杯によるブレーク

Trace Acquisitionダイアログボックスの [Trace buffer full handling]で [Break]モードを指定し、命令
実行中にトレースバッファが満杯になると、シミュレータ・デバッガは、実行を中断します。中断
時には以下のメッセージをステータスバーに表示します。

 Trace Buffer Full

(4) SLEEP命令実行によるブレーク

命令実行時に、SLEEP命令を実行すると、シミュレータ・デバッガは実行を中断します。中断時
には、以下のメッセージをステータスバーに表示します。

Sleep
【注】 実行を再開する場合は、PCの値を再開位置の命令アドレスに変更してください。

(5) [STOP]ボタンによるブレーク

命令実行中にユーザにより強制的に実行を中断することができます。中断時には以下のメッセー
ジをステータスバーに表示します。

Stop
Go、Stepコマンドにより実行を再開できます。

3.11 浮動小数点データ
実数データとして浮動小数点数を指定することができます。これにより、データ値等で浮動小数

点を扱う場合の操作が容易になります。浮動小数点を指定できる項目は次の通りです。

• Set Breakダイアログボックスにおいて、ブレーク種別を [Break Data] や [Break Register]と
指定したときのデータ

• Memoryウィンドウにおけるデータ
• Fill Memoryダイアログボックスにおけるデータ
• Search Memoryダイアログボックスにおけるデータ

浮動小数点データフォーマットは、ANSI Cの浮動小数点フォーマットに準拠しています。

シミュレータ・デバッガでは、System Configurationダイアログボックスにより、浮動小数点数の
10進→2進変換で発生する丸めのモードを選択することができます。次の２通りより選択します。

• RN（Round to Nearest）
• RZ（Round to Zero）

なお、10進→2進変換および 2進→10進変換で非正規化数が指定された場合、RZモードでは 0
に変換し、RNモードでは非正規化数のまま処理します。また、10進→2進変換時にオーバーフロー
が発生した場合、RZモードでは浮動小数点数の最大値を、RNモードでは無限大を設定します。



3.　シミュレータ・デバッガの機能

26

3.12 関数呼び出し履歴の表示
シミュレーションの中断時に、関数の呼び出し履歴を Stack Traceウィンドウに表示します。これ

により、プログラムの動作の流れを確認することができます。また、Stack Traceウィンドウ上で関
数名を選択することにより、該当するソースプログラムを Sourceウィンドウ上に表示します。これ
により、中断している関数の他に、その関数を呼び出した元の関数をチェックすることができます。
関数呼び出し履歴を更新するのは、以下のような場合です。

• 「3.10　ブレーク条件」に示す条件によりシミュレーションが中断した時
• 上記中断した状態で、レジスタの値を変更した時
• シミュレーションをステップ実行している時

詳しくは、「5.25　Stack Trace」を参照してください。
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4. メニュー

このマニュアルでは、標準的な Microsoft®メニュー命名規約を使用しています。

メニュータイトル�

メニューバー�

ドロップダウン�
メニュー�

メニュー�
オプション�

省略符号�

チェックマーク�

カスケードメニュー�

図4-1　メニュー

チェックマークは、そのメニューオプションにより提供する機能が選択されていることを示しま
す。
省略符号は、そのメニューオプションを選択すると、追加情報の入力が必要なダイアログボック

スを表示することを示します。

Windows®メニューシステムの使用法については、Windows®ユーザーズマニュアルを参照してくだ
さい。

4.1 File
Fileメニューは、プログラムファイルにアクセスする場合に使用します。

4.1.1 New Session...
新しいデバッグプラットフォームを選択ができるように Select Session ダイアログボックスを

表示します。

4.1.2 Load Session...
セッションファイル(拡張子が hds)を指定してロードできるように Select Sessionダイアログボ

ックスを表示します。セッションファイルには、デバッグプラットフォームの設定、シンボル、ブ
レークポイント、レジスタ値などのウィンドウ情報、位置情報が含まれています。

4.1.3 Save Session
現在のセッションファイルを更新します。現在のセッションファイルが定義されていない場合

は、[Save Session As...]メニューオプションと同様の動作をします。



4. メニュー

28

4.1.4 Save Session As...
現在のセッションを新しいファイル名でセーブするために Save Asダイアログボックスを表示し

ます。セッションファイルには、デバッグプラットフォームの設定、シンボル、ブレークポイント、
レジスタ値などウィンドウの情報、位置が含まれています。

4.1.5 Load Program...
Load Programダイアログボックスを表示します。S-Recordフォーマット(拡張子は*.mot、*.s20、

*.obj)または ELF/DWARFフォーマット(拡張子は*.abs)のオブジェクトファイルを選択してデバッグ
プラットフォームのメモリにダウンロードします。選択したファイルでシンボルが使用できる場合
は、シンボルもロードします。

4.1.6 Initialize
デバッグシステムを再初期化します。現在オープンしているウィンドウをクローズし、デバッ

グプラットフォームとの接続を解除します。そして、デバッグプラットフォームの再接続をします。
ステータスバーの最左端に’Link up’と表示されれば、初期化を完了したことを意味します。「4.4.1
Reset CPU」も参照してください。

4.1.7 Exit
HDI を終了します。HDI Optionダイアログボックスの’On Exit’セクションに指定された動作をし

ます。「4.6.2 Options...」も参照してください。

4.2 Edit
Editメニューは、プログラムのうち、各ウィンドウのデータを変更する場合や、デバッグプラッ

トフォームのメモリデータに対して、それらのデータを変更する場合に使用します。

4.2.1 Cut
内容を変更できるウィンドウでブロックが反転表示されている場合にのみ使用できます。

反転表示されているブロックの内容をウィンドウから削除し、Windows®標準のクリップボードに
格納します。

4.2.2 Copy
内容が変更できるウィンドウでブロックが反転表示されている場合にのみ使用できます。

反転表示されているブロックの内容をWindows®標準のクリップボードにコピーします。

4.2.3 Paste
ウィンドウの内容が変更可能な場合のみ使用できます。

Windows®標準のクリップボードの内容をウィンドウの現在のカーソル位置にコピーします。
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4.2.4 Find...
ウィンドウにテキストが含まれている場合のみ使用できます。

Findダイアログボックスを表示し、ユーザが単語を入力してテキスト中の出現箇所を検索できる
ようにします。一致する単語を見つけると、カーソルがその単語の先頭に移動します。

4.2.5 Evaluate...
Evaluateダイアログボックスを表示します。たとえば"(#pc + 205)*2"のような数式を入力して、

その結果を現在サポートしているすべての基数で表示します。

4.3 View
Viewメニューは、新規に各ウィンドウを開くために使用します。メニューオプションがグレー表

示されていれば、そのウィンドウによって提供する機能は現在のデバッグプラットフォームで使用
できません。

4.3.1 Breakpoints
Breakpointsウィンドウを開きます。現在設定されているブレークポイントを表示して変更でき

るようにします。

4.3.2 Command Line
Command Lineウィンドウを開きます。テキストベースのコマンドを使用して、デバッグプラ

ットフォームを制御できます。これらのコマンドは、バッチファイルから読み込み、結果をログフ
ァイルに書き出すことができます。これにより、自動テストが実行できます。

4.3.3 Disassembly...
表示を開始するアドレスを入力できるように Set Addressダイアログボックスを表示します。

4.3.4 Labels
プログラム中のシンボル・ラベルを操作できるよう Labelsウィンドウを表示します。

4.3.5 Locals
Localsウィンドウを開きます。現在の関数において定義されている変数の値を表示し、変更で

きるようにします。PCが C/C++ソースレベル関数の中になければ、ウィンドウは空白となります。

4.3.6 Memory...
Open Memory Windowダイアログボックスを表示します。Memoryウィンドウ内に表示するメモ

リブロック位置と表示フォーマットを指定できるようにします。

4.3.7 Performance Analysis
Performance Analysisウィンドウを開きます。ユーザプログラムの特定のセクションが呼び出さ

れる回数を計測・表示できるようにします。
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4.3.8 Profile-List
Profile-Listウィンドウを開きます。関数とグローバル変数のアドレス、サイズ、関数呼出し回

数、およびプロファイルデータを表示します。

4.3.9 Profile-Tree
Profile-Treeウィンドウを開きます。関数の呼出し関係をツリー構造で表示します。また、各関

数のアドレス、サイズ、スタックサイズ、関数呼出し回数、およびプロファイルデータを表示しま
す。スタックサイズ、関数呼出し回数、およびプロファイルデータは、実際の関数が呼出された経
路における値を表示します。

4.3.10 Registers
Registersウィンドウを開きます。現在の CPUのすべてのレジスタとその内容を見ることがで

きます。

4.3.11 Source...
Openダイアログボックスを表示します。表示したいソースファイル（C/C++言語フォーマット

またはアセンブラ言語フォーマット）のファイル名を入力します。ソースファイルが現在のプログ
ラムに含まれていない場合、あるいはアブソリュートファイル(*.abs)内にそのファイルのデバッグ
情報がない場合は、"Cannot load program. No Source level debugging available"というメッセージを表示
します。

4.3.12 Status
System Statusウィンドウを開きます。デバッグプラットフォームの現在の状態、セッション、

プログラム名を見られるようにします。

4.3.13 Trace
Traceウィンドウを開きます。現在のトレース情報を見られるようにします。

4.3.14 Watch
Watchウィンドウを開きます。C/C++ソースレベルの変数を入力し、その内容を表示・変更で

きるようにします。

4.3.15 Localized Dump…
Open Localized Dumpダイアログボックスを開きます。Localized Dumpウィンドウ内に表示するメ

モリ内容の開始アドレス、表示バイト数、および DBSCの種類を入力できるようにします。

4.3.16 Simulated I/O
Simulated I/Oウィンドウを開きます。標準入出力、ファイル I/Oを使用できるようにします。

4.3.17 Stack Trace
Stack Traceウィンドウを開きます。現在のスタックトレース情報を表示できるようにします。



4. メニュー

31

4.3.18 External Tool
External Toolsウィンドウを開きます。協調検証ツールを使用できるようにします。

4.4 Run
Runメニューは、デバッグプラットフォームにおけるユーザプログラムの実行を制御するために

使用します。

4.4.1 Reset CPU
ターゲットハードウェアをリセットし、PCをリセットベクタアドレスに設定します(デバッグ

プラットフォームのリセットについては ｢4.1.6 Initialize｣を参照)。

4.4.2 Go
現在の PCからユーザプログラムを実行します。

4.4.3 Reset Go
リセットベクタアドレスからユーザプログラムを実行します。

4.4.4 Go To Cursor
現在の PCからユーザプログラムの実行を開始し、PCが現在のテキストカーソル(マウスカー

ソルではありません)の位置によって示されたアドレスに到達するまで継続します。

4.4.5 Set PC To Cursor
PCを現在のテキストカーソル(マウスカーソルではありません)の位置によって示されるアドレ

スに設定します。アドレスが有効でなければ、無効です。

4.4.6 Run...
Run Programダイアログボックスを表示します。ユーザプログラムの実行開始前にブレークポイン

トを入力できます。

4.4.7 Step In
ユーザプログラムの 1ブロックを実行して停止します。このブロックのサイズは、通常は単一

の命令ですが、ユーザが複数の命令または C/C++ソース行に設定することも可能です(「4.4.10
Step...」参照)。サブルーチンを呼び出した場合は、そのサブルーチンに入って実行を停止し、サブ
ルーチンのコードを表示します。
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4.4.8 Step Over
ユーザプログラムの 1ブロックを実行して停止します。このブロックのサイズは、通常は単一

の命令ですが、ユーザが複数の命令または C/C++ソース行に設定することも可能です(「12.4.10
Step...」参照)。サブルーチンを呼び出す場合は、そのサブルーチンには入らず、現在の PC位置が
現在の表示の次行に移動するまでユーザプログラムを実行します。

4.4.9 Step Out
現在の関数の終わりに到達するまでユーザプログラムを実行し、呼び出す関数の次の行に PC

を設定して停止します。

4.4.10 Step...
Step Programダイアログボックスを表示します。ステップ動作の設定を変更できるようにしま

す。

4.4.11 Halt
ユーザプログラムの実行を停止します。

4.5 Memory
Memoryメニューは、ユーザプログラムがアクセスするメモリの設定に使われます。

4.5.1 Refresh
すべてのオープンしている Memoryウィンドウの内容を強制的にアップデートします。

4.5.2 Load...
メモリ領域のアドレスのオフセット、S-recordフォーマットのファイルを選択できるように、

Load Memoryダイアログボックスを表示します。

4.5.3 Save...
メモリ領域の開始、終了アドレスを指定し、S-recordフォーマットでファイルを保存するため

の Save Memory Asダイアログボックスを表示します。ダイアログボックスを表示したときに自動的
に設定する開始、終了アドレスは、Memoryウィンドウ中の反転表示されたメモリブロックです。

4.5.4 Verify...
ディスク上の S-recordファイルとベリファイするメモリ領域の開始、終了アドレスを設定する

ための Verify S-Record File with Memoryダイアログボックスを表示します。
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4.5.5 Test...
Test Memoryダイアログボックスを表示します。メモリブロックを指定して、デバッグプラッ

トフォームのメモリブロックに対して、読み取り/書き込み動作が正しく行われているかをテストし
ます。このテストは、ターゲットに依存します。しかし、すべてのケースで現在のメモリ内容は上
書きされ、プログラムとデータは削除されます。本シミュレータ・デバッガではサポートしていま
せん。

4.5.6 Fill...
Fill Memoryダイアログボックスを表示します。デバッグプラットフォームのメモリブロックに

値を書き込みます。開始、終了フィールドは、Saveオプション(｢4.5.3 Save...｣も参照)と同様に設定
します。

4.5.7 Copy...
Copy Memoryダイアログボックスを表示します。デバッグプラットフォームの同一メモリスペ

ース内で、メモリブロックを別の位置にコピーします。これらのブロックは重なってもかまいませ
ん。開始、終了フィールドは、Saveオプション(｢4.5.3 Save...｣も参照)と同様に設定します。

4.5.8 Compare...
メモリ領域の開始アドレスと終了アドレスを指定し、別のメモリ領域と比較するためのCompare

Memoryダイアログボックスを表示します。開始、終了フィールドは、Saveオプション(｢4.5.3 Save...｣
も参照)と同様に設定します。

4.5.9 Configure Map...
Memory Mappingウィンドウを開きます。デバッグプラットフォームの現在のメモリマップを

表示し、変更できるようにします。デバッグプラットフォームにより、Memory Mapダイアログボ
ックスが開きます。

4.5.10 Configure Overlay...
Overlay...ダイアログボックスを表示します。オーバーレイ機能を利用した場合、優先するセク

ショングループを設定することができます。

4.6 Setup
Setupメニューは、HDI ユーザインタフェースの設定変更と、デバッグプラットフォームの設定に

使用します。

4.6.1 Status Bar
ステータスバーの表示/非表示を切り換えます。ステータスバーが表示になっている場合は、メニ

ューテキストの左にチェックマークを表示します。
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4.6.2 Options...
HDI Optionsダイアログボックスを表示します。HDI 固有の設定(デバッグプラットフォーム依

存の設定ではありません)を変更できるようにします。

4.6.3 Radix
　数値を表示したり入力する場合の、(基数の接頭部を入力しなかった場合の)基数のデ

フォルトの設定をカスケードメニューとして表示します。現在選択されている基数は左にチェック
マークが付いていて、ツールバーの対応するボタンが押し下げられています。
たとえば現在の基数が Decimalならば、10進法の 10は"10"と表示され、"10"、"H'A "、"0x0a "な

どと入力できます。現在の基数が Hexadecimalならば、10進法の 10は"0A"と表示され、"A"、"D'10 "
などと入力できます。

4.6.4 Customize
ユーザがカスタマイズできるオプションのリストをカスケードメニューとして表示します。

Toolbar： このカスケードメニューオプションを選択すると Customizeダイアログボックスを表
示します。

Font： このカスケードメニューオプションを選択すると Fontダイアログボックスを表示し
ます。固定長ピッチのフォントを選択することができます。

File Filter： このカスケードメニューオプションを選択すると Customize File Filterダイアログボッ
クスを表示します。オブジェクト、ソースファイル、メモリファイルのファイルフィ
ルタを変更できます。

4.6.5 Configure Platform...
set-upダイアログボックスを表示します。デバッグプラットフォームの設定を変更できるよう

にします。詳しくは「5.18　System Configurationダイアログボックス」を参照してください。

4.7 Window
Windowメニューは、現在開いている各ウィンドウの表示変更に使用します。以下のメニューオ

プションは常に表示しています。また、現在開いているウィンドウの番号付きリストも一緒に表示
します。一番手前に表示しているウィンドウにはチェックマークがついています。

4.7.1 Cascade
ウィンドウを標準的なカスケード方式で、すなわち各ウィンドウのタイトルバーが見えるよう

に左上から配置します。

4.7.2 Tile
ウィンドウを標準的なタイル方式で表示、すなわちすべてのウィンドウが重ならずに表示され

るよう各ウィンドウのサイズを変更します。
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4.7.3 Arrange Icons
アイコン化されたウィンドウを、親フレームの下辺に沿って標準的な方式できれいに整列させ

ます。

4.7.4 Close All
すべてのウィンドウをクローズします。

4.8 Help
Helpメニューは、HDI が提供する機能の使用方法に関する追加情報へのアクセスに使用します。

4.8.1 Index
メインヘルプファイルのインデックスを開きます。

4.8.2 Using Help
Windows®ハイパーテキストヘルプシステムの使用方法のヘルプファイルを開きます。

4.8.3 Search for Help on
メインヘルプファイルを開き、Searchダイアログボックスを表示します。このダイアログボック

スで、ファイルのキーワードを入力・閲覧することができます。

4.8.4 About HDI
About HDIダイアログボックスを表示します。HDI と現在ロードされている DLL のバージョンを

確認することができます。
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5. ウィンドウおよびダイアログボックス

本章では、各ウィンドウおよびダイアログボックスの種類と、それぞれがサポートしている機能、
および関連ポップアップメニューにより使用できるオプションについて説明します。

5.1 Breakpoints

図5-1　Breakpointsウィンドウ

本ウィンドウは、設定されている全ブレークポイントをリスト表示します。
表示する項目は以下の通りです。

[Enable] 該当ブレークポイントの有効/無効を示します。●または Oが表示されているブレーク
ポイントは有効であることを示します。

[File/Line] ブレークポイントの存在するファイル名および行番号を表示します。
[Symbol] ブレークポイントの設定されている位置に対応するシンボルを表示します。対応する

シンボルがない場合は何も表示しません。
[Address] ブレークポイントの設定されている位置を示します。
[Type] ブレーク種別を表示します。

BP：PCブレーク
BA：ブレークアクセス
BD：ブレークデータ
BR：ブレークレジスタ（括弧内にレジスタ名を表示します。）
BS：ブレークシーケンス

また、本ウィンドウでブレークポイントをダブルクリックすると、Set Breakダイアログボックス
が開き、ブレーク条件を変更することができます。ただし、ブレークシーケンスをダブルクリック
すると、Break Sequenceダイアログボックスが開きます。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ
ニューには以下のオプションが含まれています。

5.1.1 Add...
ブレークポイントを設定します。クリックすると、Set Breakダイアログボックスが開き、ブレー
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ク条件を設定することができます。

5.1.2 Edit...
ブレークポイントが選択されている場合のみ有効です。変更したいブレークポイントを選択後ク

リックすると、Set Breakダイアログボックスが開き、ブレーク条件を変更することができます。た
だし、ブレークシーケンスが選択された場合は、Break Sequenceダイアログボックスが開きます。

5.1.3 Delete
ブレークポイントが選択されている場合のみ有効です。選択されているブレークポイントを削除

します。ブレークポイントを削除しないで、詳細情報は保持したまま、条件が成立した場合に実行
を停止させないようにする場合は、Disableオプションを使用します(｢5.1.5 Disable/Enable｣参照)。

5.1.4 Delete All
すべてのブレークポイントをリストから削除します。

5.1.5 Disable/Enable
ブレークポイントが選択されている場合のみ有効です。選択されているブレークポイントの有効

(Enable)/無効(Disable)を切り替えます(無効にした場合は、ブレークポイントはリストには残ります
が、指定した条件が成立しても実行を停止しません)。ブレークポイントが有効となっていれば、メ
ニューテキストの左にチェックマークが付きます(かつ、そのブレークポイントの Enable列に丸を表
示します)。

5.1.6 Go to Source
ブレークポイントのある Sourceまたは Disassemblyウィンドウをオープンします。
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5.2 Set Breakダイアログボックス

図5-2　Set Breakダイアログボックス

本ダイアログボックスでは、ブレーク条件を設定します。
まず、設定するブレーク種別を [Type]ラジオボタンで指定します。各種別において設定可能な項

目を以下に示します。
[PC Breakpoint] [Start address]ブレークする命令の位置

[Count] 指定位置の命令をフェッチする回数
（省略すると１となります）

[Break Access] [Start address]アクセスするとブレークするメモリの開始位置
[End address] アクセスするとブレークするメモリの終了位置

（省略すると開始位置のみが範囲となります）
[Access type] アクセス種別

[Break Data] [Start address]ブレーク判定を行うメモリの位置
[Data] ブレーク条件となるデータ値
[Size] データのサイズ
[Option] データの一致/不一致

[Break Register] [Register] ブレーク条件を設定するレジスタ名
[Data] ブレーク条件となるデータ値

（省略するとレジスタへ書き込む度にブレークします）
[Size] データのサイズ
[Option] データの一致/不一致

[Break Sequence] Break Sequenceダイアログボックスが開くので、そこで設定します。
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[PC Breakpoint]の設定時に、[Start Address]に多重定義関数あるいはメンバ関数を含むクラス名を
入力した場合、Select Functionダイアログボックスが開くので設定する関数を選択します。詳細は、
「14 関数の設定」を参照してください。
指定したブレーク条件は、[OK]ボタンをクリックすることにより設定します。[Cancel]ボタンをク

リックすると、設定しないでダイアログボックスを閉じます。

5.3 Break Sequenceダイアログボックス

図5-3　Break Sequenceダイアログボックス

本ダイアログボックスでは、ブレークの発生条件となる通過アドレスを設定します。
[Address1]～[Address8]にアドレスを指定します。なお、８ポイントすべてを設定する必要はあり

ません。アドレスとして多重定義関数あるいはメンバ関数を含むクラス名を入力した場合、Select
Functionダイアログボックスが開くので設定する関数を選択します。詳細は、「14 関数の設定」を
参照してください。

通過アドレスは、[OK]ボタンをクリックすることにより設定することができます。[Cancel]ボタン
をクリックすると、新たに通過アドレスを設定しないでダイアログボックスを閉じます。
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5.4 Command Line

図5-4　Command Lineウィンドウ

ウィンドウメニューやウィンドウコマンドを使用しないで、テキストベースのコマンドを入力し
てデバッグプラットフォームを制御できるウィンドウです。あらかじめ定義した一連のコマンドを
バッチファイルから呼び出してデバッグプラットフォームに送り、出力結果をログファイルに記録
する必要がある場合に便利です。コマンドの実行は、テキストボックス入力後に Enterキーを押すか、
テキストボックス右にあるボタンをクリックします。使用できるコマンドについては、オンライン
ヘルプを参照してください。
ウィンドウタイトルとしてバッチファイル名とログファイル名をコロンで区切って表示します。

ツールバーボタンの機能は、以下に示すポップアップメニューオプションと同じです。

5.4.1 Set Batch File...
Set Batch Fileダイアログボックスを表示します。HDI コマンドファイル名(*.hdc)を入力できま

す。コマンドファイルは、自動的に実行します。ファイル名をウィンドウのタイトルバーに表示し
ます。

5.4.2 Play
最後に実行したコマンドファイルを実行します。このボタンは、バッチファイルの実行中はグ

レー表示となり、コマンドファイルの実行が停止してユーザに制御が戻ったときに有効表示となり
ます。

5.4.3 Set Log File...
Open Log Fileダイアログボックスを表示します。出力結果を記録する HDI ログファイル(*.log)

の名前を入力します。ロギングオプションは自動的に設定され、ログファイル名をウィンドウのタ
イトルバーに表示します。
既に存在しているログファイル名を指定すると、ログを追加するか、以前のログを消去して、新

しいログを上書きするかを尋ねられます。
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5.4.4 Logging
ファイルへのロギング処理を実行するか、停止するかを切り替えます。ロギングが実行状態に

なっていれば、ボタンが有効状態になります。ログファイルの内容は、ロギングが終了するか、チ
ェックボックスをクリアしてロギングを一時的に停止しなければ表示できないことにご注意くださ
い。ロギングを再び開始すると、ログファイルに追加します。

5.4.5 Select All
Command Lineウィンドウ出力をすべて選択します。

5.4.6 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられるようにします。

5.5 Disassembly
本ウィンドウは、アセンブラレベルでプログラムを表示します。
本ウィンドウは、ソースウィンドウとは異なったレイアウトです。列にシンボル名を表示するこ

とがあります。アセンブラ情報はメモリ内容を逆アセンブルします。オブジェクトファイルからデ
バッグ情報を読まずにメモリ内容を直接編集、表示します。

図5-5　Disassemblyウィンドウ
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各列に対してダブルクリック動作をサポートしています。
• BP
そのアドレスに対し、標準ブレークポイントを設定または解除します。

• Address
Set Addressダイアログボックスを表示します。新しいアドレスを入力できます。そのアドレ
スが、ソースファイル中にあれば、新しいウィンドウをオープンし、カーソルが該当個所
をさします。もしくは、ソースプログラムの該当個所を表示します。アドレスに対応する
ソースファイルがないときには、本ウィンドウがそのアドレスまでスクロールします。ア
ドレスとして多重定義関数名やクラス名を入力するとSelect Functionダイアログボックスが
開くので、関数を選択してください。

• Code and Assembler
Assemblerダイアログボックスを表示します。任意のアドレスの命令を変更できます。機械
語を変更しても、ソースファイルには反映されません。また、そのセッション終了時に変
更した情報が失われるので注意してください。

• Label
Labelダイアログボックスを表示します。新しいラベルの入力やラベルの削除、編集ができ
ます。

• Source
スタートメニューのHDIショートカットで設定されているエディタが該当個所を表示しま
す。

BP列で右クリックすると現在サポートしている標準ブレークポイントタイプを表示します。現在、
選択されているブレークポイントタイプがメニューの左側にチェックされています。
ウィンドウ内の BP列以外のところで右クリックすると使用可能なオプションをポップアップメ

ニューで表示します。

5.5.1 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられるようにします。

5.5.2 Set Address...
Set Addressダイアログボックスを表示します。新しい開始アドレスを入力すると、ウィンドウが

更新され、ユーザが入力したアドレスが左上端のアドレスとなります。アドレスとして多重定義関
数あるいはメンバ関数を含むクラス名を入力した場合、Select Functionダイアログボックスが開くの
で、設定する関数を選択します。

5.5.3 Go To Cursor
現在の PCアドレスからプログラムを実行します。プログラムは、PCがテキストカーソル(マ

ウスカーソルではありません)の位置によって指定されたアドレスに達するか、別のブレーク条件が
成立するまで実行します。
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5.5.4 Set PC Here
PCの値をテキストカーソル(マウスカーソルではありません)の位置によって指定されたアドレス

に変更します。

5.5.5 Instant Watch...
変数名を現在のテキストカーソル(マウスカーソルではありません)の位置から抜き出して名前と

ともに Instant Watchダイアログボックスを表示します。選択しているソース行が有効なときのみ機
能します。

5.5.6 Add Watch
テキストカーソル (マウスカーソルではありません)の位置の表示から抽出した名前を、ウォッチ

変数のリストに追加します。Watchウィンドウが開いていない場合はこれを開いて、他のウィンド
ウの一番上に表示します。選択しているソース行が有効なときのみ機能します。

5.5.7 Go to Source
テキストカーソル (マウスカーソルではありません)の位置に対応する Sourceウィンドウをオープ

ンします。ソース行が有効なときのみ機能します。

5.6 Labels

図5-6　Labels ウィンドウ

カラムヘッダをクリックすることで、シンボルをアルファベット順またはアドレス順にソートし
て表示します。
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各列に対してダブルクリック動作をサポートしています。
• BP
そのアドレスに対し、標準ブレークポイントを設定または解除します。

• Address
関数の先頭アドレスでソースファイルをオープンします。

• Name
Edit Labelダイアログボックスをオープンします。

右クリックすると BP列に現在サポートしている標準ブレークポイントタイプを表示します。現
在、選択されているブレークポイントタイプがメニューの左側にチェックされています。
ウィンドウ内の BP列以外のところで右クリックすると使用可能なオプションをポップアップメ

ニューで表示します。

5.6.1 Add...
Add Labelダイアログボックスを表示します。

図5-7　Add Labelダイアログボックス

新しいラベル名を Nameフィールドに入力し、対応する値を Valueフィールドに入力して[OK]を
押します。Add Labelダイアログボックスがクローズし、ラベルリストに新しいラベルが追加され更
新されます。多重定義関数やクラス名を入力したときは、Select Functionダイアログボックスが開く
ので、関数を選択して Valueフィールドを設定します。詳細は「14 関数の設定」を参照してくださ
い。

5.6.2 Edit...
Edit Labelダイアログボックスを表示します。

図5-8　Edit Labelダイアログボックス
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ラベル名と対応する値を編集して、[OK]を押すとラベルリストに編集が反映され保存されます。
多重定義関数やクラス名を入力したときは、Select Functionダイアログボックスが開くので、関数を
選択して Valueフィールドを設定します。詳細は「14 関数の設定」を参照してください。

5.6.3 Find...
Find Label Containingダイアログボックスを表示します。

図5-9　Find Label Containing ダイアログボックス

検索したいラベル名の一部、全部をエディットボックスに入力し、[OK]ボタンまたは、ENTERキ
ーを押すと、ダイアログボックスはクローズし、指定された文字列を含んでいるテキストファイル
をサーチします。

【注】 ラベルは、はじめの 1024文字分しか情報を保持していません。したがって、ラベル名のは
じめの 1024文字分は重複しないようにしてください。ラベルは、大文字、小文字を区別し
ます。

5.6.4 Find Next
ラベルが検索できた後、検索条件に一致する次のラベルを検索します。

5.6.5 View Source
ラベルのアドレスに該当する Sourceまたは、Disassemblyウィンドウをオープンします。

5.6.6 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられるようにします。
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5.6.7 Delete
シンボルリストから選択されたラベルを削除します。Deleteキーでも同様の動作です。確認メッ

セージを表示します。

図5-10　ラベル削除確認メッセージボックス

Yesボタンをクリックするとラベルリストから削除されウィンドウが更新されます。メッセージ
ボックスの表示不要のときは、HDI Optionsダイアログボックスの Confirmationシートの Delete Label
オプションを選択しないでください。

5.6.8 Delete All
リストからすべてのラベルを削除します。確認メッセージボックスを表示します。

図5-11　Confirming All Label Deletionメッセージボックス

Yesボタンをクリックすると、すべてのラベルが HDI のシンボルテーブルから削除され、リスト
表示もクリアされます。メッセージボックスの表示が不要のときは、HDI Optionsダイアログボック
スの Confirmationシートの Delete All Labelsオプションを選択しないでください。
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5.6.9 Load...
現在の HDI のシンボルテーブルに結合します。Load Symbolsダイアログボックスをオープンしま

す。

図5-12　Load Symbols ダイアログボックス

ダイアログボックスは、Windows®標準の open fileダイアログボックスと同様です。ファイルを選
択し、Openをクリックするとロードを開始します。シンボルファイルの標準拡張子は”.sym”です。
シンボルのロードが完了するとロードしたシンボル数を表示したメッセージボックスを表示します。
このメッセージボックスは、HDI Optionsダイアログボックスの Confirmationシートで非表示にもで
きます。

5.6.10 Save
現在のシンボルテーブルをシンボルファイルに保存します。

5.6.11 Save As...
Save SymbolsダイアログボックスはWindows®標準の Save File Asダイアログボックスと同様に操

作できます。File nameフィールドにファイル名を入力し Openをクリックするとシンボルファイル
にラベルリストを保存します。標準ファイル拡張子は”.sym”です。
シンボルファイルフォーマットが「付録 C」にあるので参照してください。
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5.7 Locals

図5-13　Localsウィンドウ

すべてのローカル変数を表示・変更できるウィンドウです。このウィンドウは、アブソリュート
ファイル (*.abs)に含まれるデバッグ情報によって、現在の PC位置から関数内にあるローカル変数
に関連づけることができない場合は空白となります。
表示する項目は以下の通りです。
[Name] 変数名を表示します

[Value] 変数の値、割付け位置、および型を表示します

割付け位置は{}で囲んで表示し、型は()で囲んで表示します

変数はリスト表示され、’+’記号は変数名をダブルクリックすれば情報を拡張表示できることを、’-’
記号は情報を収縮表示できることを示します。また、’+’／’-’キーでも拡張／収縮表示することがで
きます。情報の表示については、「12.3.2 ウォッチ項目の拡張」を参照してください。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ
ニューには次のオプションが含まれています。

5.7.1 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられるようにします。

5.7.2 Edit Value...
選択しているローカル変数の値を変更するダイアログボックスを表示して、変数の値を変更でき

ます。

5.7.3 Radix
選択しているローカル変数の表示基数を変更します。
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5.8 Memory

図5-14　Memoryウィンドウ

デバッグプラットフォームのメモリ内容を表示・変更できるウィンドウです。メモリは ASCII、
バイト、ワード、ロングワード、単精度浮動小数点、倍精度浮動小数点の各フォーマットで表示で
きます。タイトルバーは現在の表示スタイルと、直前のラベル(シンボル)からのオフセットで示した
アドレスを示します。
メモリ内容は、現在のカーソル位置で入力するか、データ項目をダブルクリックして変更するこ

とができます。データ項目をダブルクリックすると Editダイアログボックスを表示するので、複雑
な式を使用して新しい値を入力できます。そのアドレスのデータが変更できない(すなわち ROMま
たは未使用領域上にある)場合は、"Invalid address value"というメッセージを表示します。

Address列でダブルクリックすると Set Addressダイアログボックスが表示されて、新しい開始ア
ドレスを入力できるようになります。[OK]をクリックするとウィンドウが更新されて、入力したア
ドレスが、１行目になるように表示します。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ
ニューには以下のオプションが含まれています。

5.8.1 Refresh
Memoryウィンドウの内容を強制的にアップデートします。

5.8.2 Load...
Load Memoryダイアログボックスを表示します。現在のデバッグ情報を削除せずにデバッグプラ

ットフォームのメモリに S-recordファイル(*.mot)をロードします。offsetフィールドは、アドレス値
を変更するときに指定します。オプショナルベリファイフラグはダウンロードが正常に行われたか
どうかをチェックします。

5.8.3 Save...
Save Memory Asダイアログボックスを表示します。デバッグプラットフォームのブロックを S-

recordファイル(*.mot)でセーブします。開始フィールドと終了フィールドは、Searchオプション(｢5.8.8
Search...｣も参照)と同様に設定します。

5.8.4 Test...
Test Memoryダイアログボックスを表示します。デバッグプラットフォーム内のメモリブロック

を検査します。テストの詳細は、デバッグプラットフォームに依存します。開始フィールドと終了
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フィールドは、Searchオプション(｢5.8.8 Search...｣も参照)と同様に設定します。本シミュレータ・
デバッガではサポートしていません。

5.8.5 Fill...
Fill Memoryダイアログボックスを表示します。デバッグプラットフォームのメモリブロックに指

定した値を書き込みます。開始フィールドと終了フィールドは、Searchオプション(｢5.8.8 Search...｣
も参照)と同様に設定します。

5.8.6 Copy...
Copy Memoryダイアログボックスを表示します。デバッグプラットフォームのメモリブロックを

同一メモリ空間内の別の場所にコピーします。ブロックはオーバラップしても構いません。開始フ
ィールドと終了フィールドは、Searchオプション(｢5.8.8 Search...｣も参照)と同様に設定します。

5.8.7 Compare...
Compare Memoryダイアログボックスを表示します。メモリ領域の開始アドレスと終了アドレスを

選択して別のメモリ領域と比較します。Memoryウィンドウでメモリブロックが反転表示されていれ
ば、ダイアログボックスを表示したときに開始アドレスと終了アドレスを自動的に設定します。
メモリベリファイに似ていますが、本機能は、2つのメモリブロックを比較します。

5.8.8 Search...
Search Memoryダイアログボックスを表示します。デバッグプラットフォームのメモリブロック

の中で指定したデータ値を検索します。メモリブロックが反転表示されている場合は、ダイアログ
ボックスの開始フィールドと終了フィールドに、反転表示されているブロックに対応する開始アド
レスと終了アドレスを自動的に設定します。

5.8.9 Set Address...
Set Addressダイアログボックスを表示します。新しい開始アドレスを入力すると、ウィンドウが

更新され、ユーザが入力したアドレスが左上端のアドレスとなります。アドレスとして多重定義関
数あるいはメンバ関数を含むクラス名を入力した場合、Select Functionダイアログボックスが開くの
で、設定する関数を選択します。

5.8.10 ASCII/Byte/Word/Long/Single Float/Double Float
これらの 6つの項目の左に付いているチェックマークは、現在の表示フォーマットを示していま

す。異なる項目を選択して、そのフォーマットに変更することができます。



5. ウィンドウ

52

5.9 Performance Analysis

図5-15　Performance Analysisウィンドウ

本ウィンドウは、指定関数ごとの実行サイクル数を表示します。
実行サイクル数は、指定関数コール命令実行時の累計実行サイクル数と指定関数からのリターン

命令実行時の累計実行サイクル数の差から求めています。

表示する項目は以下の通りです。
[Index] 設定条件のインデックス番号
[Function] 測定対象の関数名（または関数の開始アドレス）
[Cycle] 当該関数の累計実行サイクル数
[Count] 当該関数の累計呼び出し回数
[%] プログラム全体の実行サイクル数に占める当該関数の実行サイクル数の割合
[Histogram] 上記割合のヒストグラム表示

また、評価関数をダブルクリックすると、Performance Optionダイアログボックスが開き、関数を
変更することができます。なお、関数は 255個まで設定可能です。
表示領域内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメニ

ューには以下のオプションが含まれています。

5.9.1 Add Range...
評価関数を追加します。クリックすると、Performance Optionダイアログボックスが開き、関数を

追加することができます。

5.9.2 Edit Range
反転表示カーソルバーがユーザ定義範囲にある場合にのみ有効です。Performance Optionダイアロ

グボックスを表示して、範囲の設定を変更します。

5.9.3 Delete Range
反転表示カーソルバーがユーザ定義範囲にある場合にのみ有効です。範囲設定を削除し、他の範

囲のデータを再計算します。
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5.9.4 Reset Counts/Times
現在のプログラムの実行効率データをクリアします。

5.9.5 Delete All Ranges
現在のユーザ定義範囲をすべて削除し、実行効率測定データをクリアします。

5.9.6 Enable Analysis
実行効率データ収集のオン・オフを切り替えます。実行効率測定が現在アクティブであれば、テ

キストの左にチェックマークを表示します。

5.10 Performance Optionダイアログボックス

図5-16　Performance Optionダイアログボックス

本ダイアログボックスでは、性能評価する関数（ラベルも可）を設定します。評価結果は Performance
Analysisウィンドウで表示します。
多重定義関数あるいはメンバ関数を含むクラス名を入力した場合、Select Functionダイアログボッ

クスが開くので設定する関数を選択します。詳細は、「14 関数の設定」を参照してください。

[OK]ボタンをクリックすることにより、評価関数を設定します。[Cancel]ボタンをクリックすると、
設定しないでダイアログボックスを閉じます。
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5.11 Registers

図5-17　Registersウィンドウ

現在のレジスタ値を表示・変更できるウィンドウです。ウィンドウ内でマウスの右ボタンをクリ
ックするとポップアップメニューを表示します。このメニューには以下のオプションが含まれてい
ます。

5.11.1 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられるようにします。

5.11.2 Edit...
Registerダイアログボックスを表示します。テキストカーソル (マウスカーソルではありません)

の位置によって示されたレジスタの値を設定します。

5.11.3 Toggle Bit
テキストカーソルが、たとえばステータスレジスタ内のフラグなどのビットフィールド上にある

場合にのみ使用できます。ビットの現在のステータスを、もう一方のステータスに変更します。た
とえば、設定したオーバーフローフラグをクリアすることができます。
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5.12 Source
Sourceウィンドウは、C/C++、アセンブラプログラムで、デバッグオプションが指定されていれ

ば表示できます。

図5-18　Sourceウィンドウ

各列に対してダブルクリック動作をサポートしています。
• BP
クリックしたアドレス(PC)のブレークポイントの設定/解除

• Address
Set Address ダイアログボックスを表示します。アドレスの入力ができます。本ファイルの
範囲内のアドレスのときに、カーソルは指定された位置までスクロールします。入力され
たアドレスが別ファイルのときには、ウィンドウを新規にオープンしカーソルは、該当ア
ドレスを表示します。入力されたアドレスに対応するファイルがないときには、新規に
Disassemblyウィンドウをオープンします。多重定義関数名やクラス名が入力されたとき、
Select Functionダイアログボックスが開くので、関数を選択します。

• Label
Labelダイアログボックスを表示します。新しいラベルを入力するかラベル名の編集ができ
ます。

• Line
Set Lineダイアログボックスを表示します。ソースファイルの指定した行を直接表示するこ
とができます。

• Source
スタートメニューのHDIショートカットで設定されているエディタが該当個所を表示しま
す。
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右クリックすると BP列に現在サポートしている標準ブレークポイントタイプを表示します。現
在、選択されているブレークポイントタイプがメニューの左側にチェックされています。
ウィンドウ内の BP列以外のところで右クリックすると使用可能なオプションがポップアップメ

ニューを表示します。

5.12.1 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられます。

5.12.2 Find...
Findダイアログボックスを表示して、ソースファイル内で文字列を検索します。

5.12.3 Set Address...
Set Addressダイアログボックスを表示します。新しい開始アドレスを入力すると、ウィンドウが

更新され、ユーザが入力したアドレスが左上端のアドレスとなります。アドレスとして多重定義関
数あるいはメンバ関数を含むクラス名を入力した場合、Select Functionダイアログボックスが開くの
で、設定する関数を選択します。

5.12.4 Set Line...
Set Lineダイアログボックスを表示します。テキストカーソル (マウスカーソルではありません)

を指定された行に移動します。

5.12.5 Go To Cursor
現在の PCアドレスからユーザプログラムの実行を開始します。プログラムは、PCがテキスト

カーソル(マウスカーソルではありません)の位置によって指定されたアドレスに達するか、別のブレ
ーク条件が成立するまで実行します。デバッグプラットフォームによってサポートされていない場
合、このメニューオプションはグレー表示となります。

5.12.6 Set PC Here
PCの値をテキストカーソル(マウスカーソルではありません)の位置によって指定されたアドレス

に変更します。

5.12.7 Instant Watch...
変数名を現在のテキストカーソル(マウスカーソルではありません)の位置から抜き出して名前と

ともに Instant Watchダイアログボックスを表示します。ソース行が有効なときのみ機能します。

5.12.8 Add Watch
テキストカーソル (マウスカーソルではありません)の位置の表示から抽出した名前を、ウォッチ

変数のリストに追加します。Watchウィンドウが開いていない場合はこれを開いて、他のウィンド
ウの一番上に表示します。ソース行が有効なときのみ機能します。
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5.12.9 Go to Disassembly
現在のソース行に対応したアドレスの Disassembly表示を行います。

5.13 System Status

図5-19　System Statusウィンドウ

デバッグプラットフォームの現在のステータスを表示できるウィンドウです。
System Statusウィンドウは、4枚のシートに分割されています。

• Sessionシート
接続しているデバッグプラットフォームおよびロードしたファイルの名前など、現在のセ
ッションに関する情報を含んでいます。

• Platformシート
CPU種別および動作モードなど、デバッグプラットフォームのステータス情報、実行状態お
よび実行統計情報を含んでいます。

• Memoryシート
メモリマッピングおよび現在ロードしたオブジェクト・ファイルによって使用されるメモ
リエリアなど、現在のメモリステータスに関する情報を含んでいます。

• Eventsシート
リソース情報およびブレークポイント等のイベント情報に関する情報を含んでいます。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ
ニューには以下のオプションが含まれています。
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5.13.1 Update
表示データを最新情報に更新します。

5.13.2 Copy
反転表示されたテキストをWindows®クリップボードにコピーし、他のアプリケーションに貼

り付けられます。テキストブロックが反転表示されている場合にのみ使用できます。

5.14 Trace

図5-20　Traceウィンドウ

本ウィンドウは、トレース情報を表示します。なお、トレース情報の取得条件は、Trace Acquisition
ダイアログボックスで設定します。表示する項目は以下の通りです。

[PTR] トレースバッファ内ポインタ（最後に実行した命令が０となります）
[CYCLE] 累計命令実行サイクル数

（命令実行リセットによりクリアされます）
[ADDR] 命令アドレス
[CCR] コンディションコードレジスタ（CCR）の内容をニーモニックで表示します。
[MULT] 乗算器内部のフラグをニーモニックで表示します。（H8S/2600シリーズのみ）
[INSTRUCTION] 命令ニーモニックとデータアクセス

（転送先←転送データの形式で表示）

[Source] C/C++またはアセンブラソース

また、Traceウィンドウである行をダブルクリックすると、Sourceウィンドウあるいは Disassembly
ウィンドウを開いてソース表示し、選択された行をカーソルで示します。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ
ニューには以下のオプションが含まれています。
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5.14.1 Find...
Trace Searchダイアログボックスを表示します。現在のトレースバッファ内の特定のトレースレコ

ードを検索できます。

5.14.2 Find Next
トレースレコードが検索できた後、次の同様のトレースレコードをさらに検索できます。

5.14.3 Filter...
Filter Traceダイアログボックスを表示します。必要でないトレースエントリを、マスクできます。

本シミュレータ・デバッガではサポートしていません。

5.14.4 Acquisition...
Trace Acquisitionダイアログボックスを表示します。トレースするユーザプログラム領域を指定し

ます。これは問題のある領域にトレースを集中させるために使用することができます。

5.14.5 Halt
ユーザプログラムの実行を中止せずにトレースデータの収集を中止し、トレース情報を更新しま

す。本シミュレータ・デバッガではサポートしていません。

5.14.6 Restart
トレースデータの収集を開始します。本シミュレータ・デバッガではサポートしていません。

5.14.7 Snapshot
ユーザプログラムの実行を中止せずに、トレース情報を更新してデバッグプラットフォームの現

在のステータスを表示します。本シミュレータ・デバッガではサポートしていません。

5.14.8 Clear
トレースバッファを空にします。複数の Traceウインドウが開いているときは、それらは同じバ

ッファをアクセスしているため、すべてのトレースバッファをクリアします。

5.14.9 Save...
Save Asファイルダイアログボックスを表示します。トレースバッファの内容をテキストファイル

として保存します。Cycleの範囲によって指定するか、すべてのバッファを指定することができます
(すべてのバッファをセーブするには、数分かかることがあります)。このファイルはトレースバッフ
ァに再ロードできないことに注意してください。

5.14.10 View Source
該当アドレスに対応したソースプログラムや逆アセンブルを表示します。
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5.14.11 Trim Source
ソースプログラムの左側の空白を取り除きます。

5.15 Trace Acquisitionダイアログボックス

図5-21　Trace Acquisitionダイアログボックス

本ダイアログボックスでは、トレース情報の取得条件を設定します。
[Trace start/Stop]

[Disable] トレース情報の取得停止
[Enable] トレース情報の取得開始

[Instruction type]
[Instruction] 全命令のトレース情報を取得
[Subroutine] サブルーチン命令のみトレース情報を取得

[Trace buffer full handling]
[Continue] トレース情報取得バッファが満杯になっても取得を続行
[Break] トレース情報取得バッファが満杯になった場合、実行停止

指定した内容は、[OK]ボタンをクリックすることにより設定します。[Cancel]ボタンをクリックす
ると、設定しないでダイアログボックスを閉じます。
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5.16 Trace Searchダイアログボックス

図5-22　Trace Searchダイアログボックス

本ダイアログボックスは、トレース情報のサーチ条件を設定します。[Item]でサーチ対象項目を指
定し、[Value]で指定された内容をサーチします。

[PTR] トレースバッファ内ポインタ。最後に実行した命令が０となります。
-nnnの形式で指定してください。

[Cycle] 累計命令実行サイクル数
[Address] 命令アドレス
[Instruction] 命令ニーモニック

[OK]ボタンをクリックすることにより、サーチ条件を設定します。[Cancel]ボタンをクリックする
と、設定しないでダイアログボックスを閉じます。

5.17 Watch

図5-23　Watchウィンドウ



5. ウィンドウ

62

C/C++ソースレベルの変数を表示・変更することができるウィンドウです。本ウィンドウの内容
は、アブソリュートファイル(*.abs)内のデバッグ情報から、C/C++ソースファイルとのリンクが取れ
れば表示します。リンクが取れない場合には、表示しません。
表示する項目は以下の通りです。
[Name] 変数名を表示します
[Value] 変数の値、割付け位置、および型を表示します

割付け位置は{}で囲んで表示し、型は()で囲んで表示します

変数はリスト表示され、’+’記号は変数名をダブルクリックすれば情報を拡張表示できることを、’-’
記号は情報を収縮表示できることを示します。また、’+’／’-’キーでも拡張／収縮表示することがで
きます。
ウィンドウ内でマウスの右ボタンをクリックすると、ポップアップメニューを表示します。この

メニューには以下のオプションが含まれます。

5.17.1 Copy
テキストブロックが反転表示されている場合にのみ使用できます。反転表示されたテキストを

Windows®クリップボードにコピーし、他のアプリケーションに貼り付けられるようにします。

5.17.2 Delete
テキストカーソル (マウスカーソルではありません)の位置によって示された変数を、Watchウィ

ンドウから削除します。

5.17.3 Delete All
すべての変数を、Watchウィンドウから削除します。

5.17.4 Add Watch...
Add Watchダイアログボックスを表示します。監視する変数または式を入力します。

5.17.5 Edit Value...
Edit Valueダイアログボックスを表示して、変数の値を変更します。ポインタの値を変更する場合

は、そのポインタが有効なデータを指し示さなくなる可能性があるため、特に注意が必要です。

5.17.6 Radix
選択しているウォッチ項目の表示基数を変更します。



5. ウィンドウ

63

5.18 System Configurationダイアログボックス

図5-24　System Configurationダイアログボックス

本ダイアログボックスでは、アドレス空間ビット数、プログラム領域ビット数、SYSCRアドレス、
システムコールの開始位置、実行モード、浮動小数点の丸めモード、およびメモリマップの設定を
行います。

[CPU] 現在設定されている CPU。
（CPUは、Select Sessionダイアログボックスにより設定します。）

[Address Space Bit Size]アドレス空間のビット数を指定します。各 CPUで指定できる値は以下の
通りです。

H8/300、H8/300L、H8/300HN、H8S/2600N、H8S/2000N： 16
H8/300HA： 17～24
H8S/2600A、H8S/2000A： 17～32

[Program Area Bit Size] プログラム領域のビット数を指定します。各 CPUで指定できる値は以下
の通りです。

H8/300、H8/300L、H8/300HN、H8S/2600N、H8S/2000N： 16
H8/300HA： アドレス

空間ビッ
ト数と同
一

H8S/2600A、H8S/2000A： 17～24
[System Call Address] デバッグ対象プログラムから標準入出力またはファイル入出力を行うた

めのシステムコールの開始位置を指定します。
[Enable] チェックするとシステムコールが有効となりま

す。
[Execution Mode] シミュレーションエラーが発生した場合のシミュレータ・デバッガ動作

を規定します。
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[Stop] シミュレーションを停止します。
[Continue] シミュレーションを続行します。

[Round Mode] 浮動小数点数 10進→2進変換で発生する丸めのモードを指定します。
[Round to nearest] 最近値丸め
[Round to zero] ゼロ方向丸め

[Memory Map]には、メモリ情報として、先頭アドレス・終了アドレス、メモリ種別、デー
タバス幅、アクセスサイクル数の順に表示し、[Memory Map]は、以下の各ボタンにより設
定・変更・削除ができます。

[Add] [Memory Map]の項目を設定します。クリックすると、Memory Map Modifyダイアログ
ボックスが開き、設定することができます。

[Modify] [Memory Map]の項目を変更します。変更したい項目をリストボックス上で選択後、ボ
タンをクリックします。クリックすると、Memory Map Modifyダイアログボックスが
開き、変更することができます。

[Delete] [Memory Map]の項目を削除します。削除したい項目をリストボックス上で選択後、ボ
タンをクリックします。

変更内容は、[OK]ボタンをクリックすることにより設定します。[Cancel]ボタンをクリックすると、
設定しないでダイアログボックスを閉じます。

5.19 Memory Map Modifyダイアログボックス

図5-25　Memory Map Modifyダイアログボックス

本ダイアログボックスでは、シミュレータ・デバッガの対象 CPUのメモリマップを設定します。
各項目に表示する内容は、対象 CPUによって異なります。これらの値は、メモリアクセスサイク

ル数の算出に使用します。

[Memory type] メモリ種別
[Start address] メモリ種別に対応するメモリの先頭アドレス
[End address] メモリ種別に対応するメモリの終了アドレス
[State count] メモリのアクセスサイクル数
[Data bus size] メモリのデータバス幅

変更内容は、[OK]ボタンをクリックすることにより設定されます。[Cancel]ボタンをクリックする
と、設定しないでダイアログボックスを閉じます。
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【注】 メモリリソースを確保している領域のメモリマップは、削除・変更することができません。
あらかじめ、Memory Mapダイアログボックスによりメモリリソースを削除してから、メ
モリマップを削除・変更してください。

5.20 Memory Mapダイアログボックス

図5-26　Memory Mapダイアログボックス

本ダイアログボックスは、対象 CPUに関する情報とメモリマップを表示します。

表示する項目は以下の通りです。

[System Configuration] シミュレータ・デバッガの対象 CPU、アドレスバス幅、実行モードを
表示します。

[System memory resource] 現在設定されているメモリリソースのアクセス種別とその先頭アドレ
ス・終了アドレスを表示します。

[Memory map] メモリ情報として、メモリ種別とその先頭アドレス・終了アドレス、
データバス幅、アクセスサイクル数を表示します。

[System memory resource]は次の各ボタンにより設定・変更・削除することができます。

[Add] [System memory resource]の項目を設定します。クリックすることにより、System
Memory Resource Modifyダイアログボックスが開き、設定することができます。

[Modify] [System memory resource]の項目を変更します。変更したい項目をリストボックス上で
選択後、ボタンをクリックします。クリックすることにより、System Memory Resource
Modify ダイアログボックスが開き、変更することができます。

[Delete] [System memory resource]の項目を削除します。削除したい項目をリストボックス上で
選択後、ボタンをクリックします。

なお、[Memory map]・[System memory resource]は、[Reset]ボタンによりデフォルト値にリセット
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することができます。また、本ダイアログボックスは、[Close]ボタンをクリックすることにより閉
じます。

5.21 System Memory Resource Modifyダイアログボックス

図5-27　System Memory Resource Modifyダイアログボックス

本ダイアログボックスでは、メモリリソースの設定・変更を行います。
設定する項目は以下の通りです。
[Start address] 確保するメモリ領域の先頭アドレス
[End address] 確保するメモリ領域の終了アドレス
[Access type] アクセス種別

Read 読み出しのみ可能
Write 書き込みのみ可能
Read/Write 読み書き可能

各項目を指定後、[OK]ボタンをクリックすることによりメモリリソースの設定・変更を行います。
[Cancel]ボタンをクリックすると、設定しないでダイアログボックスを閉じます。

5.22 Control Registers

図5-28　Control Registersウィンドウ

本ウィンドウは、制御レジスタの値を表示します。なお、本ウィンドウは H8S/2600シリーズの
みサポートします。

表示する制御レジスタは以下の通りです。

[SYSCR] システムコントロールレジスタ

制御レジスタ値は、ウィンドウ上で直接変更できます。また、レジスタをダブルクリックすると、
レジスタ値をビット単位で設定できる SYSCRダイアログボックスが開きます。
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5.23 SYSCRダイアログボックス

図5-29　SYSCRダイアログボックス

本ダイアログボックスでは、SYSCRレジスタ（システムコントロールレジスタ）の値を設定しま
す。なお、本ダイアログボックスは H8S/2600シリーズのみサポートします。

設定する項目は以下の通りです。

[MACS bit] 積和演算（MAC 命令）の飽和演算/非飽和演算を設定します。チェックすると
飽和演算になります。

[EXR bit] EXRレジスタの有効/無効を設定します。チェックすると有効になります。

[OK]ボタンをクリックすることにより、変更した値をメモリ上に設定します。[Cancel]ボタンをク
リックすると、変更内容をメモリ上に設定しないでダイアログボックスを閉じます。

5.24 Simulated I / O

図5-30　Simulated I/Oウィンドウ

本ウィンドウは、デバッグ対象プログラムから標準入出力およびファイル入出力のシステムコー
ルを行うためのウィンドウです。
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本ウィンドウ上で右クリックすると、以下のポップアップメニューを表示します。

[Copy] 反転表示されたテキストをWindows®クリップボードにコピーし、他のアプリ
ケーションに貼り付けられるようにします。

[Paste] Windows®クリップボードの内容を貼り付けます。
[Clear window] 本ウィンドウの内容をクリアします。

入出力を行うための手順は、「3.12　標準入出力およびファイル入出力処理」を参照してくださ
い。

5.25 Stack Trace

図5-31　Stack Traceウィンドウ

本ウィンドウは、関数呼び出し履歴を表示します。
表示する項目は以下の通りです。

[Kind] 該当シンボルのシンボル種別を示します。
F：関数
P：関数パラメータ
L：ローカル変数

[Name] シンボル名を示します。
[Value] シンボルの値、アドレス、型を示します。

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメニ
ューには以下のオプションが含まれています。

5.25.1 Copy
反転表示されたテキストをWindows®クリップボードにコピーし、他のアプリケーションに貼り付

けられるようにします。

5.25.2 Go to Source
選択した関数に該当するソースプログラムを Sourceウィンドウ上に表示します。
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5.25.3 View Setting...
Stack Trace Setting...ダイアログボックスが開き、Stack Traceウィンドウの表示形式を設定します。

図5-32　Stack Trace Settingダイアログボックス

Nest levelは、Stack Traceウィンドウに表示する関数コールネスト数を指定します。
Display symbolグループのチェックボックスは、関数以外に表示するシンボルを指定します。
Display Radixグループのラジオボタンは、Stack Traceウィンドウの表示基数を指定します。
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5.26 Profile-List

図5-33　Profile-Listウィンドウ

本ウィンドウは、関数とグローバル変数のアドレス、サイズ、関数呼出し回数、およびプロファ
イルデータを表示します。表示するプロファイルデータは以下の通りです。

• Called（グローバル変数アクセス回数）、Cycle（実行サイクル数）

実行サイクル数は、当該関数コール命令実行時の累計実行サイクル数と当該関数からのリターン
命令実行時の累計実行サイクル数の差から求めています。

カラムヘッダをクリックすると、アルファベット順または昇降順にソートして表示します。
Function/Variable列または Address列をダブルクリックすると、該当するアドレスに対応したソー

スプログラムまたは逆アセンブルを表示します。
ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメニ
ューには以下のオプションが含まれています。

5.26.1 View Source
選択している行の該当アドレスに対応したソースプログラムまたは逆アセンブルを表示します。

選択している行がグロバール変数の場合、このメニューオプションはグレー表示となります。

5.26.2 View Profile-Tree
Profile-Treeウィンドウを表示します。

5.26.3 View Profile-Chart
選択している行の関数に着目した Profile-Chartウィンドウを表示します。

5.26.4 Enable Profiler
プロファイルデータ収集のオン・オフを切り替えます。プロファイルデータ測定がアクティブで

あれば、メニューテキストの左にチェックマークを表示します。なお、プロファイルデータと実行
効率データは同時に計測することはできません。プロファイルデータ収集をオンにするときに、実
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行効率データ収集がオンされている場合（Performance Analysisウィンドウの Enable Analysisにチェ
ックされている場合）、警告メッセージボックスを表示します。

図5-34　Profilerおよび Analysisの同時設定不可警告メッセージボックス

[OK]ボタンを選択すると、実行効率データ収集がオフに、プロファイルデータ収集がオンに切り
替わります。

5.26.5 Find...
Function/Variable列の文字列を検索する Find Textダイアログボックスを表示します。検索したい

文字列をエディットボックスに入力し、[Find Next]ボタンまたは、ENTERキーを入力すると、検索
を開始します。

5.26.6 Clear Data
関数呼び出し回数のカウントおよびプロファイルデータをクリアします。Profile-Treeウィンドウ

および Profile-Chartウィンドウのデータもクリアします。

5.26.7 Output Profile Information File...
Save Profile Information Fileダイアログボックスを表示します。プロファイル結果をプロファイル

情報ファイル（拡張子は".pro"）に保存します。最適化リンケージエディタは、プロファイル情報を
元に、ユーザプログラムの最適化を行うことが出来ます。プロファイル情報を使用した最適化につ
いての詳細は、最適化リンケージエディタのマニュアルを参照してください。

5.26.8 Output Text File...
Save Text of Profile Dataダイアログボックスを表示します。表示している状態をテキストファイル

に保存します。

5.26.9 Select Data...
プロファイルデータの種類を選択することができます。プロファイルデータの種類は、デバッグ

プラットフォームにより異なります。デバックプラットフォームがサポートしていない場合、この
メニューオプションはグレー表示となります。

5.26.10 Setting...
表示状態の設定を行う Setting Profile-Listダイアログボックスを表示します。
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図5-35　Setting Profile-Listダイアログボックス

Columnグループのチェックボックスは、カラムの表示／非表示を設定します。
Functions/Variablesグループのラジオボタンは、Function/Variable列で表示している関数およびグ

ローバル変数を両方表示するかどちらか一方のみ表示するかを設定します。
Show Only Executed Function(s)チェックボックスは、未実行関数の表示を抑制することができます。

最適化リンケージエディタが出力するスタック使用量情報ファイル（拡張子は".sni"）が無い場合、
このチェックボックスの設定に関わらず、未実行関数は表示しません。

Include Data of Child Function(s)チェックボックスは、表示するプロファイルデータに、関数内で呼
び出されている子関数のプロファイルデータを含めるかどうかを設定します。
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5.27 Profile-Tree

図5-36　Profile-Treeウィンドウ

本ウィンドウは、関数の呼出し関係をツリー構造で表示します。また、各関数のアドレス、サイ
ズ、スタックサイズ、関数呼出し回数、およびプロファイルデータを表示します。スタックサイズ、
関数呼出し回数、およびプロファイルデータは、実際の関数が呼出された経路における値を表示し
ます。
表示するプロファイルデータは以下の通りです。

• Cycle（実行サイクル数）

実行サイクル数は、当該関数コール命令実行時の累計実行サイクル数と当該関数からのリターン
命令実行時の累計実行サイクル数の差から求めています。

【注】 スタックサイズは実際の値とは異なります。関数の呼び出し経路における目安としてくだ
さい。また、最適化リンケージエディタが出力するスタック使用量情報ファイル（拡張子
は".sni"）が無い場合には、スタックサイズを表示しません。スタック使用量情報ファイル
については、最適化リンケージエディタのマニュアルを参照してください。

Function列の関数をダブルクリックすると、ツリー構造を拡張または収縮表示します。また、'+'
／'-'キーでも拡張／収縮表示することができます。Address列をダブルクリックすると、該当するア
ドレスに対応したソースプログラムまたは逆アセンブルを表示します。
ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ

ニューには以下のオプションが含まれています。

5.27.1 View Source
選択している行の該当アドレスに対応したソースプログラムまたは逆アセンブルを表示します。

5.27.2 View Profile-List
Profile-Listウィンドウを表示します。

5.27.3 View Profile-Chart
選択している行の関数に着目した Profile-Chartウィンドウを表示します。
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5.27.4 Enable Profiler
プロファイルデータ収集のオン・オフを切り替えます。プロファイルデータ測定がアクティブで

あれば、メニューテキストの左にチェックマークを表示します。なお、プロファイルデータと実行
効率データは同時に計測することはできません。プロファイルデータ収集をオンにするときに、実
行効率データ収集がオンされている場合（Performance Analysisウィンドウの Enable Analysisにチェ
ックされている場合）、警告メッセージボックスを表示します。

図5-37　Profilerおよび Analysisの同時設定不可警告メッセージボックス

[OK]ボタンを選択すると、実行効率データ収集がオフに、プロファイルデータ収集がオンに切り
替わります。

5.27.5 Find...
Function列の文字列を検索する Find Textダイアログボックスを表示します。検索したい文字列を

エディットボックスに入力し、[Find Next]ボタンまたは、ENTERキーを入力すると、検索を開始し
ます。

5.27.6 Find Data...
Find Dataダイアログボックスを表示します。なお、カーソルが Function列にある場合、このメニ

ューオプションはグレー表示となります。

図5-38　Find Dataダイアログボックス

Find Dataグループより検索方向を設定し、[Find Next]ボタンまたは、ENTERキーを入力すると、
検索を開始します。また、連続して[Find Next]ボタンまたは ENTERキーを入力すると、次に大きい
データ（Minimumの場合は小さいデータ）を検索します。

5.27.7 Clear Data
関数呼び出し回数のカウントおよびプロファイルデータをクリアします。Profile-Listウィンドウ
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および Profile-Chartウィンドウのデータもクリアします。

5.27.8 Output Profile Information File...
Save Profile Information Fileダイアログボックスを表示します。プロファイル結果をプロファイル

情報ファイル（拡張子は".pro"）に保存します。最適化リンケージエディタは、プロファイル情報を
元に、ユーザプログラムの最適化を行うことが出来ます。プロファイル情報を使用した最適化につ
いての詳細は、最適化リンケージエディタのマニュアルを参照してください。

5.27.9 Output Text File...
Save Text of Profile Dataダイアログボックスを表示します。表示している状態をテキストファイル

に保存します。

5.27.10 Select Data...
プロファイルデータの種類を選択することができます。プロファイルデータの種類は、デバッグ

プラットフォームにより異なります。デバックプラットフォームがサポートしていない場合、この
メニューオプションはグレー表示となります。

5.27.11 Setting...
表示状態の設定を行う Setting Profile-Treeダイアログボックスを表示します。

図5-39　Setting Profile-Treeダイアログボックス

Columnグループのチェックボックスは、カラムの表示／非表示を設定します。
Show Only Executed Function(s)チェックボックスは、未実行関数の表示を抑制することができます。

最適化リンケージエディタが出力するスタック使用量情報ファイル（拡張子は".sni"）が無い場合、
このチェックボックスの設定に関わらず、未実行関数は表示しません。

Include Data of Child Function(s)チェックボックスは、表示するプロファイルデータに、関数内で呼
び出されている子関数のプロファイルデータを含めるかどうかを設定します。
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5.28 Profile-Chart

図5-40　Profile-Chartウィンドウ

ある関数に着目した呼び出し関係を表示します。Profile-Chartウィンドウは、Profile-Listウィンド
ウまたは Profile-Treeウィンドウから開きます。Profile-Listウィンドウまたは Profile-Treeウィンドウ
で選択した関数に着目した呼び出し関係を表示します。着目した関数を中心に、左側に呼び出し元
関数、右側に呼び出し先関数を表示します。呼び出し元関数および呼び出し先関数横の数値は、呼
び出し回数を示します。

Profile-Chartウィンドウには以下のツールバーボタンが含まれています。
• Expands Size
• Reduces Size

ウィンドウ内でマウスの右ボタンをクリックするとポップアップメニューを表示します。このメ
ニューには「5.28.3 View Source」以降のオプションが含まれています。

5.28.1 Expands Size
各関数の間隔を広げて表示します。また、'+'キーでも広げて表示することができます。

5.28.2 Reduces Size
各関数の間隔を縮めて表示します。また、'-'キーでも縮めて表示することができます。

5.28.3 View Source
マウスの右ボタンをクリックしたときの位置にある関数の該当アドレスに対応したソースプログ

ラムまたは逆アセンブルを表示します。マウスの右ボタンをクリックしたときの位置が関数ではな
い場合、このメニューオプションはグレー表示となります。

5.28.4 View Profile-List
Profile-Listウィンドウを表示します。

5.28.5 View Profile-Tree
Profile-Treeウィンドウを表示します。
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5.28.6 View Profile-Chart
マウスの右ボタンをクリックしたときの位置にある関数に着目した Profile-Chartウィンドウを表

示します。マウスの右ボタンをクリックしたときの位置が関数ではない場合、このメニューオプシ
ョンはグレー表示となります。

5.28.7 Enable Profiler
プロファイルデータ収集のオン・オフを切り替えます。プロファイルデータ測定がアクティブで

あれば、メニューテキストの左にチェックマークを表示します。なお、プロファイルデータと実行
効率データは同時に計測することはできません。プロファイルデータ収集をオンにするときに、実
行効率データ収集がオンされている場合（Performance Analysisウィンドウの Enable Analysisにチェ
ックされている場合）、警告メッセージボックスを表示します。

図5-41　Profilerおよび Analysisの同時設定不可警告メッセージボックス

[OK]ボタンを選択すると、実行効率データ収集がオフに、プロファイルデータ収集がオンに切り
替わります。

5.28.8 Clear Data
関数呼び出し回数のカウントおよびプロファイルデータをクリアします。Profile-Listウィンドウ

および Profile-Treeウィンドウのデータもクリアします。

5.28.9 Multiple View
Profile-Chartウィンドウを表示する際、既に Profile-Chartウィンドウが開いているとき、別のウィ

ンドウを開くか同ウィンドウに表示するかを設定します。メニューテキストの左にチェックマーク
が表示されていれば、別のウィンドウを開きます。
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5.28.10 Output Profile Information File...
Save Profile Information Fileダイアログボックスを表示します。プロファイル結果をプロファイル

情報ファイル（拡張子は".pro"）に保存します。最適化リンケージエディタは、プロファイル情報を
元に、ユーザプログラムの最適化を行うことが出来ます。プロファイル情報を使用した最適化につ
いての詳細は、「最適化リンケージエディタのマニュアル」を参照してください。
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6. コマンドライン

コマンド一覧を表 6-1に示します。

表 6-1　コマンド一覧
コマンド名 短縮形 説　明

! - コメント

ANALYSIS AN 性能分析機能の有効化／無効化

ANALYSIS_RANGE AR 性能評価関数の設定、表示

ANALYSIS_RANGE_DELETE AD 性能分析範囲の削除

ASSEMBLE AS アセンブルの実行

ASSERT - コンディションのチェック

BREAKPOINT BP 実行命令位置によるブレークポイントの設定

BREAK_ACCESS BA メモリ範囲のアクセスによるブレーク条件の設定

BREAK_CLEAR BC ブレークポイントの削除

BREAK_DATA BD メモリのデータ値によるブレーク条件の設定

BREAK_DISPLAY BI ブレークポイント一覧の表示

BREAK_ENABLE BE ブレークポイントの有効/無効の切換え

BREAK_REGISTER BR レジスタのデータ値によるブレーク条件の設定

BREAK_SEQUENCE BS 実行順序を指定したブレークポイントの設定

DISASSEMBLE DA 逆アセンブル表示

ERASE ER Command Lineウィンドウの内容のクリア

EVALUATE EV 式の計算

FILE_LOAD FL オブジェクト(プログラム)ファイルのロード

FILE_SAVE FS メモリ内容のファイルセーブ

FILE_VERIFY FV ファイル内容とメモリ内容の比較

GO GO ユーザプログラムの実行

GO_RESET GR リセットベクタからのユーザプログラムの実行

GO_TILL GT テンポラリブレークポイントまでのユーザプログラムの実行

HALT HA ユーザプログラムの停止

HELP HE コマンドラインまたはコマンドに対するヘルプ表示

INITIALISE IN HDIの初期化

LOG LO ロギングファイルの操作

MAP_DISPLAY MA メモリマッピング情報の表示

MAP_SET MS メモリリソースの設定

MEMORY_DISPLAY MD メモリ内容の表示

MEMORY_EDIT ME メモリ内容の変更

MEMORY_FILL MF 指定データによるメモリ内容の一括変更

MEMORY_MOVE MV メモリブロックの移動

MEMORY_TEST MT メモリブロックのテスト

QUIT QU HDIの終了
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コマンド名 短縮形 説　明

RADIX RA 入力ラディックス(基数)の設定

REGISTER_DISPLAY RD CPUレジスタ値の表示

REGISTER_SET RS CPUレジスタ値の設定

RESET RE CPUのリセット

SLEEP - コマンド実行の遅延

STEP ST ステップ実行(命令単位またはソース行単位)

STEP_OUT SP PC位置の関数を終了するまでのステップ実行

STEP_OVER SO ステップオーバー実行

STEP_RATE SR ステップ実行速度の設定、表示

SUBMIT SU コマンドファイルの実行

SYMBOL_ADD SA シンボルの設定

SYMBOL_CLEAR SC シンボルの削除

SYMBOL_LOAD SL シンボル情報ファイルのロード

SYMBOL_SAVE SS シンボル情報のファイルセーブ

SYMBOL_VIEW SV シンボルの表示

TRACE TR トレース情報の表示

TRACE_ACQUISITION TA トレース情報取得の有効/無効の切換え

以下に各コマンドのシンタックスを示します。

! (コメント)

省略形: なし

説明:
ログファイル等への記録に便利な、コメントを出力することができます。

シンタックス
!  <text>
パラメータ 型 説明

<text> テキスト 出力するテキスト

例:
! Start of test routine Command Lineウィンドウ（ログが有効の場合はログファイル）にコメ

ント "Start of test routine" を出力します

ANALYSIS

省略形: AN

説明:
性能分析を有効、または無効にします。分析数は、実行前に自動的にリセットしません。
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シンタックス
an  [ <state> ]
パラメータ 型 説明

なし 分析状況を表示します

<state> キーワード 分析を設定します

enable 分析を可能にします

disable 分析を無効にします

reset 分析数をリセットします

例:
ANALYSIS 分析状況を表示します
AN enable 分析を可能にします
AN disable 分析を無効にします
AN reset 分析数をリセットします

ANALYSIS_RANGE

省略形: AR

説明:
性能評価を行う関数を設定するか、またはパラメータなしで性能評価を行う関数を表示し
ます。

シンタックス
ar  [  <関数名 t>  ]
パラメータ 型 説明

なし すべての性能評価を行う関数を表示します

<関数名> 文字列 性能評価を行う関数名

例:
ANALYSIS_RANGE  sort 関数 sortの性能評価を行います
AR 性能評価を行う関数を表示します

ANALYSIS_RANGE_DELETE

省略形: AD

説明:
指定された項目番号の関数、またはパラメータが何も指定されていなかったらすべての関
数を削除します(確認を求められません)。

シンタックス
ad  [ <index> ]
パラメータ 型 説明

なし すべての関数を削除します

<index> 数値 削除する関数の番号
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例:
ANALYSIS_RANGE_DELETE 6 項目番号 6の関数を削除します
AD すべての関数を削除します

ASSEMBLE

省略形: AS

説明:
アセンブルし、メモリに書き込みます。
アセンブルモードでは "." は終了、"^" は1バイト戻り、ENTERキーを押すと先に進みます。
シンタックス

as  <address>
パラメータ 型 説明

<address> 数値 アセンブルを開始するアドレス

例:
AS H’1000 H'1000からアセンブルします

ASSERT

省略形: なし

説明:
式が真であることを調べます。 式が偽のときはバッチファイルを終了するため、バッチフ
ァイルで使えます。 式が偽のときエラーを返します。 このコマンドは、サブルーチンの
テストハーネスを記述するために使うことができます。

シンタックス
assert  <expression>
パラメータ 型 説明

<expression> 式 判定する式

例:
ASSERT #R0 == 0x100 R0 が 0x100を含んでいないときエラーを返します

BREAKPOINT

省略形: BP

説明:
実行命令位置によるブレークポイントを設定します。
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シンタックス
bp  <address>  [<count>]
パラメータ 型 説明

<address> 数値 ブレークポイントのアドレス

<count> 数値 指定アドレスの命令をフェッチする回数（任意、デフォルト
=1）

例:
BREAKPOINT 0 2 0番地の命令を２回目に実行しようとしたとき、ブレークするように設

定します。
BP C0 C0番地の命令を実行しようとしたとき、ブレークするように設定しま

す。

BREAK_ACCESS

省略形: BA

説明:
メモリ範囲のアクセスによるブレーク条件の設定します。

シンタックス
ba  <start address>  [<end address>]  [<mode>]
パラメータ 型 説明

<start address> 数値 ブレークポイントの開始アドレス

<end address> 数値 ブレークポイントの終了アドレス（任意、デフォルト=開始アドレス）

<mode> キーワード アクセス種別（任意、デフォルト=RW）

R リードした場合にブレーク

W ライトした場合にブレーク

RW リードまたはライトした場合にブレーク

例:
BREAK_ACCESS 0 1000 W 0番地から 1000番地の範囲でライトアクセスが発生したときブレー

クするように設定します。
BA FFFF FFFF番地でリードまたはライトアクセスが発生したときブレークす

るように設定します。

BREAK_CLEAR

省略形: BC

説明:
ブレークポイントを削除します。

シンタックス
bc  <index>
パラメータ 型 説明

<index> 数値 削除するブレークポイントのインデックス（省略した場合は
全てのブレークポイントを削除します。）
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例:
BREAK_CLEAR 0 １番目のブレークポイントを削除します。
BC 全てのブレークポイントを削除します。

BREAK_DATA

省略形: BD

説明:
メモリのデータ値によるブレーク条件を設定します。

シンタックス
bd  <address>  <data>  [<size>]  [<option>]
パラメータ 型 説明

<address> 数値 実行停止の判定を行うアドレス

<data> 数値 アクセスデータ

<size> キーワード アクセスサイズ（任意、デフォルト=L）

B バイトデータ

W ワードデータ

L ロングワードデータ

S 単精度浮動小数点データ

D 倍精度浮動小数点データ

<option> キーワード データの一致/不一致（任意、デフォルト=EQ）

EQ データが一致したときブレーク

NE データが不一致となったときブレーク

例:
BREAK_DATA 0 100 L EQ 0番地のメモリにロングワードサイズで 100を書き込んだとき

ブレークするように設定します。
BD C0 FF B NE C0番地のメモリがバイトサイズの FF以外の値に書き換えられ

たときブレークするように設定します。
BD 4000 1000 4000番地のメモリにロングワードサイズで 1000を書き込んだ

ときブレークするように設定します。

BREAK_DISPLAY

省略形: BI

説明:
ブレークポイント一覧を表示します。

シンタックス
bi
パラメータ 型 説明

なし ブレークポイント一覧を表示します
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例:
BREAK_DISPLAY ブレークポイントの一覧を表示します。
BI ブレークポイントの一覧を表示します。

BREAK_ENABLE

省略形: BE

説明:
ブレークポイントの有効/無効を切換えます。

シンタックス
be  <flag>  [<index>]
パラメータ 型 説明

<flag> キーワード 有効/無効

E 有効

D 無効

<index> 数値 有効／無効を切りかえるブレークポイントのインデックス（省
略した場合は全てのブレークポイントを対象とします。）

例:
BREAK_ENABLE D 0 １番目のブレークポイントを無効にします。
BE E 全てのブレークポイントを有効にします。

BREAK_REGISTER

省略形: BR

説明:
レジスタのデータ値によるブレーク条件を設定します。

シンタックス
br  <register>  [<data>  <size>]  [<option>]
パラメータ 型 説明

<register> 文字列 レジスタ名

<data> 数値 アクセスデータ

<size> キーワード アクセスサイズ（任意、省略した場合は指定レジスタのサイ
ズとします。ただし、データ値設定時は省略不可となります。）

B バイトデータ

W ワードデータ

L ロングワードデータ

S 単精度浮動小数点データ

D 倍精度浮動小数点データ

<option> キーワード データの一致/不一致（任意、デフォルト=EQ）

EQ データが一致したときブレーク

NE データが不一致となったときブレーク
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例:
BREAK_REGISTER R0 FFFF W EQ R0レジスタの下位２バイトが FFFFになったときブレー

クします。
BR R10 R10レジスタにライトアクセスが発生したときブレーク

します。

BREAK_SEQUENCE

省略形: BS

説明:
実行順序を指定したブレークポイントを設定します。

シンタックス
bs  <address1>  [<address2>  [<address3>  […]]]
パラメータ 型 説明

<address1> ～
<address8>

数値 シーケンシャルブレークポイントとなるアドレス（最大８個
まで指定できます。）

例:
BREAK_SEQUENCE 1000 2000 通過位置が 1000番地、2000番地のときブレークします。
BS 1000 1000番地を実行するときブレークするように設定します。

DISASSEMBLE

省略形: DA

説明:
メモリ内容を逆アセンブル表示します。 逆アセンブル表示は完全なシンボリックです。

シンタックス
da  <address>  [<length>]
パラメータ 型 説明

<address> 数値 開始アドレス

<length> 数値 命令数（任意、デフォルト=16）

例:
DISASSEMBLE H’100 5 アドレス H'100からコード 5行を逆アセンブル表示します
DA H’3E00 20 アドレス H'3E00からコード 20行を逆アセンブル表示します

ERASE

省略形: ER

説明:
Command Lineウィンドウをクリアします。
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シンタックス
er
パラメータ 型 説明

なし Command Lineウィンドウをクリアします

例:
ER Command Lineウィンドウをクリアします

EVALUATE

省略形: EV

説明:
簡単な式、そして括弧、混合基数とシンボルを持つ複雑な式を評価することができます。 す
べての演算子は同じ優先順位を持っていますが、括弧は評価の順序を変更することができ
ます。 演算子はC/C++と同じ意味を持っています。 式もまた数値が要求されるコマンドで
使うことができます。 レジスタ名を使うことができますが、先頭に"#"文字を付けなければ
いけません。結果は、16進、10進、8進、2進で表示します。

シンタックス
ev  <expression>
パラメータ 型 説明

<expression> 式 評価する式

有効な演算子:
&& 論理 AND || 論理 OR << 左算術シフト >> 右算術シフト

+  加算 -  減算 *  乗算 /  除算

%  剰余 |  ビット毎の OR &  ビット毎のAND ~  ビット毎の NOT

^  ビット毎の排他的 OR !  論理 NOT == 等しい != 等しくない

>  より大きい <  より小さい >= 以上 <= 以下

例:
EV H’123 + (D’73 | B’10) 結果:  H'16E  D'366  O'556

B'00000000000000000000000101101110
EV #R2H * #R2L 結果:  H'121  D'289  O'441

B'00000000000000000000000100100001
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FILE_LOAD
省略形: FL

説明:
指定されたオフセットで、メモリに対して指定されたファイルをロードします。 現在のシ
ンボルはクリアしますが、新しいシンボルが同一名で現在のシンボルを重複定義します。 オ
フセットが指定されるとシンボルに加えられます。ファイルの拡張子はデフォルトとして
".MOT"を設定します。

シンタックス
fl  <filename>  [ <offset> ] [ <state> ]
パラメータ 型 説明

<filename> 文字列 ファイル名

<offset> 数値 ロードアドレスに加えるオフセットを設定します

（任意、デフォルト=0）

<state> キーワード ベリファイフラグ（任意、デフォルト=V)

V ベリファイあり

N ベリファイなし

例:
FILE_LOAD A:¥¥BINARY¥¥TESTFILE.A22 S レコードファイル "testfile.a22" をロードします
FL ANOTHER.MOT H’200 モトローラ Sレコードファイル "another.mot" をオ

フセット H'200バイトからロードします
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FILE_SAVE

省略形: FS

説明:
メモリ内容をファイルへ保存します。 データはモトローラ S レコードフォーマットで保
存します。すでに存在するファイル名を指定した場合は、上書きするかどうかユーザに確
認します。ファイルの拡張子のデフォルトは、".MOT"です。シンボルは自動的にセーブし
ません。

シンタックス
fs  <filename>  <start>  <end>
パラメータ 型 説明

<filename> 文字列 ファイル名

<start> 数値 開始アドレス

<end> 数値 終了アドレス

例:
FILE_SAVE TESTFILE H’0 H’2013 アドレス範囲 H'0 - H'2013をモトローラ Sレコ

ードファイル "TESTFILE.MOT" として保存し
ます

FS D:¥¥USER¥¥ANOTHER.A22 H’4000 H’4FFF アドレス範囲 H'4000 - H'4FFFを Sレコードフ
ォーマットファイル "ANOTHER.A22" として
保存します

FILE_VERIFY

省略形: FV

説明:
メモリとファイル内容をベリファイします。 ファイルデータはモトローラ S レコードフ
ォーマットです。ファイルの拡張子はデフォルトとして".MOT"を設定します。

シンタックス
fv  <filename>  [ <offset> ]
パラメータ 型 説明

<filename> 文字列 ファイル名

<offset> 数値 ファイルアドレスへ加えるオフセットを設定します

（任意、デフォルト=0）

例:
FILE_VERIFY A:¥¥BINARY¥¥TEST.A22 メモリに対して S レコードファイル "TEST.A22" を

ベリファイします
FV ANOTHER 200 メモリに対して S レコードファイル

"ANOTHER.MOT" にオフセット H'200バイトを加え
たアドレスからベリファイします
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GO
省略形: GO

説明:
ユーザプログラムを実行します。ユーザプログラムを実行しているとき、Performance Analysis
ウィンドウは更新されます。ユーザプログラムが停止すると、PC値を表示します。

シンタックス
go  [ <state> ]  [ <address> ]
パラメータ 型 説明

<state> キーワード プログラム実行中でのコマンド処理の有効／無効

（任意、デフォルト= wait ）

wait コマンド処理を続けることができません

continue コマンド処理を続けることができます

<address> 数値 PC のための開始アドレス（任意、デフォルト=PC値）

wait はデフォルトで、プログラムが実行を停止するまでコマンド処理ができません。
continue は、コマンド処理を続けることができます（デバッグプラットフォームの機能により動

作しないものもあります）。

例:
GO 現在の PCからユーザプログラムを実行します

(コマンド処理を続けることができません)
GO CONTINUE H’1000 H'1000からユーザプログラムを実行します

(コマンド処理を続けることができます)

GO_RESET

省略形: GR

説明:
リセットベクタで指定されているアドレスから始まるユーザプログラムを実行します。ユ
ーザプログラムを実行しているとき、Performance Analysisウィンドウは更新されます。

シンタックス
gr  [ <state> ]
パラメータ 型 説明

<state> キーワード プログラム実行中でのコマンド処理の有効／無効

（任意、デフォルト= wait ）

wait コマンド処理を続けることができません

continue コマンド処理を続けることができます

wait はデフォルトで、プログラムが実行を停止するまでコマンド処理ができません。
continue は、コマンド処理を続けることができます（デバッグプラットフォームの機能により動

作しないものもあります）。
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例:
GR リセットベクタで指定されているアドレスから始まる、ユーザプログラムを実

行します (コマンド処理を続けることができません)

GO_TILL

省略形: GT

説明:
テンポラリブレークポイントを設定し、現在の PC からプログラムを実行します。 テンポ
ラリブレークポイントとして、複数のアドレスを指定することができます（テンポラリブ
レークポイントは、コマンド実行中のみ有効です）。

シンタックス
gt  [ <state> ]  <address>...
パラメータ 型 説明

<state> キーワード プログラム実行中でのコマンド処理の有効／無効

wait コマンド処理を続けることができません

continue コマンド処理を続けることができます

<address>... 数値 テンポラリブレークポイントのアドレス（複数指定可）

wait はデフォルトで、プログラムが実行を停止するまでコマンド処理ができません。
continue は、コマンド処理を続けることができます（デバッグプラットフォームの機能により動

作しないものもあります）。

例:
GO_TILL H’1000 PC がアドレス H'1000に到達するまでユーザプログラムを実行します

HALT

省略形: HA

説明:
ユーザプログラムを停止します（"go continue"コマンドの後で、使うことができます）。

シンタックス
ha
パラメータ 型 説明

なし ユーザプログラムを停止します

例:
HA ユーザプログラムを停止します
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HELP

省略形: HE

説明:
ヘルプファイルを開きます。

コンテキスト詳細ヘルプは、F1キーで表示できます。HELPまたは HEに続いてコマンド名を入
力することにより検索できます。

シンタックス
he  [ <command> ]
パラメータ 型 説明

なし ヘルプの目次を表示します

<command> 文字列 コマンドを指定します

例:
HE ヘルプの目次を表示します
HE GO GO コマンドのヘルプを表示します

INITIALISE

省略形: IN

説明:
HDI（デバッグプラットフォーム、ターゲットを含む）を初期化（ターゲットライブラリを
再選択する）します。すべてのブレークポイント、メモリマッピングなどもリセットしま
す。

シンタックス
in
パラメータ 型 説明

なし HDIを初期化します

例:
IN HDI を初期化します
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LOG
省略形: LO

説明:
ファイルへのコマンド出力のログを制御します。 パラメータなしでは、現在のログ状況を
表示します。 存在するファイルを指定すると、追加するかをユーザに確認します。No と
答えるとデータはファイルに上書きされ、Yes と答えるとファイルに追加されます。 ロギ
ングはコマンドラインインタフェースでのみサポートします。

シンタックス
lo  [  <state>  |  <filename>  ]
パラメータ 型 説明

なし ロギング状態を表示します

<state> キーワード ロギングを再開／停止します

+ ロギングを再開します

- ロギングを停止します

<filename> 文字列 ロギングを出力するファイル名を指定します

例:
LOG TEST ファイル TESTへの出力をロギングします
LO - ロギングを停止します
LOG + ロギングを再開します
LOG 現在のロギング状態を表示します
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MAP_DISPLAY

省略形: MA

説明:
現在のメモリマップ構成を表示します。

シンタックス
ma
パラメータ 型 説明

なし 現在のメモリマップ構成を表示します

例:
MA 現在のメモリマップ構成を表示します

MAP_SET

省略形: MS

説明:
メモリリソースを設定します。

シンタックス
ms  <start address>  [ <end address> ]  [ <mode> ]
パラメータ 型 説明

<start address> 数値 開始アドレス

<end address> 数値 終了アドレス

<mode> キーワード アクセス種別（任意、デフォルト=RW）

R リードのみ可

W ライトのみ可

RW リード／ライト可

例:
MAP_SET 0000 3FFF RW 0000番地から 3FFF番地をリード/ライト可能な領域として確保し

ます。
MS 5000 5000番地をリード/ライト可能な領域として確保します。

MEMORY_DISPLAY

省略形: MD

説明:
メモリ内容を表示します。
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シンタックス
md  <address>  [ <length> ]  [ <mode> ]
パラメータ 型 説明

<address> 数値 開始アドレス

<length> 数値 長さ（任意、デフォルト=H'100バイト）

<mode> キーワード フォーマット（任意、デフォルト=byte）

byte バイトとして表示します

word ワードとして表示します（2バイト）

long ロングワードとして表示します（4バイト）

ascii ASCII として表示します

single 単精度浮動小数点として表示します

double 倍精度浮動小数点として表示します

例:
MEMORY_DISPLAY H’C000 H’100 WORD H'C000から始まるメモリを H'100バイト分ワード

フォーマットで表示します
MEMORY_DISPLAY H’1000 H’FF H'1000から始まるメモリを H'FFバイト分バイトフ

ォーマットで表示します

MEMORY_EDIT

省略形: ME

説明:
メモリ内容を変更します。 メモリを変更するとき、現在位置は ASSEMBLE コマンドで記
述したときと同じような方法で変更することができます。"." を入力すると変更モードを終
了し、"^" は1ユニット戻り、空白は変更せずに進みます。

シンタックス
me  <address>  [ <mode> ]  [ <state> ]
パラメータ 型 説明

<address> 数値 変更するアドレス

<mode> キーワード フォーマット（任意、デフォルト=byte）

byte バイトとして変更します

word ワードとして変更します

long ロングワードとして変更します

ascii ASCII として変更します

single 単精度浮動小数点として表示します

double 倍精度浮動小数点として表示します

<state> キーワード ベリファイフラグ（任意、デフォルト=V)

V ベリファイあり

N ベリファイなし

例:
ME H’1000 WORD H'1000からwordフォーマットでメモリ内容を変更します(ベリファイあり)
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MEMORY_FILL
省略形: MF

説明:
メモリ領域を指定されたデータ値に変更します。

シンタックス
mf  <start>  <end>  <data>  [ <mode> ]  [ <state> ]
パラメータ 型 説明

<start> 数値 開始アドレス

<end> 数値 終了アドレス

<data> 数値 データ値

<mode> キーワード データサイズ（任意、デフォルト=byte）

byte バイト

word ワード

long ロングワード

single 単精度浮動小数点

double 倍精度浮動小数点

<state> キーワード ベリファイフラグ（任意、デフォルト=V)

V ベリファイあり

N ベリファイなし

例:
MEMORY_FILL H’C000 H’C100 H’55AA WORD H'C000から H'C0FFまでワードデータ

H'55AAに変更します
MF H’5000 H’7FFF H’21 H'5000から H'7FFFまでデータ H'21に変更

します

MEMORY_MOVE

省略形: MV

説明:
指定されたメモリ内容を移動します。

シンタックス
mv  <start>  <end>  <dest> [ <state> ]
パラメータ 型 説明

<start> 数値 ソース開始アドレス

<end> 数値 ソース終了アドレス（この値を含む）

<dest> 数値 移動先開始アドレス

<state> キーワード ベリファイフラグ（任意、デフォルト=V)

V ベリファイあり

N ベリファイなし

例:
MEMORY_MOVE H’1000 H’1FFF H’2000 領域 H'1000 - H'1FFFを H'2000へ移動します
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MV H’FB80 H’FF7F H’3000 領域 H'FB80 - H'FF7Fを H'3000へ移動しま
す

MEMORY_TEST

省略形: MT

説明:
指定されたアドレス範囲で、リード・ライト・ベリファイのテストを行います。このとき
のデータは破壊されます。マップ設定に従ってメモリテストを行います。本シミュレータ・
デバッガではサポートしていません。

シンタックス
mt  <start>  <end>
パラメータ 型 説明

<start> 数値 開始アドレス

<end> 数値 終了アドレス（この値を含む）

例:
MEMORY_TEST H’8000 H’BFFF H'8000から H'BFFFまでテストします
MT H’4000 H’5000 H'4000から H'5000までテストします
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QUIT

省略形: QU

説明:
HDI を終了します。 ログファイルがオープンしていると閉じられます。

シンタックス
qu
パラメータ 型 説明

なし HDIを終了します

例:
QU HDI を終了します

RADIX

省略形: RA

説明:
デフォルトの基数を設定、または表示します。 パラメータなしで基数を表示します。
基数は数値データの前の B'/H'/D'/O' を使って変更できます。

シンタックス
ra  [ <mode> ]
パラメータ 型 説明

なし 現在の基数を表示します

<mode> キーワード 基数指定子

H 16進数

D 10進数

O 8進数

B 2進数

例:
RADIX 現在の基数を表示します
RA H 基数を 16進数にします

REGISTER_DISPLAY

省略形: RD

説明:
CPUレジスタ値を表示します。

シンタックス
rd
パラメータ 型 説明

なし 全レジスタの内容を表示します
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例:
RD 全レジスタの内容を表示します

REGISTER_SET

省略形: RS

説明:
CPUレジスタ値を変更します。

シンタックス
rs  <register>  <value>  <mode>
パラメータ 型 説明

<register> キーワード レジスタ名

<value> 数値 レジスタ値

<mode> キーワード データサイズ（任意、デフォルト=レジスタサイズ）

byte バイト

word ワード

long ロングワード

single 単精度浮動小数点

double 倍精度浮動小数点

例:
RS PC _SrartUp プログラムカウンタをシンボル_StartUpに設定します
RS R0 H’1234 WORD R0にワードデータ H'1234に設定します

RESET

省略形: RE

説明:
プロセッサをリセットします。 すべてのレジスタ値はデバイスの初期化状態となります。
メモリマッピングとブレークポイントには影響しません。

シンタックス
re
パラメータ 型 説明

なし プロセッサをリセットします

例:
RE プロセッサをリセットします
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SLEEP

省略形: なし

説明:
指定されたミリ秒の間コマンド実行を遅延します。

シンタックス
sleep  <milliseconds>
パラメータ 型 説明

<milliseconds> 数値 遅延時間（ミリ秒）

基数 D’ は、明示して使わないとデフォルトの基数（必ずしも 10進ではありません）が使われま
す。

例:
SLEEP D’9000 9秒間遅延します

STEP

省略形: ST

説明:
シングルステップ（ソース行、または命令）を行ないます。現在の PC から指定された命
令数分ステップします。ソースデバッグが有効な時、デフォルトのステップはソース行と
なります。ステップ数のデフォルトは1です｡

シンタックス
st  [ <mode> ]  [ <count> ]
パラメータ 型 説明

<mode> キーワード ステップの種類（任意）

instruction アセンブラの 1命令を基準にステップします

line ソースコードの 1行を基準にステップします

<count> 数値 ステップ数（任意、デフォルト=1）

例:
STEP 9 9ステップコードをステップします

STEP_OUT

省略形: SP

説明:
現在の関数の外へプログラムをステップします（即ち、ステップアップ）。 アセンブラと
ソースレベルデバッグの両方に有効です。
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シンタックス
sp
パラメータ 型 説明

なし ステップアップします

例:
SP 現在の関数の外へプログラムをステップします

STEP_OVER

省略形: SO

説明:
現在の PC から指定された命令数分ステップします。
このコマンドはサブルーチン、または割り込みルーチンの中でステップしないという点で
STEPとは異なります。フルスピードで実行します。

シンタックス
so  [ <mode> ]  [ <count> ]
パラメータ 型 説明

<mode> キーワード ステップの種類（任意）

instruction アセンブラの 1命令を基準にステップします

line ソースコードの 1行を基準にステップします

<count> 数値 ステップ数（任意、デフォルト=1）

例:
SO 1ステップコードをステップオーバーします

STEP_RATE

省略形: SR

説明:
STEPとSTEP_OVERコマンドでステップの速度をコントロールします。 6レートは最大限に
速くステップします。 値が1の場合は最も遅いステップです。

シンタックス
sr  [ <rate> ]

パラメータ 型 説明

なし ステップレートを表示します

<rate> 数値 ステップレート 1から 6で 6が最も速くなります

例:
SR 現在設定されているステップレートを表示します
SR 6 ステップレートを最速にします
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SUBMIT

省略形: SU

説明:
コマンドファイルを処理します。 処理するファイル中でもこのコマンドを使用できます。
エラーが発生するとファイルの処理を中止します。 [stop]ボタンでプロセスを中止すること
ができます。

シンタックス
su  <filename>
パラメータ 型 説明:

<filename> 文字列 ファイル名

例:
SUBMIT COMMAND.HDC COMMAND.HDC ファイルを処理します
SU A:SETUP.TXT ドライブ A: の SETUP.TXT ファイルを処理します

SYMBOL_ADD

省略形: SA

説明:
新しいシンボルを追加するか、または存在しているシンボルを変更します。

シンタックス
sa  <symbol>  <value>
パラメータ 型 説明

<symbol> 文字列 シンボル名

<value> 数値 値

例:
SYMBOL_ADD start H’1000 H'1000に start を定義します
SA END_OF_TABLE 1000 現在のデフォルト基数を使い、1000に END_OF_TABLE を定

義します

SYMBOL_CLEAR

省略形: SC

説明:
シンボルを削除します。 パラメータを指定しないとすべてのシンボルを削除します。

シンタックス
sc  [ <symbol> ]
パラメータ 型 説明

なし すべてのシンボルを削除します

<symbol> 文字列 シンボル名
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例:
SYMBOL_CLEAR すべてのシンボルを削除します
SC start シンボル start を削除します

SYMBOL_LOAD

省略形: SL

説明:
ファイルからシンボルをロードします。 ファイルは XLINK Pentica-b フォーマット（即ち
"XXXXH name"）である必要があります。 シンボルは存在するシンボルテーブルに加えら
れます。

シンタックス
sl  <filename>

パラメータ 型 説明

<filename> 文字列 ファイル名

例:
SYMBOL_LOAD TEST.SYM ファイル TEST.SYM をロードします
SL MY_CODE.SYM ファイル MY_CODE.SYM をロードします

SYMBOL_SAVE

省略形: SS

説明:
すべてのシンボルをファイルへ保存します。 ファイルは XLINK Pentica-b フォーマット
で、 シンボルファイル拡張子は".SYM" をデフォルトとします。 ファイル名は、既に存在
するときファイルを上書きするプロンプトを表示します。

シンタックス
ss  <filename>

パラメータ 型 説明

<filename> 文字列 ファイル名

例:
SYMBOL_SAVE TEST TEST.SYM にシンボルテーブルを保存します
SS MY_CODE.SYM MY_CODE.SYM にシンボルテーブルを保存します

SYMBOL_VIEW

省略形: SV

説明:
定義されたすべてのシンボル、または指定した文字列（大文字／小文字は区別する）を含
んでいるシンボルを表示します。



6.　コマンドライン

104

シンタックス
sv  [ <pattern> ]
パラメータ 型 説明

なし すべてのシンボルを表示します

<pattern> 文字列 文字列を含んでいるシンボル

例:
SYMBOL_VIEW BUFFER BUFFER を含んでいるすべてのシンボルを表示します
SV すべてのシンボルを表示します

TRACE

省略形: TR

説明:
トレースバッファの内容を表示します。バッファでの最後の（最も最近実行された）サイ
クルはサイクル0で、それ以前のサイクルは負の値を持っています。

シンタックス
tr  [ <start rec>  [ <count> ] ]
パラメータ 型 説明

<start rec> 数値 オフセット（任意、デフォルト=最も新しいサイクル-9）

<count> 数値 カウント（任意、デフォルト= 10）

例:
TR 0 5 バッファ先頭から 5行トレースバッファの内容を表示します

TRACE_ACQUISITION

省略形: TA

説明:
トレース情報取得の有効/無効を切換えます。

シンタックス
ta   <mode>
パラメータ 型 説明

<mode> キーワード トレース情報取得の有効/無効

E 有効

D 無効

例:
TRACE_ACQUISITION E トレース情報の取得を有効にします
TA D トレース情報の取得を無効にします
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7. メッセージ一覧

7.1 インフォメーションメッセージ
シミュレータ・デバッガは実行経過をユーザに知らせるため、インフォメーションメッセージを

出力します。シミュレータ・デバッガの出力するインフォメーションメッセージを表 7-1に示します。

表 7-1　インフォメーションメッセージ一覧
メッセージ 内容

Break Access ブレークアクセス条件が成立して実行を中断しました。

Break Data ブレークデータ条件が成立して実行を中断しました。

Break Register ブレークレジスタ条件が成立して実行を中断しました。

Break Sequence ブレークシーケンス条件が成立して実行を中断しました。

PC Breakpoint ブレークポイント条件が成立して実行を中断しました。

Sleep SLEEP命令により実行を中断しました。

Step Normal End ステップ実行が正常に終了しました。

Stop [STOP]ボタンにより実行を中断しました。

Trace Buffer Full Trace Acquisitionダイアログボックスの Trace buffer full handlingで Breakモ
ードが選択され、かつトレースバッファが満杯となったので実行を中断しま
した。

7.2 エラーメッセージ
シミュレータ・デバッガはデバッグ対象プログラムや操作の誤りをユーザに知らせるため、エラ

ーメッセージを出力します。シミュレータ・デバッガの出力するエラーメッセージを表 7-2に示しま
す。

表 7-2　エラーメッセージ一覧
メッセージ 内容・対策

Address Error 以下のいずれかの状態になりました。

（1）PC値が奇数である

（2）内蔵 I/O空間から命令読み出しを行おうとした

（3）ワードデータを（２n）番地以外からアクセスしようとした

（4）ロングワードデータを（４n）番地以外からアクセスしようとした

エラーが発生しないようにデバッグ対象プログラムを修正してください。

Exception Error 例外処理でエラーが発生しました。

エラーが発生しないようにデバッグ対象プログラムを修正してください。
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メッセージ 内容・対策

Illegal Instruction 以下のいずれかの状態になりました。

（1）命令ではないコードを実行しようとした

（2）MOV.B Rn,@-SPまたは、MOV.B @SP+,Rnを実行しようとした

エラーが発生しないようにデバッグ対象プログラムを修正してください。

Illegal Operation 以下のいずれかの状態になりました。

（1）DAA命令、DAS命令で CCRの Cフラグ、Hフラグと補正前の値の関
係が不正である

（2）DIVXU命令、DIVXS命令でゼロ除算または、オーバフローが発生した

エラーが発生しないようにデバッグ対象プログラムを修正してください。

Memory Access Error 以下のいずれかの状態になりました。

（1）確保されていないメモリ領域をアクセスしようとした

（2）書き込み不可属性を持つメモリへの書き込みを行おうとした

（3）読み出し不可属性を持つメモリからの読み出しを行おうとした

（4）メモリが存在しない領域をアクセスしようとした

（5）EEPMOV命令以外で EEPROMへ書き込みを行おうとした

メモリの確保、属性変更を行うか、当該メモリアクセスが発生しないように
デバッグ対象プログラムを修正してください。

System Call Error システムコールエラーが発生しました。

レジスタ R0,R1または ER1およびパラメータブロックの内容の誤りを修正
してください。
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8. プログラムの表示

本章では、プログラムリストをソースコードやアセンブラニーモニックで表示する方法について
説明します。また、HDI を使用してコード、ラベル、テキストファイルを表示する方法について述
べます。

8.1 デバッグを行うためのコンパイル
C/C++言語ソースレベルでプログラムをデバッグするためには、プログラムをデバッグオプショ

ンを指定してコンパイル、リンクする必要があります。

【注】 デバッグ用のデバッグオブジェクトファイルを作成する際には、コンパイラおよびリンケ
ージエディタの両方で、デバッグオプションを指定していることを確認してください。

デバッグオブジェクトファイルにデバッグ情報が入っていない場合でも、そのファイルを HDI へ
ロードできますが、C/C++言語ソースレベルでプログラムをデバッグすることができず、アセンブ
ラレベルのみとなります。

8.2 コードの表示

8.2.1 ソースコードの表示
プログラムのソースコードを見るには、[View->Source...]メニューオプションを選択するか、キー

ボードで Ctrl+Kを入力します。あるいは、ツールバー上に Sourceボタン[ ] が表示されていれば、
このボタンをクリックします。

ソースファイルを選択して[Open]をクリックすると、Sourceウィンドウが開きます。
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図8-1　Sourceウィンドウ

Sourceウィンドウは、ヘッダバー領域とメインウィンドウ領域の、2つの領域に分割されていま
す。また、縦に、Line、Address、BP（Break Point）、Labelおよび Sourceの 5つの列に分かれてい
ます。各列の幅を調整するには、ヘッダバーに表示された各列のタイトル間の境界線をドラッグし
ます。カーソルが に変わり、ドラッグした位置にあわせて、メインウィンドウ領域に縦線が表
示されます。変更したい列幅に合わせてマウスボタンを離すと、新しい列幅で表示が更新されます。

8.2.2 アセンブラコードの表示
Sourceウィンドウがオープンされている場合は、ポップアップメニューの[Go to Disassembly]メニ

ューオプションを選択すると、Disassemblyウィンドウをオープンします。Disassemblyウィンドウに
は、Sourceウィンドウに現在表示されているアドレスと同一のアドレスを表示します。

ソースファイルがなく、アセンブラレベルでコードを表示したいという場合は、[View-
>Disassembly...]メニューオプションを選択するか、キーボードで Ctrl+Dを入力します。あるいは、
ツールバー上に Disassemblyボタン[ ] が表示されていれば、このボタンをクリックします。Set
Addressダイアログボックスには、逆アセンブルの開始アドレスを指定してください。

Disassemblyウィンドウにはアドレス、ブレークポイント、マシンコード値、ラベル、逆アセンブ
ルされたニーモニック(使用可能であればラベル付きで)を表示します。さらに、対応するソースファ
イルを表示し、混在モード表示を提供します。
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アドレス�
フィールド�

ブレーク�
ポイント�

アセンブラコード� ソースコード�

図8-2　Disassemblyウィンドウ

8.2.3 アセンブラコードの変更
アセンブラコードを変更するには、変更したい命令をダブルクリックし、Assemblerダイアログボ

ックスを開きます。

アドレス�

マシンコード�

逆アセンブル�
された命令�

図8-3　Assemblerダイアログボックス

アドレス、マシンコード、および逆アセンブルされた命令を表示します。Mnemonicフィールドに
新しい命令を入力するか、表示されている命令を変更してください。ENTERキーを押すと、その命
令がアセンブルされてメモリに格納され、次の命令に移ります。[OK]をクリックすると、その命令
がアセンブルされてメモリに格納され、このダイアログボックスが閉じます。[Cancel]をクリックす
るか、ESCキーを押すと、このダイアログボックスが閉じます。

【注】 アセンブラ表示は、デバッグプラットフォームのメモリに格納された実際のマシンコード
から逆アセンブルします。メモリの内容が変更されると、それに対応する新しいアセンブ
ラコードを示します。ただし、この内容は、ソース表示とは一致しません。
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8.3 ラベルの表示
デバッグオブジェクトファイルに含まれるシンボル情報には、プログラム中でアドレスを表すラ

ベルが含まれています。ラベルは対応するアドレスの Labelフィールドに表示します。また、Assembler
フィールドにオペランドの一部として表示します。

【注】1. 命令のオペランドとラベルが一致する場合は、そのオペランドをラベルに置き換えます。
2つ以上のラベルが同じ値をもつ場合は、アルファベット順で最初にくるラベルを表示
します。

2. HDIでは、アドレスまたは値を入力できる場所では、どこでもラベルを代わりに使用で
きます。

8.3.1 ラベルのリスト表示
HDI で定義した全ラベルのリストを見るには、[View->Labels]メニューオプションを選択して、

Labelsウィンドウを開きます。

図8-4　Labelsウィンドウ

それぞれのカラムヘッダをクリックすることによって、アルファベット順(ASCIIコード順)または
アドレスの昇順にソートします。

BP列をダブルクリックする(または、ポップアップメニューの [Break]メニューオプションを選択
する)により、対応するアドレスにソフトウェアブレークを迅速に設定することができます。
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8.3.2 Sourceウィンドウまたは Disassemblyウィンドウでのラベルの
追加

Sourceウィンドウまたは Disassemblyウィンドウで、ラベルを割り当てたいアドレスのラベル列
をダブルクリックすることで、ラベルを迅速に追加することができます。Labelダイアログボックス
で、ラベル名を入力してください。

図8-5　Labelダイアログボックス

ラベル名を入力し[OK]をクリックすると、その行のアドレス列に表示されているアドレス値がラ
ベルに設定され、ラベルリストに追加されます。Sourceウィンドウの表示内容が更新され、追加し
たラベルが表示されます。[Clear]ボタンはラベルを削除するために使用します。

また、この方法を使用して、既存のラベルのテキストを簡単に変更することもできます。Label列
で変更するラベルをダブルクリックすると、Labelダイアログボックスのエディットボックスにその
ラベルのテキストがコピーされます。次に、そのテキストを変更すると、変更されたテキストがラ
ベルリストに保存されます。Sourceウィンドウの表示内容が更新され、新しいラベルが表示されま
す。

【注】 追加・変更したラベルを再度使用する場合は、ラベル情報をファイルに保存してください。
詳細は、「5.6.11 Save As …」を参照してください。

8.4 特定アドレスのプログラム表示
Sourceウィンドウでプログラムを参照時に、別の領域のプログラムを参照したいことがあります。

その場合には、メインウィンドウ領域をスクロールするのではなく、特定のアドレスへ直接移動す
ることができます。Address列でダブルクリックすると、Set Addressダイアログボックスが開きます。

図8-6　Set Addressダイアログボックス

該当するアドレスまたはシンボル名をエディットボックスに入力して、[OK]をクリックするか、
ENTERキーを押します。そのアドレスのコードが同じソースファイル内にある場合は、Sourceウィ
ンドウが新しいアドレスのコードに更新されます。ただし、多重定義関数あるいはクラス名を入力
した場合、Select Functionダイアログボックスが開くので、設定する関数を選択してください。詳細



8. プログラムの表示

112

については、「14 関数の設定」を参照してください。

新しいアドレスが別のソースファイル内にある場合は、新しい Sourceウィンドウが開き、そのア
ドレスのコードが表示されます。ソースファイルが参照可能であれば、デフォルトで新規ウィンド
ウにソースが表示されます。新規アドレスに対して参照可能なソースファイルがない場合は、Source
ウィンドウはアセンブラコードで表示されます。

新しいアドレスが、すでに開いている Sourceウィンドウのソースファイル内にある場合は、その
ウィンドウが前面に呼び出されて、新しいアドレスのコードが表示されます。

8.4.1 現在の PCのプログラム表示
HDI にアドレスまたは値を入力できる場所では、式を入力することも可能です(「2.2 データ入力」

を参照)。先頭に“#”文字を付けてレジスタ名を入力すると、そのレジスタの内容が値として式に使用
できます。つまり、Set Addressダイアログボックスを呼び出して、“#PC”という式を入力すると、Source
ウィンドウまたは Disassemblyウィンドウには現在の PCのアドレスが表示されます。また、PC+オ
フセット (例：“#PC+0x100”)の形で式を入力して、現在の PCアドレスからオフセット値分はなれた
箇所を表示することも可能です。

8.5 テキストの検索
検索オプションを使用して、Sourceウィンドウから特定の文字列を検索できます。これを実行す

るには、ポップアップメニューの[Find...]メニューオプションを選択するか、キーボードで F3を押
します。

Findダイアログボックスを表示します。

図8-7　Findダイアログボックス

検索したいテキストを入力して、[Find Next]をクリックするか、ENTERキーを押します。テキス
トが検出されると、Sourceウィンドウにはそのテキストが反転表示されます。そのテキストが次に
現れる箇所を検索するには、再度、[Find Next]をクリックするか、ENTERキーを押します。Findダ
イアログボックスを閉じるには、[Cancel]をクリックするか、ESCキーを押します。
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9. メモリの操作

本章では、CPUのアドレス空間で、メモリの各領域を見る方法について説明します。ここでは、
様々なフォーマットでメモリ領域を表示する方法、メモリブロックにデータを埋める方法、メモリ
ブロックの移動およびテスト方法、ディスクファイルを使用したメモリ領域の保存、ロード、およ
びベリファイ方法について述べます。

9.1 メモリ領域の表示
メモリ領域を見るには、[View->Memory...]メニューオプションを選択するか Ctrl+Mキーを押して、

Memoryウィンドウを開きます。あるいは、ツールバーに Memoryボタン[ ]が表示されていれば、
このボタンをクリックしてMemoryウィンドウを表示することもできます。これらの操作によりOpen
Memory Windowダイアログボックスが開きます。

図9-1　Open Memory Windowダイアログボックス

Addressフィールドに、ウィンドウ表示の開始アドレスまたはそれに相当するシンボルを入力して、
Formatリストから必要な表示フォーマットを選択します。[OK]をクリックするか、ENTERキーを押
すと、このダイアログボックスが閉じ、Memoryウィンドウが開きます。

図9-2　Memoryウィンドウ(バイト単位)
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Memoryウィンドウは、アドレス列を除いて２つの表示列を持っています。

• Data
表示するデータはデバッグプラットフォームから読み込みます。データは表示サイズ単位
に物理メモリから読み込みます。データの変更ができます。

• Value
データは選択されたフォーマットで表示します。値の変更はできません。

表示フォーマットを、ウィンドウのオープン時に選択したものから変更したい場合は、ポップア
ップメニューから変更できます。

9.1.1 ASCIIでのメモリ表示
メモリを ASCII文字として表示・変更するにはポップアップメニューの[ASCII]メニューオプショ

ンを選択します。[ASCII]メニューオプションを選択すると、表示内容が更新され、メモリ内容が ASCII
文字で表示されます。

9.1.2 バイト単位でのメモリ表示
メモリをバイト単位で表示・変更するにはポップアップメニューの[Byte]メニューオプションを選

択します。[Byte]メニューオプションを選択すると、表示内容が更新され、メモリ内容がバイト単位
で表示されます。（図 9-2）

9.1.3 ワード単位でのメモリ表示
メモリをワード単位で表示・変更するにはポップアップメニューの[Word]メニューオプションを

選択します。[Word]メニューオプションを選択すると、表示内容が更新され、メモリ内容が 16ビッ
トのワード単位で表示されます。

9.1.4 ロングワード単位でのメモリ表示
メモリをロングワード単位で表示するにはポップアップメニューの [Long]メニューオプションを

選択します。[Long]メニューオプションを選択すると、表示内容が更新され、メモリ内容が 32ビッ
トのロングワード単位で表示されます。

9.1.5 単精度浮動小数点数形式でのメモリ表示
メモリを単精度浮動小数点数形式で表示するにはポップアップメニューの [Single float]メニュー

オプションを選択します。[Single float]メニューオプションを選択すると、表示内容が更新され、メ
モリ内容が単精度浮動小数点数形式で表示されます。

9.1.6 倍精度浮動小数点数形式でのメモリ表示
メモリを倍精度浮動小数点数形式で表示するにはポップアップメニューの[Double float]メニュー

オプションを選択します。[Double float]メニューオプションを選択すると、表示内容が更新され、メ
モリ内容が倍精度浮動小数点数形式で表示されます。
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9.1.7 別領域のメモリ表示
Memoryウィンドウに表示されたメモリ領域を変更するには、スクロールバーを使用できます。

表示する領域を変更するには、Set Addressダイアログボックスを使用します。ポップアップメニュ
ーの[Set Address...]メニューオプションを選択するか、またはアドレス列をダブルクリックすること
で、このダイアログボックスを呼び出すことができます。

図9-3　Set Addressダイアログボックス

Set Addressダイアログボックスが開いたら、新しいアドレス値を入力します。[OK]をクリックす
るか、ENTERキーを押すと、このダイアログボックスが閉じ、Memoryウィンドウの表示内容が更
新され、新しいアドレスのデータが表示されます。ただし、アドレス値として多重定義関数あるい
はクラス名を入力した場合、Select Functionダイアログボックスが開くので、設定する関数を選択し
てください。詳細については、「14 関数の設定」を参照してください。

9.2 メモリ内容の変更
アドレスのメモリ内容を変更する方法は 2つあります。一つは簡易変更方式です。本方式は、ウ

ィンドウに値を直接入力できますが、ASCII表示時は ASCII入力のみ、それ以外での表示時は 16進
数値の入力のみに限定されます。もう一つは、詳細変更方式です。本方式は、ダイアログボックス
で値を入力します。浮動小数点数や式を値として入力できます。

9.2.1 簡易変更方式
該当する桁をクリックするか、または、クリック・ドラッグにより変更したい桁を選択し、反転

表示させます。その桁に新しい値を入力してください。ASCII表示時以外のとき、値は、0-9および
a-fの範囲内でなければなりません。ASCII表示時のときには、ASCII入力でなければなりません。
変更値がその桁に書き込まれ、カーソルがメモリの次の桁へ移動します。

9.2.2 詳細変更方式
Editダイアログボックスを使用します。変更するメモリ単位（Memoryウィンドウの表示フォーマ

ットに依存します）上にカーソルを移動して ENTERキーを押す、またはダブルクリックすると、Edit
ダイアログボックスが開きます。
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図9-4　Editダイアログボックス

データ入力フィールドには、フォーマットに従った数値またはC/C++言語の式を入力できます(「2.2
データ入力」を参照)。新しい数値または式を入力したら、[OK]ボタンをクリックするか、ENTER
キーを押します。ダイアログボックスが閉じ、新しい値がメモリに書き込まれます。

9.2.3 メモリ範囲の選択
選択する範囲が Memoryウィンドウに表示されている範囲内の場合、範囲の先頭位置でマウスの

左ボタンを押して、そのまま範囲の終了位置までドラッグします。選択された範囲は強調表示され
ます。

9.3 メモリ内の値の検索
Memoryウィンドウの検索機能を使用して、メモリ内の値を検索できます。値を検索するには、

ポップアップメニューの[Search]メニューオプションをクリックするか、または Memoryウィンドウ
が入力フォーカスを持つときに F3を押します。これらの操作により Search Memoryダイアログボッ
クスを開きます。

図9-5　Search Memoryダイアログボックス

検索したい範囲の開始アドレスと終了アドレス、および検索するデータ値を入力します。開始ア
ドレスと終了アドレスは Memoryウィンドウで範囲が選択されている場合は、自動的に設定されま
す。また、終了アドレスには、符号＋を値の前に付けて、サイズとして指定することができます。

検索フォーマットを選択して、[OK]をクリックするか、ENTERキーを押します。ダイアログボッ
クスが閉じ、HDI は該当する範囲から指定したデータを検索します。データが検出されると、その
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データが Memoryウィンドウに強調表示されます。データが検出されなかった場合は、Memoryウィ
ンドウの表示は変更されず、データが検出されなかったことを示すメッセージがメッセージボック
スに表示されます。

9.4 メモリ領域に値を埋める
メモリ埋め込み機能を使用して、指定した範囲のメモリアドレスに値を設定できます。

9.4.1 範囲を埋める
同じ値で指定した範囲のメモリを埋めるためには、[Memory->Fill...]メニューオプションまたは

Memoryウィンドウのポップアップメニューの[Fill...]メニューオプションを選択し、Fill Memoryダ
イアログボックスを開きます。

図9-6　Fill Memoryダイアログボックス

Memoryウィンドウでアドレス範囲を選択してある場合、先頭アドレスおよび終了アドレスは、
自動的に設定されます。検索フォーマットを選択して、[OK]をクリックするか、ENTERキーを押し
ます。ダイアログボックスが閉じ、新規の値がメモリ範囲に書き込まれます。
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9.5 メモリ領域の転送
メモリ転送機能を使用して、メモリ領域を転送できます。メモリ範囲を選択して(「9.2.3メモリ

範囲の選択」を参照)、ポップアップメニューの[Copy]メニューオプションを選択し、Copy Memory
ダイアログボックスを開きます。

図9-7　Copy Memoryダイアログボックス

Beginおよび Endフィールドには、Memoryウィンドウで選択した転送元のそれぞれのアドレスが
設定されています。Destinationフィールドに転送先の開始アドレスを入力して、[OK]ボタンをクリ
ックするか、ENTERキーを押すと、このダイアログボックスが閉じ、指定されたメモリブロックが
新しいアドレスへコピーされます。

9.6 メモリ領域の保存
メモリ保存機能を使用して、アドレス空間内のメモリ領域をディスクファイルに保存できます。

[Memory->Save...]メニューオプションを選択して、Save Memory Asダイアログボックスを開きます。

図9-8　Save Memory Asダイアログボックス

保存したいメモリブロックの開始アドレスと終了アドレス、およびファイル名を入力します。フ
ァイル名のドロップダウンリストは、以前にセーブしたファイル名を 4つ持っています。また、
[Browse...]ボタンを押すと、標準の Save Asダイアログボックスが開きます。[Save]ボタンをクリッ
クするか、ENTERキーを押すと、このダイアログボックスが閉じ、指定したメモリブロックが S-
Recordフォーマットファイルとしてディスクに保存されます。ファイルの保存が完了すると、確認
のメッセージボックスが開きます。HDI Optionsダイアログボックスの Confirmationタグで確認メッ
セージの出力抑止できます。
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9.7 メモリ領域のロード
メモリ領域のロード機能を使用して、現在のデバッグ情報を削除せずにメモリ領域へ S-Recordフ

ァイルをロードすることができます。[Memory->Load...]メニューオプションを選択すると Load
Memoryダイアログボックスが開きます。

図9-9　Load Memoryダイアログボックス

Offsetフィールドに値(正または負)を入力して、S-Recordで指定されたアドレスから指定した値の
分はなれた位置をロードアドレスとすることができます。[Open]ボタンをクリックするか、ENTER
キーを押すと、このダイアログボックスが閉じ、データがメモリにロードされます。データのロー
ドが完了すると、確認のメッセージボックスが開きます。HDI Optionsダイアログボックスの
Confirmationタグで確認メッセージの出力抑止できます。
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9.8 メモリ領域のベリファイ
メモリ比較機能を使用して、現在のメモリブロックと以前に保存したメモリブロックを比較する

ことができます。[Memory->Verify...]メニューオプションを選択すると Verify S-Record File with
Memoryダイアログボックスが開きます。

図9-10　Verify S-Record File with Memoryダイアログボックス

Offsetフィールドに値(正または負)を入力して、S-Recordで指定されたアドレスから指定した値の
分はなれた位置からベリファイを開始することができます。[Open]ボタンをクリックするか、ENTER
キーを押すと、このダイアログボックスが閉じ、ファイルとメモリの内容がベリファイされます。
ベリファイが完了すると、確認のメッセージボックスが開きます。HDI Optionsダイアログボックス
の Confirmationタグで確認メッセージの出力抑止できます。
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10. プログラムの実行

本章では、ユーザプログラムの実行方法について説明します。ここでは、命令を連続実行する方
法と、単一命令または複数命令をステップ実行する方法について述べます。

10.1 リセットからの実行
ユーザシステムをリセットして、リセットベクタアドレスからアプリケーションを実行するには、

ツールバーの Reset Goボタン[ ]をクリックするか、[Run-> Reset Go]メニューオプションを選択し
ます。

プログラムは、ブレークポイントに到達するかブレーク条件が成立するまで実行されます。ツー
ルバーの Haltボタン[ ]をクリックするか、[Run->Halt]メニューオプションを選択して、プログラ
ムを任意のタイミングで停止できます。

【注】 プログラムは、リセットベクタ位置に格納されたアドレスから実行を開始します。したが
って、この位置に開始コードのアドレスが格納されているかどうかを確認してください。

10.2 連続実行
プログラムが停止し、デバッガがブレークモードになると、HDI は、Sourceウィンドウまたは

Disassemblyウィンドウ内で、CPUのプログラムカウンタ(PC)が示す現在のアドレス値に対応する行
を強調表示します。これは、ステップ実行または連続実行の場合に、次に実行される命令となりま
す。

現在のPC

図10-1　PCが示すアドレス値に対応する行の強調表示



10. プログラムの実行

122

現在の PCのアドレスから連続実行するには、Goボタン[ ]をクリックするか、[Run->Go]メニュ
ーオプションを選択します。

10.3 カーソル位置まで実行
プログラムの一部分のみを実行する機能として、特定アドレスまで実行する Go To Cursor機能が

あります。

Go To Cursorの使用手順

1. プログラムを停止させたいアドレスが、SourceウィンドウまたはDisassemblyウィンドウに表
示されていることを確認してください。

2. Address列でクリックするか、カーソルキーを使用して、停止させたいアドレス上にテキス
トカーソルを合わせます。

3. ポップアップメニューの [Go To Cursor]メニューオプションを選択します。

これにより、現在の PC値から、カーソル位置で指定したアドレスに到達するまでプログラムが
実行されます。

【注】1. カーソル位置のアドレスのプログラムを実行しない場合は、プログラムは停止しません。
このようなことが起きた場合、ツールバーの Haltボタン[ ]をクリックするか、ESC
キーを押す、または、[Run->Halt]メニューオプションを選択して、プログラムを手操作
で停止できます。

2. Go To Cursor機能は、テンポラリブレークポイントを使用します。ブレークポイント設
定数が上限値の場合には、この機能は使用できません。メニューオプションが無効状態
になります。

10.4 複数ポイントまで実行
Go To Cursorのような処理を実行したいが、停止アドレスが Sourceウィンドウの外部にある、ま

たは複数のアドレスで停止させたいという場合もあります。このような場合には、HDI のテンポラ
リブレークポイント機能を使用します(「11.5 テンポラリブレークポイント」を参照)。

10.5 シングルステップ
プログラムをデバッグ時に、1行単位または 1命令単位に実行して、システムに対するその命令

の効果を検証できる機能です。Sourceウィンドウでは、ステップ処理はソースの 1行をステップ実
行します。Disassemblyウィンドウでは、ステップ処理はアセンブラの 1命令をステップ実行します。
命令が別の関数またはサブルーチンを呼び出す場合は、その関数内の各命令をステップ実行するか、
またはその関数全体を１ステップで実行するかをオプションで指定します。命令が呼び出しを実行
しない場合は、いずれのオプションを指定していても、デバッガはその命令を実行して、次の命令
で停止します。
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10.5.1 関数内の各命令をステップ実行
関数内の各命令のステップ実行を選択すると、関数の呼び出しを実行し、その関数の最初の行ま

たは命令で停止します。関数内の各命令をステップ実行するには、Step Inボタン[ ]をクリックす
るか、[Run->Step In]メニューオプションを選択します。

10.5.2 関数全体を１ステップで実行
関数全体の１ステップ実行を選択すると、デバッガは呼び出しとその関数 (および、その関数が

実行するすべての関数呼び出し)を実行し、呼び出し元関数の次の行または命令で停止します。関数
全体を１ステップで実行するには、Step Overボタン[ ]をクリックするか、[Run->Step Over]メニュ
ーオプションを選択します。

10.6 関数の実行停止
デバッグ時に、関数の実行を開始し、検証したい各命令の実行を完了した後、その関数の残りの

全コードを実行して呼び出し元関数に戻りたい場合があります。あるいは、関数全体の１ステップ
実行をするつもりが、誤って関数内の各命令のステップ実行したために、現在の関数の全コードを
実行して呼び出し元関数に戻りたい場合があります(この場合の方に、より有用です)。このような場
合には、Step Out機能を使用します。

現在の関数の残コードを実行して呼び出し元関数に戻るには、Step Outボタン[ ]をクリックす
るか、[Run->Step Out] メニューオプションを選択します。

10.7 複数のステップ
1度に複数の命令を実行してから停止させるには、Step Programダイアログボックスを使用します。

また、このダイアログボックスには、ステップ実行の間隔を選択できる自動ステップ機能も備わっ
ています。このダイアログボックスを呼び出すには、[Run-> Step...]メニューオプションを選択しま
す。

Step Programダイアログボックスを表示します。

図10-2　Step Programダイアログボックス
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Stepsフィールドにはステップ数を入力します。Step Over Callsチェックボックスにより、関数呼
び出し全体を１ステップで実行するかどうかを選択します。Source Level Stepチェックボックスによ
り、ソースプログラムの 1行と 1ステップを対応させるかどうかを選択します。自動ステップ機能
を使用する場合は、Rateフィールドのリストからステップの速度を選択します。ステップ実行を開
始するには、[OK]をクリックするか、ENTERキーを押します。
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11. プログラムの停止

本章では、プログラムの実行を停止する方法を説明します。停止コマンドを使用して直接停止さ
せる方法と、コード中の特定の位置にブレークポイントを設定し、停止させる方法について述べま
す。

11.1 実行の停止
ツールバーの Haltボタンは、プログラムの実行中は有効状態 [ ](赤色の STOPマーク)、プログ

ラム停止時は無効状態[ ](グレー表示の STOPマーク)となります。実行中に、Haltボタンをクリッ
クするか、ESCキーを押すか、メニューで [Run->Halt] を選択することにより実行が停止します。

プログラムの実行が停止され、メッセージ“Break = Stop”がステータスバーに表示されます、ま
た、開いているすべてのウィンドウが HDI によって更新されます。

最後にブレークしたときの要因は、System Statusウィンドウの Platformシートに表示されます。

11.2 PCブレークポイント
プログラムのデバッグで、PCが 1個所または複数の特定個所に達した時点で実行を停止させたい

場合には、その行または命令にプログラムブレークポイントを設定してプログラムを停止させるこ
とができます。以下に、プログラムブレークポイントを簡単に設定・削除する方法を示します。
Breakpointsウィンドウで、より複雑なブレークポイント操作を行うこともできます。これについて
は後で説明します。

プログラムブレークポイントの設定手順

1. プログラムブレークポイントを設定したい位置のSourceウィンドウが開いていることを確認
します。

2. プログラムを停止したいアドレスが表示されている行のBP列をダブルクリックするかF9キ
ーを押します。

3. プログラムブレークポイントが設定されたことを示す"Break"という語と丸が、その列に表
示されます。
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ブレーク�
ポイントを設定�

図11-1　プログラムブレークポイントの設定

これにより、プログラムがプログラムブレークポイントを設定したアドレスに到達すると、実行
が停止して、メッセージ“Break = PC Breakpoint”がステータスバーに表示されます。また、 Source
ウィンドウの表示が更新されてプログラムブレークポイント行が強調表示されます。

【注】 プログラムがプログラムブレークポイントを設定したアドレスで停止した場合、プログラ
ムブレークポイントを設定した行または命令は、実行されません。プログラムはその行ま
たは命令の実行が開始される直前に停止します。プログラムブレークポイントで停止した
後に Goまたは Stepを選択すると、次に実行される命令は強調表示された行となります。

11.3 Breakpointsウィンドウ
Breakpointsウィンドウを使用すると、複雑なブレークポイントを設定することができ(デバッグプ

ラットフォームが各ブレークポイントをサポートしている場合)、ブレークポイントの設定／削除お
よび有効／無効に関して、さらに詳細に制御できるようになります。Breakpointsウィンドウを開く
には、[View->Breakpoints]メニューオプションを選択します。あるいは、ツールバーに Breakpoints
ボタン[ ]が表示されていれば、このボタンをクリックして Breakpointsウィンドウを開くこともで
きます。

ヘッダバー�

ブレーク�
ポイント�
が無効�

ブレーク�
ポイント�
が無効�

図11-2　Breakpointsウィンドウ

このウィンドウは、システムに設定されたブレークポイントのリストを表示します。ブレークポ
イントリストは、横方向に Enable、File/Line、Symbol、Address、および Typeの 5列に分かれていま
す。各列の幅を調整するには、ヘッダバーに表示された各列のタイトル間の境界線をドラッグしま
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す。カーソルが に変わり、ドラッグした位置にあわせて、リスト領域に縦線が表示されます。
マウスボタンを離した位置の列幅で、表示が新しい列幅に更新されます。

11.3.1 ブレークポイントの追加
Breakpointsウィンドウに新しいブレークポイントを追加するには、ポップアップメニューの[Add...]

メニューオプションを選択してください。

Set Breakダイアログボックスが開き、ここで設定したいブレークポイントの種類とパラメータを
選択できます。

11.3.2 ブレークポイントの変更
Breakpointsウィンドウで既存のブレークポイントを変更するには、リスト上の該当するブレーク

ポイントに対応する行をダブルクリックしてください。または、クリックしてそのブレークポイン
トを選択後、ポップアップメニューの[Edit...]メニューオプションを選択してください｡

Set Breakダイアログボックスが開き、設定を変更したいブレークポイントの種類とパラメータを
選択できます。ただし、ブレークシーケンスを選択した場合は、Break Sequenceダイアログボックス
が開きます。

11.3.3 ブレークポイントの削除
Breakpointsウィンドウから既存のブレークポイントを削除するには、リスト上の該当するブレー

クポイントに対応する行をクリックしてブレークポイントを選択します。次に、ポップアップメニ
ューの[Delete]メニューオプションを選択してください。

選択したブレークポイントが削除され、ウィンドウが更新されます。

11.3.4 全ブレークポイントの削除
Breakpointsウィンドウにリストされたブレークポイントをすべて削除するには、ポップアップメ

ニューの[Delete All]メニューオプションを選択してください。

すべてのブレークポイントが削除され、ウィンドウが更新されます。

11.4 ブレークポイントを無効にする
ある領域のプログラムをデバッグ後、別の領域のプログラムをデバッグして、また前の領域に戻

りたいという場合に、ある領域にブレークポイントを設定してデバッグし、別の領域をデバッグす
るために設定したすべてのブレークポイントを削除し、別の領域のデバッグ後、再び削除したブレ
ークポイントを設定しなければならないのでは、効率が悪くなります。HDI では、ブレークポイン
トリストにブレークポイントを残したまま、それらを無効にすることが可能です。

11.4.1 ブレークポイントを無効にする
各ブレークポイントを無効にするには、リスト上の該当するブレークポイントに対応する行をク

リックしてそのブレークポイントを選択します。次に、ポップアップメニューの[Disable]メニューオ
プションを選択してください。
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Enable列をダブルクリックしても、ブレークポイントが無効になります。
メニューが閉じ、ブレークポイントリストが更新され、Enable列のチェックマークが消去され、

ブレークポイントが無効となります。

11.4.2 ブレークポイントを有効にする
Breakpointsウィンドウでブレークポイントを再度有効にするには、上述のように、リスト上の該

当するブレークポイントに対応する行をクリックしてそのブレークポイントを選択します。次に、
ポップアップメニューの[Enable]メニューオプションを選択してください。

Enable列をダブルクリックしても、ブレークポイントが有効になります。
メニューが閉じ、ブレークポイントリストが更新され、Enable列にチェックマークが付き、選択

したブレークポイントが有効となります。

11.5 テンポラリブレークポイント
プログラムの実行を開始して、1つまたは複数のアドレスに達した場合にプログラムを停止した

いが、それらのアドレスに恒久的なブレークポイントを設定したくないという場合があります。た
とえば、Go To Cursorと同じような処理を実行したいが、停止アドレスが Sourceウィンドウの外部
にある、または複数のアドレスで停止させたいという場合などが当てはまります。このような場合
には、HDI のテンポラリブレークポイント機能を使用して、最大 10箇所のテンポラリブレークポイ
ントを設定して実行します。それらのブレークポイントは、プログラムが停止すると削除されます。
テンポラリブレークポイントは、Run Programダイアログボックスで設定します。このダイアログボ
ックスを開くには、[Run-> Run...]メニューオプションを選択します。

Run Programダイアログボックスが開きます。

図11-3　Run Programダイアログボックス
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Stop Atフィールドに、プログラムを停止する各ポイント(最大 10まで)を表すシンボルまたはアド
レスを入力します。 ただし、多重定義関数あるいはクラス名を入力した場合、Select Functionダイ
アログボックスが開くので、設定する関数を選択してください。詳細については、「14 関数の設定」
を参照してください。

Program Counterフィールドに表示されている、現在の PCアドレスから実行を開始するには、[Go
PC]ボタンをクリックします。CPUをリセットして、リセットベクタアドレスから実行を開始する
には、[Go Reset]ボタンをクリックします。

テンポラリブレークポイントでプログラムが停止すると、テンポラリブレークポイントがブレー
クポイントリストから削除されます。Run Programダイアログボックスを再度選択すると、Stop At
フィールドにテンポラリブレークポイントがリストされ、 [Go PC]ボタンまたは[Go Reset]ボタンを
クリックすると、再度設定されます。
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12. 変数の表示

本章では、プログラムが使用する変数およびデータオブジェクトを見る方法について説明します。
ここでは、変数の表示方法、ウォッチ項目の設定方法、および CPUの汎用レジスタ、FPUレジスタ、
DSPレジスタおよび内蔵周辺レジスタを見る方法について述べます。

12.1 ツールチップウォッチ
Tooltip Watch機能を使用してプログラム内の変数を迅速に見ることができます。

Tooltip Watchの使用手順

1. Sourceウィンドウを開き、ウォッチしたい変数が表示された状態にします。
2. ウォッチしたい変数の変数名の上にマウスカーソルを移動して静止します。

図12-1　Tooltip Watch

12.2 インスタントウォッチ
Instant Watch機能を使用して変数の詳細を見ることができます。

Instant Watchの使用手順

1. Sourceウィンドウを開き、ウォッチしたい変数が表示された状態にします。
2. 該当する変数をクリックして、変数上にカーソルを移動します。
3. ポップアップメニューの[Instant Watch]メニューオプションを選択します。

Instant Watchダイアログボックスが開きます。
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図12-2　Instant Watchダイアログボックス

この変数をWatchウィンドウのウォッチ項目リストに追加するには、[Add Watch]ボタンをクリッ
クします。

12.3 ウォッチ項目の使用
プログラムを実行しながら、変数の値の変化を確認するには、Watchウィンドウを使用します。

Watchウィンドウを開くには、[View->Watch]メニューオプションを選択するか、ツールバーのWatch
ボタン[ ]をクリックします。Watchウィンドウは、最初は空白です。

12.3.1 ウォッチ項目の追加
Watchウィンドウにウォッチ項目を追加する方法は 2つあります。一方は、Sourceウィンドウか

らアクセスする簡易方式で、もう一方は、Watchウィンドウの Add Watchダイアログボックスを使
用する詳細方式です。

簡易方式

変数をWatchウィンドウに簡単に追加するには、Add Watch機能を使用します。

Sourceウィンドウでの Add Watchの使用手順

1. Sourceウィンドウを開き、ウォッチしたい変数が表示された状態にします。
2. 該当する変数をクリックして、変数上にカーソルを移動します。
3. ポップアップメニューの[Add Watch...]メニューオプションを選択します。

指定した変数がウォッチ項目として追加され、Watchウィンドウが更新されます。
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詳細方式

詳細方式では、配列、構造体やポインタなどの複雑な表現を使用することができます。

Watchウィンドウでの Add Watchの使用手順

1. Watchウィンドウを開きます。
2. ポップアップメニューの[Add Watch...]メニューオプションを選択します。

Add Watchダイアログボックスが開きます。

図12-3　Add Watchダイアログボックス

ウォッチしたい変数名を入力して、[OK]をクリックします。指定した変数がWatchウィンドウに
追加されます。

図12-4　Watchウィンドウ

12.3.2 ウォッチ項目の拡張
ウォッチ項目がポインタ、配列、または構造体の場合は、その項目名の左側にプラス記号(+)の拡

張インジケータが表示されます。これは、そのウォッチ項目を拡張できることを表しています。ウ
ォッチ項目を拡張するには、その項目をダブルクリックします。その項目が拡張され、各構成要素(構
造体または配列の場合)またはデータ値(ポインタの場合)が、タブ 1つ分インデントされて表示され
ます。プラス記号はマイナス記号(-)に変わります。ウォッチ項目の構成要素にもポインタ、構造体、
または配列が含まれている場合は、それらの構成要素の横にもまた、拡張インジケータが表示され
ます。
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拡張表示された�
ウォッチ項目�

拡張インジケータ�

収縮表示された�
ウォッチ項目�

図12-5　ウォッチ項目の拡張

拡張されたウォッチ項目を圧縮するには、その項目を再度ダブルクリックします。項目の構成要
素が圧縮され、1つの項目に戻ります。マイナス記号は再度プラス記号に変わります。

12.3.3 ウォッチ項目の表示基数の変更
ウォッチ項目の表示基数を変更するには、該当する項目をクリックして、変更する項目を選択し

ます。ポップアップメニューの[Radix]メニューオプションを選択するとサブメニューに基数のリス
トが表示されます。表示したい基数を選択しクリックすると、選択した項目の表示基数が変更され
ます。

12.3.4 ウォッチ項目の値の変更
ウォッチ対象の変数の値を変更したい場合があります。たとえば、テストを実行したい場合や、

プログラムにバグがあるため値が正しくない場合などです。ウォッチ項目の値を変更するには、Edit
Value機能を使用します。

ウォッチ項目の値の変更手順

1. 該当する項目をクリックします。クリックした項目上でカーソルが点滅します。
2. ポップアップメニューの[Edit Value]メニューオプションを選択します。

Edit Valueダイアログボックスが開きます。

図12-6　Edit Valueダイアログボックス

New Valueフィールドに新しい値または式を入力して、[OK]をクリックします。Watchウィンド
ウが更新され、新しい値が表示されます。
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12.3.5 ウォッチ項目の削除
ウォッチ項目を削除するには、該当する項目をクリックして、削除する項目を選択し、ポップア

ップメニューの[Delete]メニューオプションを選択します。選択した項目が削除され、Watchウィン
ドウが更新されます。

【注】 Watchウィンドウで設定したウォッチ項目をセッションファイルに保存できます。詳細に
ついては、「15 ユーザインタフェースの構成」を参照してください。

12.4 ローカル変数の表示
ローカル変数を見るには、[View->Locals]メニューオプションを選択して、Localsウィンドウを開

きます。

Localsウィンドウが開きます。

図12-7　Localsウィンドウ

プログラムをデバッグする際には、実行開始後のステップまたはブレークに従って、Localsウィ
ンドウが更新され、現在のローカル変数およびそれらの値が表示されます。定義時に初期設定され
ていないローカル変数の場合は、値が代入されるまで、Localsウィンドウ内の値は不定値を表示し
ます。

ローカル変数の表示基数および値の変更は、Watchウィンドウと同様に行えます。
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12.5 レジスタの表示
アセンブラ表示または混合表示の Sourceウィンドウを使用して、アセンブラレベルでデバッグす

る場合は、汎用、FPU、DSPレジスタの内容を確認できると便利です。これを行うには、Registers
ウィンドウを使用します。

図12-8　Registersウィンドウ

Registersウィンドウを開くには、[View->Registers]メニューオプションを選択するか、ツールバー
の CPU Registersボタン[ ]をクリックします。Registersウィンドウが開き、汎用、FPU、DSPレジ
スタの値(16進数表記)がすべて表示されます。

12.5.1 ビットレジスタの拡張
コントロールレジスタやステータスレジスタのようにビット単位で使用されるレジスタの場合、

レジスタ名の左側に拡張インジケータ(+)が付いています。これは拡張表示できることを意味します。
(+)記号をダブルクリックするとそのレジスタが拡張表示され、拡張インジケータが(+)から(-)に変わ
ります。
拡張表示されたレジスタがレジスタマスクのように、さらにサブグループを持つ場合は、それら

の左側にも拡張インジケータ(+)が付きます。
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通常のレジスタ�

拡張インジケータ�
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図12-9　ビットレジスタの拡張

拡張表示を解除するには拡張インジケータ(-)記号をダブルクリックします。拡張表示を解除する
と、拡張インジケータは(-)から(+)に戻ります。

12.5.2 レジスタ内容の変更
レジスタの内容を変更する方法は 2つあります。一方は簡易変更方式で、ウィンドウに直接入力

することで値を入力できます。ただし、この方式は 16進数値のみに限定されます。もう一方は詳細
変更方式で、ダイアログボックスを使用して値を入力する必要がありますが、この方式を使用する
と、基数の指定ができ、また複雑な式も入力できます。

簡易変更方式

レジスタの内容を簡単に変更するには、該当する桁をクリックするか、または、クリック・ドラ
ッグにより変更したい桁を選択し、反転表示させます。その桁に新しい値を入力してください。値
は、0-9および a-fの範囲内でなければなりません。新しい値がその桁に書き込まれ、カーソルがレ
ジスタ内の次の桁へ移動します。レジスタの最下位桁に値を入力すると、カーソルは、次のレジス
タの最上位桁へ移動します。表示されているレジスタの桁が、たとえば、CPUの条件コードレジス
タ(CCR)などのビットを示している場合は、SPACEキーを押して、そのビットの値を切り替えるこ
とができます。



12. 変数の表示

138

詳細変更方式

レジスタの内容を詳細変更方式で変更する場合は、Registerダイアログボックスを使用します。以
下の操作のいずれかを行なって、 Registerダイアログボックスを開いてください。

• 変更したいレジスタをダブルクリックする。
• 変更したいレジスタを選択し、ENTERキーを押す。
• 変更したいレジスタを選択し、ポップアップメニューの[Edit...]メニューオプションを選択
する。

図12-10　Registerダイアログボックス

HDI の他のデータ入力フィールドと同様に、フォーマットに従った数値または C/C++言語の式を
入力できます(「2.2 データ入力」を参照)。

ドロップダウンリスト(このリストの内容は CPUモデルおよび選択されたレジスタに依存します)
からオプションを選択することにより、レジスタのどの部分の値を変更するのか（High Word、Low
Wordなど）や、値の指定方法（マスク形式、浮動小数点数など）、あるいはどのフラグビットを修
正するのかを指定することができます。

新しい数値または式を入力し、[OK]ボタンをクリックするか、ENTERキーを押します。ダイアロ
グボックスが閉じ、新しい値がレジスタに書き込まれます。

レジスタ内容の使用

値を入力する際に、CPUレジスタに設定された値を使用できると便利な場合があります。たとえ
ば、Sourceウィンドウまたは Memoryウィンドウで特定アドレスを表示する場合などです。これを
行うには、先頭に“#”文字を付けて、レジスタ名を指定します(例：#R1、#PC、#R6L、#ER3など)。
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13. オーバーレイ機能

本章では、オーバーレイを実現するための設定方法について説明します。

13.1 セクショングループの表示
オーバーレイ機能を利用した場合、つまり同一アドレスに複数のセクショングループを割り当て

た場合、Overlayダイアログボックスにそのアドレス範囲とセクショングループを表示します。
Overlayダイアログボックスを開くには、[Setup->Overlay]メニューオプションを選択します。

図13-1　Overlayダイアログボックス（表示時）

このダイアログボックスには、Addressリストボックスと Section Nameリストボックスがありま
す。Addressリストボックスには、オーバーレイ指定されているアドレス範囲を表示します。

Addressリストボックスの中から、アドレス範囲を選択しクリックします。

図13-2　Overlayダイアログボックス（アドレス範囲選択時）

Section Nameリストボックスに、選択したアドレス範囲に割り付けられた複数のセクショングル
ープを表示します。
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13.2 セクショングループの設定
オーバーレイの指定をした場合、Overlayダイアログボックスにより、優先するセクショングルー

プを設定する必要があります。設定しないで実行すると不正な動作をします。

まず、Addressリストボックスに表示されたアドレスをクリックします。すると、そのアドレスに
割り付けられた複数のセクショングループが Section Nameリストボックスに表示されます。

表示された複数のセクショングループの中から、優先するセクショングループを選択しクリック
します。

図13-3　Overlayダイアログボックス（優先セクショングループ選択時）

セクショングループを選択後、[OK]ボタンをクリックすることにより、優先するセクショングル
ープを設定しダイアログボックスを閉じます。

[Cancel]ボタンをクリックすると、セクションを設定しないでダイアログボックスを閉じます。

【注】 オーバーレイ指定のアドレス範囲では、Overlayダイアログボックスで指定したセクション
のデバッグ情報を使用します。そのため、現在ロードしているプログラムのセクションと
同一のセクションを Overlayダイアログボックスで設定してください。
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14. 関数の設定

本章では、C++プログラムの多重定義関数およびメンバ関数の設定方法について説明します。

14.1 関数の表示
多重定義関数およびメンバ関数は、Select Functionダイアログボックスで表示します。

次のような時、関数名による設定が可能です。

• ブレークポイントの設定
• Run Programダイアログボックスでの関数設定
• Sourceウィンドウ表示時に開く Set Addressダイアログボックスによる設定
• Memoryウィンドウ表示時に開く Set Addressダイアログボックスによる設定
• シンボルの追加および変更
• パフォーマンス・アナリシスの関数設定

上記項目に設定した関数に多重定義関数が存在する場合、あるいはメンバ関数を含むクラス名を
設定した場合、Select Functionダイアログボックスが開きます。

図14-1　Select Functionダイアログボックス
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このダイアログボックスは、3つの領域に分割されています。

• Select Function Nameリストボックス
多重定義関数あるいはメンバ関数を詳細情報付きで表示します。

• Set Function Nameリストボックス
設定する関数を詳細情報付きで表示します。

• Counterグループエディットボックス
All Function :すべての同一名関数あるいはメンバ関数の個数を表示します。
Select Function :Select Function Nameリストボックスに表示している関数の個数を表示しま

す。
Set Function :Set Function Nameリストボックスに表示している関数の個数を表示しま

す。

14.2 関数の設定
多重定義関数およびメンバ関数は、Select Functionダイアログボックス上で選択し設定します。選

択できる関数は通常 1つですが、ブレークポイントを設定する場合、Run Programダイアログボック
スでの関数設定、パフォーマンス･アナリシスの関数設定では、複数選択できます。

14.2.1 関数の選択
関数を選択するには、Select Function Nameリストボックス上で関数を選択後 [＞＞＞＞]ボタンをクリッ

クします。クリックすることによって、選択した関数が Set Function Nameリストボックス上に表示
されます。また、[≫≫≫≫]ボタンをクリックすることによって Select Function Nameリストボックス上に
表示されているすべての関数を選択することができます。

14.2.2 関数の削除
Set Function Nameリストボックス上に表示されている関数を削除する場合は、Set Function Name

リストボックス上で関数を選択後 [＜＜＜＜]ボタンをクリックします。また、[≪≪≪≪]ボタンをクリックする
ことによって Set Function Nameリストボックス上に表示されているすべての関数を削除することが
できます。

14.2.3 関数の設定
Set Function Nameリストボックス上に表示されている関数を設定するには、[OK]ボタンをクリッ

クします。クリックすることにより、関数を設定し、ダイアログボックスを閉じます。

[Cancel]ボタンをクリックすると、関数を設定しないでダイアログボックスを閉じます。
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15. ユーザインタフェースの構成

HDI ユーザインタフェースは、頻繁に行う操作にすばやくアクセスできるように、関連のある操
作を論理的な順序でグループ分けをしています。しかし、デバッグ中には、ユーザインタフェース
項目の配置をユーザの使いやすいように変更したり、ユーザの好みに応じて配置できるように、ユ
ーザインタフェースをカスタマイズできるようになっています。本章では、ユーザインタフェース
ウィンドウの配置を変更、表示形式のカスタマイズ、設定を保存する方法について説明します。

15.1 ウィンドウの配置

15.1.1 ウィンドウの最小化
開いたウィンドウを一時的に終了して、現在の状態で再度表示する場合は、そのウィンドウをア

イコン化することができます。つまり、ウィンドウの最小化ができます。ウィンドウを最小化する
には、ウィンドウの最小化ボタンをクリックするか、ウィンドウメニューで[ -> Minimize]メニュ
ーオプションを選択します。

ウィンド�
メニュー�

最小化ボタン�

図15-1　ウィンドウの最小化

ウィンドウが最小化され、HDI アプリケーションウィンドウ左下隅にアイコンとして表示されま
す。上の Disassemblyウィンドウの場合、アイコンは次のようになります。

図15-2　Disassemblyウィンドウのアイコン

【注】 画面の下部に開いているウィンドウがあると、このアイコンが見えない場合があります。

アイコンをウィンドウに復元するには、アイコンをダブルクリックするか、ウィンドウメニュー
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の[Restore]を選択します。

15.1.2 アイコンの整列
アイコンは、デフォルトで HDI アプリケーションウィンドウの左下隅に置かれます。アイコンは、

クリックして新しい位置にドラッグすればアプリケーションウィンドウ内の任意の位置に移動させ
ることができます。アイコンをウィンドウに復元すると、最小化される前と同じ位置にウィンドウ
が表示されます。同様に、再び最小化すると、アイコンは最後に移動した位置に表示されます。

最小化してアイコンとなったウィンドウがいくつもあると、見づらくなります。アイコンを整理
するには、[Window->Arrange Icons]メニューオプションを選択します。

アイコンがアプリケーションウィンドウの左下隅から整列します。

図15-3　整列前

図15-4　整列後
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15.1.3 ウィンドウのタイル表示
デバッグ後には、画面上に多くのウィンドウが開いている場合があります。Tile機能を使用すれ

ば、どのウィンドウも他のウィンドウと重ならないタイルフォーマットで、すべてのウィンドウを
配置することができます。これを行うには、[Window->Tile]メニューオプションを選択します。
現在開いているすべてのウィンドウが、タイルフォーマットで配置されます。最小化されアイコ

ンとなっているウィンドウは影響を受けません。

15.1.4 ウィンドウのカスケード表示
ウィンドウを、手前のウィンドウの後ろにウィンドウの左と上の端だけが表示されるカスケード

フォーマットで配置することができます。これを行うには、[Window->Cascade]メニューオプション
を選択します。現在開いているすべてのウィンドウが、カスケードフォーマットで配置されます。
最小化されアイコンとなっているウィンドウは影響を受けません。

15.2 現在開いているウィンドウの検索
HDI アプリケーションの中に多くのウィンドウが開いていると、他のウィンドウの後ろに隠れた

ウィンドウを見失ってしまうことがあります。見失ったウィンドウを見つけるには、2つの方法が
あります。

15.2.1 次のウィンドウの検索
ウィンドウリスト中の次のウィンドウを手前に表示するには、ウィンドウメニューを呼び出し

[Next]を選択するか、CTRL+F6を押します。この操作を繰り返すと、すべてのウィンドウ(開いてい
るものと最小化されているもの)を順に選択できます。

15.2.2 特定のウィンドウの検索
特定のウィンドウを選択するには、[Window]メニューの一番下にあるウィンドウリスト(開いてい

るものと最小化されているもの)の中で、選択したいウィンドウをクリックします。ウィンドウリス
トでは、現在選択されているウィンドウの横にチェックマークが付いています。
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次の例では Disassemblyウィンドウが、現在選択されているウィンドウです。

図15-5　ウィンドウの選択

選択したウィンドウが手前に表示されます。そのウィンドウが最小化されている場合は、アイコ
ンがウィンドウに復元されます。

15.3 ステータスバーの表示／非表示
HDI アプリケーションウィンドウの下部にステータスバーを表示するかどうかを選択できます。

デフォルトでは表示します。ステータスバーを非表示にするには、[Setup->Status Bar]メニューオプ
ションを選択します。

ステータスバーが、HDI アプリケーションウィンドウの表示から削除されます。ステータスバー
を再表示するには、もう一度[Setup->Status Bar]メニューオプションを選択します。ステータスバー
が、HDI アプリケーションウィンドウの表示に追加されます。

15.4 ツールバーのカスタマイズ
ツールバーに表示されるボタンの種類と配列をカスタマイズすることができます。表示を変更す

るには、[Setup->Customize->Toolbar]メニューオプションを選択します。

Customizeダイアログボックスをオープンすると 2枚のシートがあります。1枚目のシートは、ツ
ールバーの表示を設定します。2枚目のシートは、ツールバーの個々のボタンを設定します。
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15.4.1 全体概要
Toolbarsシートで、表示するツールバーを選択します。

図15-6　Customizeダイアログボックス(Toolbarsシート)

ツールバーは、複数選択可能なリストボックスに表示されています。個々のツールバーを非表示
にする場合は、ツールバー名(ツールバーがメインフレームウィンドウに固定されていない場合に表
示されるタイトルバーの名前)の隣のチェックをクリアします。

【注】 メニューバーは、チェックをクリアすることはできません。

簡素化されたデスクトップエリアで HDI を使用する場合には’Cool Look’のチェックをはずすと
Windows®3.1スタイルのメニュー、ツールバーになります。

ユーザ定義のツールバーを追加することが可能です。[New...]ボタンをクリックし、定義するツー
ルバー名を入力してください。Toolbar Nameエディットボックスで編集することができます。新し
いツールバー「My Toolbar」として説明します。「My Toolbar」は、メインフレームの左上に現れま
す。ボタンがないのでボタンを追加するには、ツールバーをカスタマイズしなければなりません。
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15.4.2 ツールバーのカスタマイズ
ユーザ定義のツールバーをカスタマイズするには、マウスまたは、他のポインティングデバイス

が必要になります。キーボードしかない場合は、カスタマイズできません。ツールバーは、マウス
のみでしか操作できないため、マウスがない場合にはカスタマイズする必要がないためです。

Customizeダイアログボックスの Commandsシートでそれぞれのツールバーのボタンを設定できま
す。

ボタン�
カテゴリ�

使用可能な�
ボタン�

ボタンの�
動作説明�

図15-7　Customizeダイアログボックス(Commandsシート)

15.4.3 ボタンカテゴリ
ダイアログボックスの左上部は、ボタンカテゴリのリストです。それぞれのカテゴリに対応する

ボタンは右側に表示されます。リスト中のボタンをクリックすると、Descriptionにボタンの動作に
ついての説明が表示されます。

15.4.4 ツールバーへのボタンの追加
ツールバーにボタンを追加する方法を以下に示します。

1. ボタンカテゴリのリストから該当するボタンカテゴリを選択します。
2. 動作リストからボタン項目を選択します。
3. ボタン項目をダイアログからドラッグするとツールバーにボタンが追加されます。
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15.4.5 ツールバーのボタンの位置変更

ツールバーのボタンの位置を変更するには

1. ツールバー中の移動するボタンを選択します。
2. そのボタンをツールバー内の移動先の位置でドロップします。

【注】 Ctrlキーを押しながらドロップするとボタンをコピーできます。

15.4.6 ツールバーからのボタンの削除

ツールバーのボタンを削除するには

1. ツールバーから削除するボタンを選択します。
2. 選択したボタンをメインフレーム内のツールバーの外に移動します。

15.5 フォントのカスタマイズ
テキスト形式のウィンドウのフォントをカスタマイズすることができます（Sourceウィンドウや

Memoryウィンドウ）。また、新しいウィンドウをオープンしたときに使われるデフォルトのフォン
トを設定できます。

フォントを変更するには、[Setup->Customize->Font]メニューオプションを選択します。Fontダイ
アログボックスがオープンします。

図15-8　Fontダイアログボックス

このダイアログボックスは、標準的なWindows®のフォントダイアログボックスと同じ操作ができ
ますが、Fontリストボックスには、固定長幅のフォントのみ表示されます。また、[Use as Default Font]
ボタンを押すと、新しいウィンドウをオープンしたときに使われるフォントを設定することができ
ます。
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15.6 ファイルフィルターのカスタマイズ
Openダイアログのファイルフィルタをカスタマイズできます。
フィルタを変更するには、[Setup->Customize->File Filter]メニューオプションを選択します。

Customize File Filterダイアログボックスがオープンします。

図15-9　Customize File Filterダイアログボックス

【注】 このダイアログボックスでの変更は直ちに反映されます。変更を取り消す事はできません。

フィルターを編集するには

1. File一覧からファイルグループを選択します。
2. Type一覧から対応するタイプ名を選択します。
3. [Edit...]ボタンをクリックするとEdit Filterダイアログボックスが開きます。ダイアログボッ

クスのタイトルには、選択されているファイルグループが表示されます。エディットボッ
クスにはフィルタタイプまたは拡張子として指定できる文字以外は入力できません。

4. ファイル拡張子またはフィルタタイプを編集します。同時に2つ以上の拡張子を指定する場
合は、各拡張子をセミコロンで区切ってください。以下に例を示します。

例
*.mot; *.a20; *.a37

新しいフィルターを入力するには

1. File一覧からファイルグループを選択します。
2. [Add...]ボタンをクリックするとAdd Filterダイアログボックスが開きます。ダイアログボッ

クスのタイトルには、選択されているファイルグループが表示されます。エディットボッ
クスにはフィルタとして指定できる文字以外は入力できません。

3. 追加するフィルタタイプと、フィルタに使用したい拡張子を登録します。

【注】 指定されたフィルタタイプと同じタイプのフィルタが既に存在する場合は、新しく入力さ
れたフィルタが有効となります。

フィルタを削除するには

1. File一覧からファイルグループを選択します。
2. Type一覧から対応するタイプ名を選択します。
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3. [Delete]ボタンをクリックすれば、タイプ名を削除します。

15.7 セッションの保存
ユーザプログラムがデバッグプラットフォームにダウンロードされ、対応するソースファイルが

表示されていて、かつ多くのウィンドウが開いている場合は、次回このプログラムをロードする時
にこうした情報のセットアップに時間がかかる場合があります。HDI では、セットアップ時間短縮
のために現在の設定をファイルに保存することができます。
すでに命名されているセッションや、現在のオブジェクトファイルと同名のセッションを新規に

生成する場合は、[File->Save Session]メニューオプションを選択してセッションを更新することがで
きます。

現在の設定を新しい名前で保存するには、[File->Save Session As...]メニューオプションを選択しま
す。これにより、ファイル名を要求する標準的なファイルダイアログボックスを表示します。HDI
セッションファイル(*.hds)、ターゲットセッションファイル(*.hdt)とウォッチセッションファイル
(*.hdw)の 3つのファイルが保存されます。HDI セッションファイルには、すべての開いているウィ
ンドウとその位置などの HDI インタフェース設定が含まれます。ターゲットセッションファイルに
は、デバッグプラットフォームの名前と構成など、デバッグプラットフォーム／ターゲットシステ
ムに固有の設定が含まれます。ウォッチセッションファイルには、現在のWatchウィンドウの変数
の情報等を保存します。

これらのファイルが保存されると、HDI タイトルバーの第 2エントリとしてセッション名が表示
されます。

図15-10　セッション名の表示

【注】 セッションファイルにはシンボルやメモリ情報を保存しないため、変更した情報を再度使
用したい場合は別途それぞれのファイルに保存してください。詳細は、「9.6 メモリ領域の
保存」、「5.6.11 Save As …」を参照してください。

15.8 セッションのロード
保存したセッションを再ロードするには、[File->Load Session...]メニューオプションを選択します。

これにより、HDI セッションファイル名(*.hds)を要求する標準的なWindows®ファイルダイアログボ
ックスを表示します。
現在開いているウィンドウがあればクローズされ、デバッグプラットフォームへの接続が初期化

されます。ユーザプログラムがターゲットにダウンロードされている場合は、ステータスバーが進
行状況を表示します。ダウンロードが完了すると、ウィンドウが開かれ、更新されて、ターゲット
からの最新情報が表示されます。
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15.9 HDIオプションの設定
HDI インタフェースを使用するとき、役立つ設定があります。[Setup->Options...]メニューオプシ

ョンを選択すると、HDI Optionsダイアログボックスを表示します。

図15-11　HDI Options（Session）ダイアログボックス

On Exitのラジオボタングループは、プログラム終了時のカレントセッションの自動保存に使用で
きます。

• Save session automatically - カレントセッションファイルのセッション情報を保存します。カ
レントセッションファイルがない場合は、HDI セッションファイル名を入力するよう求め
られます。

• Prompt for save session - プログラム終了時に、カレントセッションを保存したいかどうかを
毎回尋ねてきます。Yesを選択すると、カレントセッションファイルにセッション情報が保
存されます。カレントセッションファイルがない場合は、HDI セッションファイル名を入
力するよう求められます。

• Quit without asking - カレントセッション情報を保存するかどうかを尋ねず、保存も行わな
いでプログラムを終了します。

次にプログラムを起動する際、最後に保存したセッションを自動ロードしたい場合は、Load last
session on startupチェックボックスをチェックします。
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図15-12　HDIオプション(Confirmation)ダイアログボックス

Confirmationシートで、確認メッセージボックスの表示／非表示を切り替えられます。

図15-13　HDIオプション(Viewing)ダイアログボックス

Tab Sizeリストボックスは、タブを何文字の空白にするかを設定します。指定可能な値は 2から 8
までです。通常使用しているエディタの空白数に合わせることを推奨します。
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15.10 デフォルト基数の設定
HDI では、いくつかの基数で数値を表示できます。デフォルトは、16進数です。ただし、Count

フィールドは、常に 10進数です。「2.2.2 データ形式」で説明した接頭コードのいずれかを使用す
ることができます。使用入力を簡単にするために、これらのフォーマットのいずれかをデフォルト
として選択することができます。すなわち、その基数を使用する際に対応する接頭コードを入力す
る必要がありません。

デフォルトの基数を変更するには、[Setup->Radix]メニューオプションを選択します。これにより、
使用可能な数値表示システムのリストを表示します。現在選択されている基数の左にチェックマー
クが付いています。

図15-14　基数の設定
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付録A. システムモジュール

本章では、HDI デバッグシステムのアーキテクチャを説明します。

HDI
グラフィカル

ユーザ

インタフェース

ターゲット

DLL
CPU
DLL

オブジェクト

DLL

ユーザコード

(オブジェクトファイル)

ターゲット

ハードウェア

エミュレータモニタ シミュレータ

デバッグ

プラットフォーム

IOファイル

図 A-1　HDIシステムモジュール

通常の動作では、ユーザプログラムをターゲットハードウェアに直接格納します(たとえば EPROM
として)。HDI はこの情報を使用して、Windows®ベースのデバッグシステムを提供します。

異なるデバッグプラットフォームやターゲットハードウェアに交換したとき、デバッグシステム
の使用法を習熟する時間を短縮するため、 HDIは、統一したインタフェース(GUI)とターゲット固
有のモジュールファミリーを提供しています。通常は､標準 GUIは共通です。ユーザが適切なター
ゲットモジュールを選択すれば、システムの残りの部分が自動的に適切なモジュールをロードして
自己設定します。

A.1 グラフィカルユーザインタフェース
これは、Windows®上で動くメインの HDI.EXEプログラムです。ユーザになじみのあるWindows®

の操作を採用しており、メニューとウィンドウは、デバッグシステムの内容をユーザフレンドリー
な方法で表示します。GUIは、ユーザがシステムの残りの部分が接する唯一の接点であり、コマン
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ドを処理して、ユーザプログラムに関する必要な情報を提供します。また、モジュール DLL とホス
トファイルシステム、すなわち PCとの間のインタフェースも提供します。

A.2 オブジェクト DLL
コンパイラツールはユーザプログラムを作成する際、アブソリュートファイルを作成します。こ

のファイルには、ターゲットアプリケーションを構成する機能を実行するため、マイクロコンピュ
ータが処理する実際のマシンコードおよびデータが含まれます。オリジナルソースコードとしてユ
ーザプログラムをデバッグするためには、コンパイラツールはデバッガにさらに情報を提供しなけ
ればなりません。このため、コンパイラツールは、ソースコードのデバッグに必要なすべての情報
をアブソリュートファイルに格納するデバッグオプションを備えています。このようなアブソリュ
ートファイルは通常、デバッグオブジェクトファイルと呼ばれます。

オブジェクト DLL は、オブジェクトファイルからこの情報を抽出し、ユーザに対して表示します。
データのフォーマットはコンパイラツールに依存するため、HDI ディレクトリには複数のオブジェ
クト DLL を入れておくことができます。HDI はオブジェクトファイルのフォーマットが理解できる
オブジェクト DLL をみつけるまで、1つ 1つを試します。

A.3 CPU DLL
CPU DLLモジュールには、ターゲットのマイクロコンピュータに関する情報が含まれています。

たとえば、マイクロコンピュータが使用できる、レジスタの数と種類が含まれており、また、ター
ゲット中のマシンコードと Sourceウィンドウに表示するアセンブラニーモニックとの間で、翻訳を
行います。

A.4 ターゲット DLL
ターゲット DLL は、デバッグプラットフォームの機能を HDI に通知し、正しい CPU DLLを選択

します。ターゲットの幾つかの機能は、一般的になり得ません(たとえばターゲット構成)。ターゲッ
ト DLL には、これらの機能へのアクセスをユーザに提供するため、標準 GUIへの拡張機能も含まれ
ています。
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付録B. GUIコマンド一覧

メニュー メニューオプション ショートカットキー ツールバーボタン

File New Session... Ctrl+N

Load Session... Ctrl+O

Save Session Ctrl+S

Save Session As...

Load Program...

Initialize

Exit Alt+F4

Edit Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Find F3

Evaluate

View Breakpoints Ctrl+B

Command Line Ctrl+L

Disassembly... Ctrl+D

I/O Area Ctrl+I

Labels Ctrl+A

Locals Ctrl+Shift+W

Memory... Ctrl+M

Performance Analysis Ctrl+P

Profile-List Ctrl+F

Profile-Tree Ctrl+Shift+F

Registers Ctrl+R

Source... Ctrl+K

Status Ctrl+U
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メニュー メニューオプション ショートカットキー ツールバーボタン

View Trace Ctrl+T

Watch Ctrl+W

Run Reset CPU

Go F5

Reset Go Shift+F5

Go To Cursor

Set PC To Cursor

Run...

Step In F8

Step Over F7

Step Out

Step...

Halt Esc

Memory Refresh F12

Load...

Save...

Verify...

Test...

Fill...

Copy...

Compare...

Search...

Configure Map...

Configure Overlay...
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メニュー メニューオプション ショートカットキー ツールバーボタン

Setup Options...

Radix (Input) 　　　　�

          Hexadecimal

          Decimal

          Octal

          Binary

　　　

　　　

Customize　　　　　�

          Toolbar...

          Font...

          File Filter...

　　　

Configure Platform...

Window Cascade

Tile

Arrange Icons

Close All

Help Index F1

Using Help

Search for Help on

About HDI
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付録C. シンボルファイルのフォーマット

HDI がシンボルファイルを正しく理解しデコードするためには、決められた方法でファイルをフ
ォーマットする必要があります。

1. ファイルは、ASCIIテキストファイルでなければなりません。
2. ファイルの先頭には、“BEGIN”という語を指定する必要があります。
3. 各シンボルは、別個の行にあり、最初に“H”で終わる16進数の値、続いてスペース、次にシ

ンボルテキストが指定されていなければなりません。
4. ファイルの終わりには、“END”という語を指定する必要があります。

例:
BEGIN
11FAH Symbol_name_1
11FCH Symbol_name_2
11FEH Symbol_name_3
1200H Symbol_name_4
END
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